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Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, 
without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. 
reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to 
notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the 
trade laws of other countries. You agree to comply with all export control regulations and to obtain any required 
licenses or classification to export, re-export, or import deliverables. You agree not to export or re-export to entities 
on the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export 
laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. 
Please refer to www.novell.com/info/exports/ for more information on exporting Novell software. Novell assumes no 
responsibility for your failure to obtain any necessary export approvals.

Copyright © 2005-2006 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, 
stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is described in this 
document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. 
patents listed at http://www.novell.com/company/legal/patents/ and one or more additional patents or pending patent 
applications in the U.S. and in other countries.

Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA 02451
U.S.A.
www.novell.com

Online Documentation: To access the online documentation for this and other Novell products, and to get 
updates, see www.novell.com/documentation.

Novell Trademarks

For a list of Novell tradmarks, see the Novell Trademark List (http://www.novell.com/company/legal/trademarks/
tmlist.html).

Third-Party Materials

All third-party trademarks are the property of their respective owners.
This product includes code licensed from RSA Security, Inc. Some portions licensed from IBM are available at 

http://oss.software.ibm.com/icu4j/.
This product includes materials licensed under the Apache license, including Apache and Tomcat.
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About This Guide

This guide describes how to install, upgrade, and update Novell® Open Enterprise Server (OES) for 
Linux and is divided into the following sections:

• “What's New” on page 9
• “Preparing to Install OES Linux” on page 11
• “Installing Open Enterprise Server (OES) Linux” on page 21
• “Upgrading to OES Linux” on page 45
• “Completing Post-Installation Tasks” on page 49
• “Patching an OES Linux Server” on page 57
• “Installing and Configuring Multiple Servers Using AutoYaST” on page 87
• “Removing OES Linux Components” on page 115
• “Security Considerations” on page 117
• “Installing Linux with EVMS as the Volume Manager of the System Device” on page 119
• “OES Linux File and Data Locations” on page 135
• “Documentation Updates” on page 137

Audience

This guide is intended for system administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

The latest version of the OES Linux Installation Guide is available at the Open Enterprise Server 
documentation Web site (http://www.novell.com/documentation/oes/install_linux/data/front.html).

Additional Documentation

Table 1   Additional Documentation References

For more information about See

Planning and implementing OES for Linux Novell OES SP2 Planning and Implementation 
Guide

Migration from and coexistence with other products OES Coexistence and Migration Guide
7

http://www.novell.com/documentation/oes/install_linux/data/front.html
http://www.novell.com/documentation/oes/install_linux/data/front.html


8 OES Linux I

novdocx (E
N

U
)  01 February 2006
Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
within a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms, or a forward slash for 
other platforms, the pathname is presented with a forward slash to reflect the Linux convention. 
Users of platforms that require a backslash, such as Linux or UNIX*, should use backslashes as 
required by the software.

SLES 9 Installation and Administration details SUSE® LINUX Enterprise Server 9 Administration 
Guide (http://www.novell.com/documentation/oes/
sles_admin/data/front.html)

For more information about See
nstallation Guide
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1What's New

This section includes the features that were updated in Open Enterprise Server (OES) for Linux 
since its initial release.

1.1  OES Support Pack 2 Release
In this release of OES, the following feature has been added to the OES Linux installation:

Table 1-1   OES  Support Pack 2 Changes

1.2  OES Support Pack 1 Release
In this release of OES, the following features have been added to the OES Linux installation:

Table 1-2   OES Support Pack 1 Changes

Functionality For More Information

SLES 9 base has been updated to SP3. N/A

When you update a server with several patches, 
you can use the Red Carpet® Graphical User 
Interface (GUI) to update the server.

“Patching a Server From the ZLM Channel Using 
the Red Carpet GUI” on page 71.

When configuring eDirectory to use SLP, you can 
now specify more than one server to use as the 
directory agent.

“SLP Configuration” on page 37.

The Novell® Virtual Office predefined server type is 
removed. Updates to existing server deployments 
are still available.

N/A

Functionality For More Information

SLES 9 base has been updated to SP2. N/A

AutoYaST Automation Tool includes OES 
components

“Installing and Configuring Multiple Servers Using 
AutoYaST” on page 87.

iFolder 3.x and iFolder 3.x Web Access have been 
added as network services that you can install on 
your OES Linux server.

“Prerequisites and Guidelines” and “Installing 
iFolder on an Existing OES Linux Server” in the 
Novell iFolder 3.x Administration Guide.

Novell IP Address Management has been added as 
a network service framework that you can install on 
your OES Linux server.

This framework is added for future use only and is 
not exposed in the Novell Remote Manager 
included in OES SP1.

N/A
What's New 9
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eDirectoryTM Configuration has added a field to 
specify a location for the DIB and the opportunity to 
add additional LDAP servers to your network 
configuration.

See the online installation help for these fields 
during the installation.

Functionality For More Information
nstallation Guide
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2Preparing to Install OES Linux

Before you install Novell® Open Enterprise Server (OES) for Linux, you should review the 
information in the following guides:

Novell OES SP2 Planning and Implementation Guide 
OES Coexistence and Migration Guide
Open Enterprise Server Readme

You should also perform the tasks outlined in these sections.

Section 2.1, “Meet All Server Software and Hardware Requirements,” on page 11
Section 2.2, “Decide What Type of Server You Are Installing,” on page 12
Section 2.3, “eDirectory Rights Required to Install OES Linux,” on page 15
Section 2.4, “Installing into Existing Networks,” on page 17

2.1  Meet All Server Software and Hardware 
Requirements
Before installing OES Linux, ensure that your system meets the following requirements.

2.1.1  Server Software
As part of the OES Linux installation, you will install SUSE® Linux Enterprise Server 9 SP3.

2.1.2  Server Hardware

Table 2-1   Server Hardware Requirements

System Component Minimum Requirements Recommended Requirements

Computer Server-class computer with 
Pentium* II or AMD* K7 450 
MHz processor

Server-class computer with Pentium III, 
Pentium III Xeon*, Pentium 4, Intel* Xeon 700 
MHz, AMD K8 CPUs (Athlon64 and Opteron), 
Intel EM64T or higher processor. 

NOTE: OES runs in 32-bit mode only. 

Memory 512 MB of RAM 1 GB of RAM

Free Disk Space 6 GB of available, 
unpartitioned disk space

10 GB of available, unpartitioned disk space. 
Additional disk space might be required 
depending on which OES components are 
selected and how they are used.

CD-ROM Drive 4X CD-ROM drive 48X CD-ROM drive

Hard Drive 20 GB
Preparing to Install OES Linux 11
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NOTE: The RAM and disk space amounts shown here are for system components only. The OES 
Linux service components you install might require additional RAM and disk space. 

Be sure to complete the planning instructions found in the Novell OES SP2 Planning and 
Implementation Guide for each component you install. During that planning process, you are 
instructed to record and track the additional RAM and disk space you need on the worksheet.

2.2  Decide What Type of Server You Are 
Installing
In the Installation Settings > Software Selection panel, a normal SLES 9 SP3 installation has the 
following predefined server types.

Table 2-2   Standard SLES 9 SP3 Installation Predefined Server Type

Network Board Ethernet 100 Mbps

IP address • One IP Addresses on a 
subnet

If installing Novell 
iFolder®, you need an 
additional IP address. 
iFolder requires a 
separate IP address on 
Linux.

• Subnet mask

• Default gateway

Mouse N/A USB or PS/2

Server computer BIOS If doing a CD-ROM 
installation, prepare the BIOS 
on your server computer so 
that it boots from the CD-
ROM drive first.

Predefined Server Type Description

Minimum system Includes just the bare essentials needed to safely run SUSE Linux. It 
does not include graphical desktop environments. You might select 
this option if your server is a dedicated system that does not need a 
graphical desktop or if your server is short on disk space or memory.

Minimum graphical system 
(without KDE)

Includes the SUSE Linux base system.

Full installation The largest system and includes all packages available with SUSE 
Linux, except those that would result in dependency conflicts.

Default system Includes the KDE desktop together with most of the KDE programs 
and the CUPS print server.

System Component Minimum Requirements Recommended Requirements
nstallation Guide
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The OES integrated installation includes the options listed in Table 2-2, but it also includes the 
additional predefined server types listed in Table 2-3.

These predefined server types let you install the OES Base install and just the components you want 
for a particular server type. For example, if you want your server to be primarily an iPrint server, 
you can select the Novell Print Server predefined server type to install the server and configure it 
with only components it needs to function as an iPrint server. The Open Enterprise Server type is 
preselected by default.

Table 2-3   Additional OES Predefined Server Types

Predefined Server Type Description and Software Selections Installed

Novell QuickFinder Server QuickFinderTM lets your users find the information they’re looking for 
on any of your public and private Web sites, your partners’ sites, and 
any number of additional Web sites across the Internet or internal file 
servers, all from a single search form on your Web page. You can 
easily modify the look-and-feel of any of the sample search results 
pages to match your corporate design.

This server type installs the following software selections by default:

• Basis Runtime System

• YaST

• Novell QuickFinder

Novell iFolder 2 Server Novell iFolder 2.1 lets your users’ local data files to follow them 
everywhere—online, offline, all the time—across multiple 
workstations, your corporate network and the Internet. It provides a 
simple, convenient, and secure way to access, back up, and protect 
the local data files of your mobile professionals.

This server type installs the following software selections by default:

• Basis Runtime System

• YaST

• Novell iManager

• Novell NetStorage

• Novell iFolder 2.x

Novell Print Server Novell iPrint lets employees, partners, and customers access printers 
from a variety of locations across their network and the Internet. From 
a Web browser users can easily install any printer on the network from 
any location.

This server type installs the following software selections by default:

• Basis Runtime System

• Yast

• Novell eDirectory

• Novell iManager

• Novell iPrint
Preparing to Install OES Linux 13
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The following software selections listed in Table 2-4 on page 15 are not installed by default with the 
Novell Open Enterprise Server predefined server type. 

Novell Management Server Installs iManager and all related packages on a minimum system 
(basis runtime system and YaST). 

This server type installs the following software selections by default:

• Basis Runtime System

• YaST

• Novell iManager

Novell Open Enterprise Server Novell Open Enterprise Server (OES) is a secure, highly available 
solution that combines proven services for application delivery, 
networking, communication, and collaboration in an open, easy-to-
deploy environment.

Novell OES is the default predefined server type selection. 

This server type installs the following software selections by default:

• Basis Runtime System

• YaST

• Graphical Base System

• Linux Tools

• KDE Desktop

• Helps and Support Documentation

• Authentication Server (NIS, LDAP Kerberos)

• Base Sound Libraries and Tools

• Novell eDirectory

• Novell iManager

• Novell Linux User Management

• Novell eGuide

• Novell iPrint

• Novell NetStorage

• Novell QuickFinder

• Novell NCP Server

• Novell Samba Configuration

• Novell Backup Services (SMS)

• Novell Health Monitoring

For a detailed description of each of these Novell software services, 
see the following sections in the Novell OES SP2 Planning and 
Implementation Guide:

• “Identity and Directory Services”

• “Infrastructure Services”

• “End User Services”

Predefined Server Type Description and Software Selections Installed
nstallation Guide
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If you want to install these services, you can select them to install with any predefined server type by 
customizing the installation or you can install them after installing your initial Open Enterprise 
Server. For more information, see “Customizing the Software Selections” on page 28 and “Installing 
or Configuring OES Components on an Existing Server” on page 51. 

Table 2-4   Additional OES Software Selections

If none of the predefined server types meets your needs, you can customize the installation. See 
“Customizing the Software Selections” on page 28.

2.3  eDirectory Rights Required to Install OES 
Linux
The following eDirectory rights are discussed in this section:

• Section 2.3.1, “eDirectory Rights Required to Install the First Three OES Linux Servers in an 
eDirectory Tree,” on page 15

• Section 2.3.2, “eDirectory Rights Required to the Extend Schema,” on page 16
• Section 2.3.3, “eDirectory Rights Required to Run Deployment Manager,” on page 16
• Section 2.3.4, “eDirectory Rights Required for Subcontainer Administrators,” on page 16

2.3.1  eDirectory Rights Required to Install the First Three OES 
Linux Servers in an eDirectory Tree
If you are installing the server into a new tree, the Admin user that is created during the OES Linux 
installation has full rights to the root of the tree. Using the account for user Admin allows the 
installer to extend the eDirectory schema for OES Linux as necessary. To install the first OES Linux 
server in an eDirectory tree, you must have the Supervisor right at the [Root] of the eDirectory tree. 

Software Selection Description

Novell Cluster Services A server clustering system that ensures high 
availability and manageability of critical network 
resources including data (volumes), applications, 
and services.

Novell iFolder 2.x, Novell iFolder 3.x, or iFolder 3.x 
Web Access

A Net services software solution that lets mobile 
professionals access their local files from 
anywhere—online, offline, all the time—across 
multiple workstations and the Net.

Novell Storage Services (NSS) A set of features that can help you effectively 
manage your storage usage and growth.

Novell IP Address Management A service that assists you in managing the IP 
addresses that network services use on a server.

In this release, this is a framework only and no 
services are currently using this framework to 
manage IP address configurations.
Preparing to Install OES Linux 15
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By default, the first three servers installed in an eDirectory partition automatically receive a replica 
of that partition. To install a server into a partition that does not already contain three replica servers, 
the user must have either the Supervisor right at the [Root] of the tree or to the container in which 
the server holding the partition resides.

Before letting a subcontainer administrator install subsequent OES Linux servers in a tree, a user 
with the Supervisor rights to the root of the tree must extend the schema in the tree. You can extend 
the schema by using the Schema Update Wizard in Deployment Manager or by having a user with 
Supervisor rights to the root of eDirectory tree install the first OES Linux server into the tree. For 
more information, see “Schema Update” in the OES NetWare Installation Guide.

2.3.2  eDirectory Rights Required to the Extend Schema
Some of the products that can be selected to install along with OES Linux require schema extensions 
of their own. Only an administrator with Supervisor rights at [Root] can extend the schema of an 
eDirectory tree; a subcontainer administrator would not have sufficient rights.

2.3.3  eDirectory Rights Required to Run Deployment Manager
If you are installing the first OES Linux server into an existing NDS®/eDirectory tree, run 
Deployment Manager first to prepare the tree so it is compatible with the new version of eDirectory 
that comes with OES. This requires access to a server with a Read/Write replica of the Root 
partition.

2.3.4  eDirectory Rights Required for Subcontainer 
Administrators
For security reasons, you might want to create one or more subcontainer administrators 
(administrators that are in a container that is subordinate to the container that user Admin is in) with 
sufficient rights to install additional OES Linux servers, without granting them full rights to the 
entire tree. A subcontainer administrator needs the following rights to install an OES Linux server 
into the tree:

• Supervisor right to the container where the server will be installed
• Read right to the Security container object for the eDirectory tree
• Read right to the NDSPKI:Private Key Attribute on the Organizational CA object (located in 

the Security container)
• Supervisor right to the W0 object located inside the KAP object in the Security container
• Supervisor right to the Security container when installing the NMASTM login methods

These rights are typically granted by placing all administrative users in a Group or Role in 
eDirectory, and then assigning the rights to the Group or Role.
nstallation Guide
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2.4  Installing into Existing Networks
This section contains important information for the following scenarios:

• Section 2.4.1, “Installing Multiple Servers,” on page 17
• Section 2.4.2, “Installing into an Existing Novell eDirectory Tree,” on page 17
• Section 2.4.3, “Installing into an Existing NetWare Tree,” on page 17
• Section 2.4.4, “Installing into a NetWare 5.1 Servers Only Tree,” on page 18

2.4.1  Installing Multiple Servers
You should install one server at a time into a tree, waiting for the installation program to complete 
before installing an additional server into the same tree.

2.4.2  Installing into an Existing Novell eDirectory Tree
If you are installing the first OES Linux server into an existing NDS/eDirectory tree, run 
Deployment Manager first to prepare the tree so it is compatible with the new version of eDirectory 
that comes with OES. 

To run the Deployment Manager, follow the steps outlined in “Prepare the Network with 
Deployment Manager” in the OES NetWare Installation Guide. This procedure is for NetWare® 
OES servers, but it also applies to OES Linux servers.

2.4.3  Installing into an Existing NetWare Tree

IMPORTANT: If you are installing into an eDirectory tree that is using a NetWare server to supply 
LDAP, upgrade the LDAP server that the OES Linux installation will communicate with to the 
NetWare 6.5 SP3 or later software; otherwise, the server (running NetWare 6.5 SP2 or earlier) will 
most likely abend.

To ensure a successful OES Linux installation, do the following before installing your first OES 
Linux server in an existing NetWare tree:

1 Extend the schema using the “Schema Update” in Deployment Manager.

Schema Update is a new tool in the OES SP1 version of Deployment Manager. It extends the 
schema for Linux and NetWare trees. For more information, see “Schema Update” in the OES 
NetWare Installation Guide.

2 Ensure the schema is synchronized throughout the tree from [ROOT] by doing the following:
2a Verify that schema is synchronizing out from [ROOT] by entering the following 

commands at the System Console prompt of the server with the Master of [ROOT]:

set DSTRACE=on
set DSTRACE=nodebug
set DSTRACE=+Schema
set DSTRACE=*SSD
set DSTRACE=*SSA
Preparing to Install OES Linux 17
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2b Toggle to the Directory Services screen and look for the message: 
All Processed = YES

2c On each server that holds a Master of a partition, enter the following commands at the 
System Console prompt:

set DSTRACE=off
set DSTRACE=nodebug
set DSTRACE=+Schema
set DSTRACE=*SS

2d Toggle to the Directory Services screen and look for the message:
All Processed = YES

2.4.4  Installing into a NetWare 5.1 Servers Only Tree
Before installing an OES Linux server into an existing tree that is running NetWare 5.1 server only, 
do the following:

1 Run Deployment Manager first to prepare the tree so it is compatible with the new version of 
eDirectory that comes with OES.

IMPORTANT: If you install the OES Linux server into an existing tree with servers with 
versions earlier than NetWare 5.1 SP7 and eDirectory 8.6.x, you first need to run Deployment 
Manager to prepare the network. See “eDirectory Rights Required to Install OES Linux” on 
page 15. If all the servers in the tree are running NetWare 5.1 SP7 or later with eDirectory 8.6.x 
or later, you do not need to run Deployment Manager.

Deployment Manager is on the OES NetWare 6.5 Operating System CD 1. To run the 
Deployment Manager, follow the steps outlined in “Prepare for New eDirectory ”in the OES 
NetWare Installation Guide. This procedure is for NetWare OES servers, but it also applies to 
OES Linux servers.

Deployment Manager runs from a Windows* workstation and requires a NetWare server that 
holds a root replica of the tree.

2 Update the OES schema in the tree by using the Schema Update Wizard in Deployment 
Manager.
For more information, see “Schema Update” in the OES NetWare Installation Guide.

3 Ensure that all NetWare 5.1 servers in the tree are running NetWare 5.1 SP7 or later.
4 Apply a new sas.nlm file to each NetWare 5.1 server in the tree. For more information, see 

TID 2970116 “NetWare 5.1 SP8 SAS.NLM for OES Install” (http://support.novell.com/cgi-bin/
search/searchtid.cgi?/2970116.htm).

5 Ensure that all OES services (components) are pointing to the OES Linux server that you are 
installing and that they are not pointing to the NetWare 5.1 server.
nstallation Guide
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2.5  What's Next
Proceed to one of the following sections based on the task that you want to perform:

• “Installing Open Enterprise Server (OES) Linux” on page 21
• “Upgrading to OES Linux” on page 45
• “Patching an OES Linux Server” on page 57
• “Installing and Configuring Multiple Servers Using AutoYaST” on page 87
• “Installing Linux with EVMS as the Volume Manager of the System Device” on page 119
Preparing to Install OES Linux 19
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3Installing Open Enterprise Server 
(OES) Linux

OES Linux includes SUSE® Linux Enterprise Server (SLES) 9 SP3. When you install and configure 
OES Linux, you also install and configure SLES 9 SP3. Therefore, it is helpful to understand how to 
perform a SLES installation.

For detailed information on performing a SLES installation, see the SUSE LINUX Enterprise Server 
9 Administration Guide.

Before installing Novell® Open Enterprise Server (OES) for Linux, we recommend that you read the 
following documents and information:

Novell OES SP2 Planning and Implementation Guide
OES Coexistence and Migration Guide
Open Enterprise Server Readme
“Preparing to Install OES Linux” on page 11

This section includes brief steps for performing a full installation of OES Linux and provides 
information on the following topics:

• Obtaining OES Linux Software (page 21)
• Preparing the OES Linux Files for Installation (page 21)
• Installing OES Linux as a New Installation (page 25)

3.1  Obtaining OES Linux Software
For information on obtaining OES Linux software, see “Getting and Preparing OES Software” in the 
Novell OES SP2 Planning and Implementation Guide.

3.2  Preparing the OES Linux Files for Installation
This section covers preparation for the following two methods for installing OES Linux:

• Section 3.2.1, “Preparing for a Network Installation,” on page 22
• Section 3.2.2, “Preparing for a CD Installation,” on page 24

Both methods require that you download the ISO image files for each CD used in the installation.

If you have multiple computers that have similar hardware and a similar environment, you can 
perform a single installation on one server and then create a profile from that server to automate the 
installation for subsequent servers. For procedures, see “Installing and Configuring Multiple Servers 
Using AutoYaST” on page 87.
Installing Open Enterprise Server (OES) Linux 21
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3.2.1  Preparing for a Network Installation
This section contains the following information:

• “Requirements” on page 22
• “Procedure” on page 22

Requirements

For a network installation, you need the following:

A SLES server to act as the YaST Network Installation server
A computer to become the new OES Linux server

Both servers need to be connected to the network and able to communicate with each other. 

If you have DHCP on your network, this works well to begin the initial network installation. Part 
way through the installation, you are prompted to configure your OES Linux server with a static IP 
address. The static IP address is required for the configuring OES network services on your server.

If you don't have DHCP on your network, you need to do a manual installation and configure your 
OES Linux server with a static IP address, subnet mask, a default gateway, and a name server. You 
will not have to redo this network configuration later in the installation because it will already be set 
up. The instructions for this come later in the installation procedure. (See “Installing OES Linux as a 
New Installation” on page 25.)

Procedure

To prepare for a network install, configure the YaST Network Installation server:

1 Download the netInstall.sh script file.

You can download this file from TID 2972902 “Script File to Install OES via Network” (http://
support.novell.com/cgi-bin/search/searchtid.cgi?/2972902.htm).

2 Download or copy the ISO image files to a directory of your choice.
3 Run the following command to execute the shell script:
./netInstall.sh

When prompted, provide the following:
• The location (directory) where you want the root of the network installation directory to 

be created. If the directory does not exist, you are prompted to create it. 
• The location (directory) of the ISO image files that you downloaded.

The script creates the file structure, copies the contents of the ISO files to the network 
installation directory, and creates the links and files in the network installation directory 
necessary for a network installation.
You might see the following error when you run the script:
Bad Interpreter No such file or folder

This means that the system could not find the bash interpreter to execute the script. The 
interpreter is called at the beginning of the script.
For possible causes and actions to take, see the following:
nstallation Guide
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4 Configure your Linux server to be a YaST installation server and select the location for the root 
of the network installation.
The three protocol options to choose from for configuring the YaST installation server are NFS, 
FTP, and HTTP. For the protocol configuration procedures, see the following:

• NFS Protocol Configuration (page 23)
• FTP Protocol Configuration (page 24)
• HTTP Protocol Configuration (page 24)

FTP and HTTP do not allow you to serve the files without possible modifications to .conf 
files. NFS is the simplest protocol to configure and is recommended.

5 Create a CD using the oessp2linux01.iso image file and label it as Open Enterprise 
Server SP2 CD 1.
For information on creating this CD, see “Preparing for a CD Installation” on page 24.
This CD will be the network installation boot CD.

With these steps completed, you are ready to perform a network installation. See “Installing OES 
Linux as a New Installation” on page 25

NFS Protocol Configuration

An NFS share can be shared easily from most any location on your file system. If you choose to use 
this protocol:

1 At your network installation server, launch YaST.
2 Select Network Services, then click NFS Server.

You might be prompted to install the NFS server.
3 On the NFS Server configuration screen, select Start NFS Server, then click Next.
4 In the Directories section, add the directory where you have created the install root (source 

directory).
5 Accept the defaults in the pop-up window. 

If you are experienced with NFS configurations, you can customize the configuration.
6 Click Finish.

Possible Cause Action

The netInstall.sh file might have been 
copied from a Windows workstation to the SUSE 
Linux server. This might cause problems for the 
system in executing the script because the file 
appears to be correct but the internal structure of 
the file is not what Linux is expecting.

To resolve this issue, run the dos2unix 
command with the file as the parameter. This  
corrects the internal document structure.

For example,

dos2unix netInstall.sh

Bash has been disallowed to execute in the 
directory where the netInstall.sh file has 
been copied to.

Change the location of the netInstall.sh file.

or

Allow bash to execute files in the directory where 
the netInstall.sh file resides.
Installing Open Enterprise Server (OES) Linux 23
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FTP Protocol Configuration

Depending on the FTP server you use, the configuration might be different. These instructions use 
pure ftpd and can be installed using YaST.

If you have created your install root (source directory) within your ftp root, you can forego the 
following procedure and simply start pure ftpd. 

The default configuration of pure ftpd runs in chroot jail, so symlinks cannot be followed. In order to 
allow ftp access to the install root created outside of the ftp root, you must mount the install root 
directory inside of the ftp root.

If you have not created your install root within your ftp root and you choose to use this protocol:

1 Create a directory inside of your ftp root.
2 Run the following command:
mount --bind /path_to_install_root /
path_to_directory_in_ftp_root

For example, 
mount --bind /tmp/OES /srv/ftp/OES

3 (Optional) If you want to make this install root permanent, add this command to the /etc/
fstab file.

4 Start pure ftpd.

HTTP Protocol Configuration

These instructions use Apache2 as provided by SLES 9.

If you choose to use this protocol:

1 Modify the default-server.conf file of your HTTP server to allow it to follow 
symlinks and create directory indexes.

The default-server.conf file is located in the /etc/apache2 directory. In the 
Directory tag of the default-server.conf file, remove None if it is there, add 
FollowSymLinks and Indexes to the Options directive, then save the changes.

2 (Conditional) If the install root is outside of the http root, create a symbolic link to the install 
root with the following command:
ln -s /path_to_install_root /path_to_link 
For example, 
ln -s /tmp/OES /srv/www/htdocs/OES

3 Restart Apache.

3.2.2  Preparing for a CD Installation
To do a CD installation, you must first download and burn a CD for each ISO image file that you 
need.

1 Insert a blank, writable CD into your CD burner.
2 Select the option to create a CD from an image file.
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3 Select ISO as the file type.
4 Select the first image file (see Table 3-1) from the location you downloaded it to.
5 Complete the CD creation process.
6 Repeat this process for each of the ISO image files.

The following table shows the ISO image filename and how each CD should be labelled:

Table 3-1   OES Linux ISO Images and CD Labels

Your CDs are now ready to be used for an installation. See “Installing OES Linux as a New 
Installation” on page 25.

3.3  Installing OES Linux as a New Installation
This section does not provide step-by-step instructions on how to do the installation, but it provides 
the following important information specific to OES Linux as you progress through the installation.

• Section 3.3.1, “Starting the OES Linux Installation,” on page 26
• Section 3.3.2, “Specifying the Type of Installation,” on page 27
• Section 3.3.3, “Specifying the Installation Settings for the Base OES Linux Installation,” on 

page 27
• Section 3.3.4, “Specifying Configuration Information,” on page 31
• Section 3.3.5, “Finishing the Installation,” on page 44

ISO Image File CD Label Download Required

oessp2linux01.iso Open Enterprise Server SP2 CD1 Yes

oessp2linux02.iso Open Enterprise Server SP2 CD2 Yes

oessp2linux03.iso Open Enterprise Server SP2 CD3 Yes

oessp2linux04.iso Open Enterprise Server SP2 CD4 Yes

oessp2linux05.iso Open Enterprise Server SP2 CD5 Optional

oessp2linux06.iso Suse Core Version 9 CD1 Yes

oessp2linux07.iso Suse Core Version 9 CD2 Yes

oessp2linux08.iso Suse Core Version 9 CD3 Yes

oessp2linux09.iso Suse Core Version 9 CD4 Optional

oessp2linux10.iso Suse Core Version 9 CD5 Optional
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3.3.1  Starting the OES Linux Installation
Insert Open Enterprise Server SP2 CD1 into the CD-ROM drive of the computer you want to be 
your OES Linux server, then boot the machine. Then proceed with one of the following:

• “Network Installation Using DHCP” on page 26
• “Network Installation without DHCP” on page 26
• “CD Installation” on page 27

Network Installation Using DHCP

1 From the CD boot menu, select the second option (Installation) but do not press Enter.
2 Press F3, and then select the network installation type (NFS, FTP, HTTP) that you set up on 

your network installation server.
See Step 4 on page 23 of the Preparing for a Network Installation procedure.

3 Specify the required information (server name and installation path), then select OK.
4 Press Enter to begin the installation.
5 Follow the screen prompts using the information contained in “Specifying the Type of 

Installation” on page 27, “Specifying the Installation Settings for the Base OES Linux 
Installation” on page 27, “Specifying Configuration Information” on page 31, and “Finishing 
the Installation” on page 44 to complete the installation.

6 Complete the server setup by following the procedures in “Completing Post-Installation Tasks” 
on page 49.

Network Installation without DHCP

1 From the CD boot menu, select the fifth option (Manual Installation), then press Enter.
2 Select the language, then press Enter.
3 Select a keyboard map, then press Enter.
4 Select Start Installation or System, then press Enter.
5 Select Network, then press Enter.
6 Select the network protocol that matches the configured protocol on your network installation 

server, then press Enter.
7 (Conditional) If you have more than one network interface card, select one of the cards, then 

press Enter.
We recommend eth0.

8 When prompted whether you want to use DHCP, select No, then press Enter.
9 Specify the IP address, then press Enter.

10 Specify the subnet mask, then press Enter.
11 Specify the gateway, then press Enter.
12 Specify the IP address of a name server, then press Enter.
13 Specify the IP address or the DNS hostname of the network installation server, then press Enter.
14 Specify the path to your installation source on the network installation server, then press Enter.
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15 Follow the screen prompts using the information contained in “Specifying the Type of 
Installation” on page 27, “Specifying the Installation Settings for the Base OES Linux 
Installation” on page 27, “Specifying Configuration Information” on page 31, and “Finishing 
the Installation” on page 44 to complete the installation.

16 Complete the server setup by following the procedures in “Completing Post-Installation Tasks” 
on page 49.

CD Installation

1 From the CD boot menu, select the second option (Installation), then press Enter.

The installation process prompts you for each CD at the appropriate time. Disregard the 
progress status window at the right which uses internal names rather than the CD label names.

2 Follow the screen prompts using the information contained in “Specifying the Type of 
Installation” on page 27, “Specifying the Installation Settings for the Base OES Linux 
Installation” on page 27, “Specifying Configuration Information” on page 31, and “Finishing 
the Installation” on page 44 to complete the installation.

3 Complete the server setup by following the procedures in “Completing Post-Installation Tasks” 
on page 49.

3.3.2  Specifying the Type of Installation
When selecting the type of installation, select New Installation.

3.3.3  Specifying the Installation Settings for the Base OES 
Linux Installation
The instructions in this section assume you are using the graphical YaST interface for installation. If 
you are installing from a shell prompt or the text-based YaST interface, you need to apply these 
installation instructions to the interface you are using. 

This section does not provide step-by-step instructions on how to do the installation, but it provides 
important information specific to OES Linux as you progress through the installation and determine 
the Installation Settings.

For step-by-step information on performing a SLES installation, see “Installation” in the SUSE 
LINUX Enterprise Server 9 Administration Guide. The SUSE LINUX Enterprise Server 9 
Administration Guide does not contain instructions for OES-specific components.

After selecting the language setting, you are presented with the Installation Settings proposal. You 
can accept the default settings or customize each setting to fit the needs of your organization. At this 
stage of the installation, you can change settings for the System, Mode, Keyboard Layout, Mouse, 
Partitioning, Software, Booting, Time Zone, Language, and Default Runlevel.

This section gives recommendations or procedures for the following tasks:

• “Setting Up Disk Partitions” on page 28
• “Customizing the Software Selections” on page 28
• “Setting Up the Time Zone” on page 30
• “Accepting the Installation Settings” on page 30
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Setting Up Disk Partitions

In most cases, YaST proposes a reasonable partitioning scheme that can be accepted without change. 
You can also use YaST to customize the partitioning.

For OES Linux, Novell Storage ServicesTM (NSS) volumes can only be used as data volumes, not as 
system volumes. They cannot be created as part of the install process. You must also consider 
whether you will be creating NSS volumes in the future on the devices where you are installing 
Linux. The default volume manager for Linux traditional volumes on SUSE Linux is LVM (Linux 
Volume Manager). However, NSS volumes cannot be created on devices managed by LVM; NSS 
requires EVMS (Enterprise Volume Management System) management of its devices. 

IMPORTANT: If you have only a single device on the server (such as a single physical disk or a 
hardware RAID 1 or RAID 5 device) and you plan to use NSS volumes as data volumes after the 
install, make sure to follow the partition configuration instructions in “Installing Linux with EVMS 
as the Volume Manager of the System Device” on page 119. You can also following this alternate 
setup if you have multiple devices and want to be able to create NSS volumes in the future on the 
same device that contains the system partitions.

Table 3-2 presents guidelines for setting up disk partitions on your OES Linux server. For more 
information, see “Partitioning” in the SUSE LINUX Enterprise Server 9 Administration Guide.

Table 3-2   Partition Guidelines

Customizing the Software Selections

To customize which software packages are installed on the server:

1 On the Installation Settings page, click Software.

Novell Open Enterprise Server is the default predefined server type. If you accept this 
selection, the OES Base install (similar to SLES Default installation) plus most of the OES 
components are installed.

Partition 
to Create Other Considerations

/boot Depending on the hardware, it might be useful to create a boot partition (/boot) to hold the boot 
mechanism and the Linux kernel. 

You should create this partition at the start of the disk and make it at least 8 MB or 1 cylinder. 
As a rule of thumb, always create such a partition if it was included in the YaST original 
proposal. If you are unsure about this, create a boot partition to be on the safe side.

/swap This should normally be twice the size of the RAM installed on your server, up to 1 GB.

/ Define this partition as 3 GB or more.

/var Define this partition as 4 GB or more.

/opt Some (mostly commercial) programs install their data in /opt.

Define this partition as 4 GB or more.

/usr Define this partition as 4 GB or more.

/home You can allocate the rest of the disk space to this partition.
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The following OES components are not preselected and installed by default with the Novell 
Open Enterprise Server predefined server type:

• Novell Cluster ServicesTM

• Novell iFolder® 2.x
• Novell iFolder 3.x 

We recommend that you post-install iFolder 3.x and iFolder 3.x Web Access so that you 
have time before configuring iFolder 3.x to set up supporting services and storage. 
If you want to use an NSS volume to store iFolder data, do not install iFolder 3.x as part of 
the basic OES Linux install. You must first install NSS, then use iManager to set up the 
NSS volume. This volume must exist when you configure the iFolder server. 
For information, see “Prerequisites and Guidelines” and “Installing and Configuring 
iFolder Services” in the Novell iFolder 3.x Administration Guide.

• Novell iFolder 3.x Web Access 
We recommend that you post-install iFolder 3.x and iFolder 3.x Web Access so that you 
have time before configuring iFolder 3.x to set up supporting services and storage. 
If you want to use an NSS volume to store iFolder data, do not install iFolder 3.x as part of 
the basic OES Linux install. You must first install NSS, then use iManager to set up the 
NSS volume. This volume must exist when you configure the iFolder server. 
For information, see “Prerequisites and Guidelines” and “Installing and Configuring 
iFolder Services” in the Novell iFolder 3.x Administration Guide.

• Novell IP Address Management (framework only)
• Novell Storage Services 

If you select the NSS package, you might need to reconsider the disk partition setup you 
have chosen. For information, see “Setting Up Disk Partitions” on page 28 and “Installing 
Linux with EVMS as the Volume Manager of the System Device” on page 119.

2 At this point, you can do any of the following:
• Select one of the other predefined server types.
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• Select one of the other predefined server types, then click Detailed Selections. Then add 
additional items or remove a preselected item by selecting the check box next to the 
applicable item in the Selections list. 

• Click Detailed Selections and add additional items or remove a preselected items by 
selecting the check box next to the applicable item in the Selections list.

For a list of OES predefined server types and the components preselected with each type, see 
Table 2-3 on page 13.

3 When you have the software components selected that you want to install, click Next or Accept 
depending on the actions you performed in Step 2.

4 (Conditional) If the prompt for Automatic Changes displays, click Continue.

Setting Up the Time Zone

To set your correct region, time zone, date, and time, click Time Zone. You can configure this 
information after the installation is complete, but it is easier to do it during the installation.

Accepting the Installation Settings

After you have changed all the Installation Settings as desired, click Accept > Yes, install. 

For a network install, you can remove the network boot CD (Open Enterprise Server SP2 CD 1) 
from the CD drive. 

For a CD install, leave the CD in the CD-ROM drive.

The base installation settings are applied and the server reboots. Proceed with “Specifying 
Configuration Information” on page 31.
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3.3.4  Specifying Configuration Information
When the server reboots, you are required to complete the following configuration information:

• “Root Password” on page 31
• “Network Configuration” on page 31
• “Test Internet Connection and Online Update” on page 32
• “Service Configuration” on page 33
• “OES Configuration” on page 33

Root Password

After the base installation is complete and your server reboots, the Password for “root,” the system 
administrator dialog is displayed. 

For security reasons, the Root password should be between five and eight characters long and should 
contain a mixture of both uppercase and lowercase letters and numbers. The maximum length for 
passwords is 72 characters, and passwords are case sensitive. If you have a password longer than 
eight characters, click Expert Options > Blowfish > OK.

Network Configuration

Configuration success is directly tied to specific networking configuration requirements. Make sure 
that the following settings are configured exactly as specified for the Network Interfaces dialogs.

NOTE: If you selected a manual installation and provided previously the following information, 
you don't need to provide it again. Your network configuration should still be intact. But you still 
need to set the DNS hostname.

Table 3-3   Network Interfaces Settings

Setting Recommendation Steps

IP Address Use a static IP address 
for the network card.

By default, the OES 
Linux installation 
requires you to 
configure the network 
card to use a static IP 
address.

1. During the YaST installation, in the Network 
Configuration panel, click Network Interfaces.

2. From the Network Cards to Configure list, select the 
network card you want to configure and then click 
Configure.

3. Select Static Address Setup, then specify the IP address 
and the subnet mask for the server.
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When you have completed the options for each of the parameters in Table 3-3 for each of the 
network boards in the server:

1 Click Next > Finish to save the network card configuration.

If you receive any errors regarding invalid hostnames or IP addresses, click Back > Back and 
fix your network configuration.

When the network configuration is correct, proceed with Step 2.
2 Click Next to continue with the configuration.

Test Internet Connection and Online Update

At the Test Internet Connection screen:

1 Select Yes, Test Connection to the Internet, then click Next.

Obtaining the latest SUSE release notes might fail at this point. If it does, view the log to verify 
that the network configuration is correct, then, proceed with Step 2.

If the network configuration is not correct, click Back > Back and fix your network 
configuration. See “Network Configuration” on page 31.

You can get the latest release notes at http://www.suse.com/relnotes/i386/Open-Enterprise-
Server/9/release-notes.rpm.

Host Name 
and Domain 
Name

Specify the hostname 
and the DNS domain 
name separately.

1. From the Detailed Settings list, select Host Name and 
Name Server. 

2. Specify the information described for the following two 
fields: 

Host Name: Type only the hostname. Do not include 
DNS domain information with the hostname.

For example: Type only mylinuxbox, not 
mylinuxboxdigitalairlines.com

Domain Name: Type only the domain name without the 
hostname. 

For example, type only digitalairlines.com.

Name Servers Specify one or more 
name servers.

1. From the Detailed Settings list, select Host Name and 
Name Server. 

2. In the Name Servers and Domain Search List panel, 
specify from one to three DNS server IP addresses and 
a domain name for each address.

3. Click OK to return to the Detailed Settings list.

Routing Specify a default 
gateway (router).

1. From the Detailed Settings list, select the Routing option 
and specify the IP address of the default gateway on the 
subnet where you are installing the OES Linux server.

2. Click OK to return to the Detailed Settings list.

Setting Recommendation Steps
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2 Run the online update to download and install any available updates.
2a Click Next.
2b Select Yes, Run Online Update Now.
2c If the update fails, do the following:

2c1 Click OK.
2c2 On the Welcome to YaST Online Update screen in the Update Configuration field, 

click the Installation Source drop-down arrow to select User-Defined Location.
2c3 In the Location field, type http://update.novell.com/YOU.
2c4 Click Next > Accept.

The YaST Online Update (YOU) client contacts the YOU server and checks for new 
patches that are considered mandatory, even those that have already been applied. 
The YOU client automatically selects the newer patches, downloads them, and 
applies them.

2c5 Click Close.
2c6 If this still fails, you can continue with the installation, then update the server later. 

See “Patching an OES Linux Server” on page 57.

Service Configuration

In the Service Configuration screen, there are two important things to keep in mind:

At the CA Management screen, do not skip this configuration.

The certificate that is created is used by the Apache Web server. If you skip this configuration, 
each service that uses Apache will not work. The option to run the CA Management 
configuration is selected by default.

For more information about Certificate Authority Management, see “X.509 Certification with 
YaST” in the SUSE LINUX Enterprise Server 9 Administration Guide.
Do not enable OpenLDAP server. 
Because the Novell eDirectoryTM LDAP server replaces the SLES 9 OpenLDAP server, you 
must not select this option. It is deselected by default.

OES Configuration

At the beginning of the OES configuration, you are given the option to Configure Now or Configure 
Later. 

If you select Configure Now (recommended), you are prompted for the configuration information 
for each OES component you are installing. Common configuration values populate common fields, 
so you don't have to type them in each time. 

If you select Configure Later, you will configure the OES components after the installation is 
complete. See “Installing or Configuring OES Components on an Existing Server” on page 51.

When confirming the OES component configurations, you might receive the following error:

The proposal contains an error that must be resolved before 
continuing.
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If this error is displayed, check the list of configured products for a message immediately below the 
product heading that indicates the product needs to be configured. If you are running the YaST 
graphical interface, the text appears red. If you are installing using the YaST text-base interface, it is 
not red.

For example, if you have selected iFolder 2 in connection with other OES Web service products, 
you see a message that iFolder 2 needs to be configured.

You must then assign iFolder an alternate IP address, subnet mask, and hostname for the iFolder 
service to use. And if you have installed Novell NetStorageTM, you should also configure it with the 
iFolder server IP address.

After resolving all product configuration problems, you can proceed with the install.

Each OES component and the configurable fields associated with it are listed in the following 
sections. These components also include the default or previously entered values, where applicable. 
Some components might require some additional configuration as part of the OES installation; this 
information is also included in the tables. If the component requires configuration that is not part the 
OES installation, see the component's administration guide for more information. You can find 
administration guides for all OES products at the OES Documentation Web site  (http://
www.novell.com/documentation/oes/oes_home/data/allguides.html#allguides).

Keep the following in mind as you configure the OES components:

Table 3-4   Guidelines for Configuring OES Components

Issue Guideline

Software 
Selections When 
Using Text-Based 
YaST

Some older machines (Dell* 1300) use the text mode install by default when the 
video card does not meet SLES 9 specifications. When you go into the Software 
Selection, and then to the details of the OES software selections, YaST doesn’t 
bring up the OES selections like it does when you use the graphical YaST (YaST2). 

To view this screen, select Filter > Selections (or press Alt+F > Alt+I).

Specifying Typeful 
Admin Names

When installing OES, you must specify a fully distinguished admin name using the 
typeful syntax that includes object type abbreviations (cn=, ou=, o=, etc.). For 
example, you might specify the following:

cn=admin.ou=example_organization.o=example_company
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After you complete the eDirectory information fields the server configures all of the other selected 
OES component. A summary screen is displayed showing all the components and their 
configuration settings. Review the setting for each component and click the component heading to 
change any settings required. When you are satisfied with the settings for each component, click 
Next.

The following section lists the specific information required for each component:

• “Novell eDirectory Configuration” on page 36
• “Novell eGuide” on page 37
• “Novell Backup Services (SMS)” on page 37
• “Novell Cluster Services” on page 38

Using Dot-
Delimited or 
Comma-Delimited 
Input for All 
Products

For all parameters requiring full contexts, you can separate the names using dot-
delimited or comma-delimited syntax; however, you must be consistent in your 
usage within the field. Do not mix dot and comma delimitations.

The OES installation routine displays all input in the dot-delimited (NDAP) format. 
However, it converts the name separators to commas when this is required by 
individual product components.

When using NDAP format (periods), you must escape all embedded periods. For 
example:
cn=admin.o=novell\.provo

When using LDAP format (commas), you must escape all embedded commas. For 
example:
cn=admin,o=novell\,provo

IMPORTANT: After the OES components are installed, be sure to follow the 
conventions specified in the documentation for each product. Some contexts must 
be specified using periods (.) and others using commas (,). However, eDirectory TM 
supports names like cn=juan\.garcia.ou=users.o=novell. The period (.) inside a 
name component must be escaped.

The installation disallows a backslash and period (\.) in the CN portion of the admin 
name. 

For example, these names are supported:

cn=admin.o=novell
cn=admin.o=novell\.provo
cn=admin.ou=deployment\.linux.o=novell\.provo

These names are not supported:

cn=admin\.first.o=novell
cn=admin\.root.o=novell

Before LUM enabling users whose cn contains a period (.), you must remove the 
backslash (\) from the unique_id field of the User object container.

For example, cn=juan.garcia has a unique_id attribute = juan\.garcia. Before such a 
user can be LUM enabled, the backslash (\) must be removed from the unique_id 
attribute.

Issue Guideline
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• “Novell Health Monitoring” on page 39
• “Novell iFolder 2.x” on page 39
• “Novell iFolder 3.x” on page 40
• “Novell iFolder 3.x Web Access” on page 40
• “Novell iManager” on page 41
• “Novell iPrint” on page 41
• “Novell Linux User Management” on page 41
• “Novell NCP Server” on page 42
• “Novell NetStorage” on page 42
• “Novell QuickFinder” on page 43
• “Novell Samba” on page 43
• “Novell Storage Services (NSS)” on page 43

Novell eDirectory Configuration

Table 3-5   Novell eDirectory Configuration Parameters and Values

Synchronizing Server Time

eDirectory requires that all OES servers, both NetWare and Linux, are time synchronized. 

For information on this important topic, see “Implementing Time Synchronization” in the Novell 
OES SP2 Planning and Implementation Guide.

Parameter Default or Previously Entered Values

New or Existing Tree Name exampletree

FDN Admin Name with Context cn=admin.o=example

Server Context o=example

Directory Information Base (DIB) Location /var/nds/dib

LDAP Port 389

LDAP Secure Port 636

iMonitor HTTP Port 8028

iMonitor HTTPS Port 8030

Network Time Protocol (NTP) Server Local Clock

eDirectory Server Port 524

LDAP Server IP Address
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SLP Configuration

You have the following options for configuring SLP:

• Do Not Configure SLP: This option is good for eDirectory trees with three or fewer 
eDirectory servers.

Without SLP, users won't be able to see a tree list, but they should still be able to attach to a tree 
by name. Users can configure the Novell Client to use DNS, or they can configure the local 
host file (%SystemDrive%\windows\system32\drivers\etc\hosts on WinXP) 
to resolve tree and server names. Users can also specify preferred tree and context information 
in the DHCP Settings page of the Novell Client.

• Use Multicast to Access SLP: This option allows the server to request SLP information using 
multicast packets. Use this in environments that have not established SLP DAs (Directory 
Agents).

• Configure SLP to use an existing Directory Agent: This option configures SLP to use an 
existing Directory Agent (DA) in your network. Use this in environments that have established 
SLP DAs. When selecting this option, you configure which servers to use by adding or 
removing them from the SLP Directory Agent list.

For more information about configuring SLP, see “Configuring OpenSLP for eDirectory”Novell 
eDirectory 8.7.3 Administration Guide.

Novell eGuide

Table 3-6   Novell eGuide Parameters and Values

Novell Backup Services (SMS)

Table 3-7   Novell Backup Services Parameters and Values

Parameter Default or Previously Entered Values

eDirectory Host frankm.houston.example.com

Admin Name with Context cn=admin.o=example

eDirectory LDAP Port 389

eDirectory LDAP Secure Port 636

Parameter Default or Previously Entered Values

Server Admin Name with Context cn=admin.o=example

LDAP IP Address 127.0.0.1

LDAP Secure Port 636
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Novell Cluster Services

Table 3-8   Novell Cluster Services Parameters and Values

Additional Cluster Services Configuration Information

On the Installation Settings screen, click Cluster Services and do the following:

1 Select whether you are installing locally or remotely, accept or change the admin name and 
password, then click Next.

Locally indicates that you are also installing eDirectory on this server. We recommend that you 
install eDirectory on cluster nodes. If you are not installing eDirectory on this server, select 
Remote.

NOTE: When installing OES Linux clustering into a NetWare 5.1 or NetWare 6 tree, the Local 
LDAP server option should be used or clustering might fail to install. NetWare 5.1 or NetWare 
6 LDAP servers are incompatible with the OES Linux Cluster Services installation.

2 Choose to either create a new cluster or install Novell Cluster ServicesTM on a server that you 
will add to an existing cluster, or configure later.
Create a New Cluster is the default when installing Novell Cluster Services during the OES 
installation.

3 Specify the fully distinguished name (FDN) of the cluster.

NOTE: Use the dot format illustrated in the example. Do not use commas.

If you are creating a new cluster, this is the name you will give the new cluster and the 
eDirectory context where the new Cluster object will reside.
If you are adding a server to an existing cluster, this is the name and eDirectory context of the 
cluster that you are adding this server to.

4 (Conditional) If you are creating a new cluster, specify a unique IP address for the cluster.
The cluster IP address is separate from the server IP address, is required to be on the same IP 
subnet as the other cluster servers, and is required for certain external network management 
programs to get cluster status alerts. The cluster IP address provides a single point for cluster 
access, configuration, and management. A Master IP Address resource is created automatically 
during the Cluster Services installation that makes this possible.
The cluster IP address is bound to the master node and remains with the master node regardless 
of which server is the master node.

Parameter Default or Previously Entered Values

New or Existing Cluster New Cluster

Cluster Name with Context

Node Name frankm

Node's IP Address 127.0.0.1

Start Clustering Now
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5 (Conditional) If you chose to install remotely in Step 1 on page 38, accept the default server 
name and IP address (recommended), or specify the IP address and server name for server that 
has eDirectory installed.

6 (Conditional) If you are creating a new cluster:
6a Specify the device where you want the SBD partition to be created, then click Next.

For example, the device might be something similar to /dev/sdc.
If you have a shared disk system or SAN attached to your cluster servers, Novell Cluster 
Services creates a small cluster partition on that shared disk system. This small cluster 
partition is referred to as the Split Brain Detector (SBD) partition. Provide the drive or 
device where you want the small cluster partition created.
If you do not have a shared disk system connected to your cluster servers, accept the 
default (none). 

IMPORTANT: You must have at least 20 MB of free space on one of the shared disk 
drives to create the cluster partition. If no free space is available, the shared disk drives 
can't be used by Novell Cluster Services.

6b Select the IP address clustering should use. If you have multiple network boards installed, 
you need to select the IP address bound to the desired network board.

6c Start clustering now indicates if clustering should start now or after the machine is 
rebooted.

7 Continue through the rest of the OES installation.

Novell Health Monitoring

Table 3-9   Novell Health Monitoring Parameters and Values

Novell iFolder 2.x

Table 3-10   Novell iFolder 2.x Parameters and Values

Parameter Default or Previously Entered Values

LDAP Admin Name with Context cn=admin.o=example

LDAP IP Address 127.0.0.1

LDAP Secure Port 636

Parameter Default or Previously Entered Values

LDAP Admin Name with Context cn=admin.o=example

LDAP IP Address 127.0.0.1

LDAP Secure Port 636

iFolder 2.x Server IP Address

iFolder 2.x Server Netmask
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Novell iFolder 3.x

When you configure iFolder as part of the OES install and configuration, you can specify only an 
EXT3 or ReiserFS volume location for the System Store Path, which is where you are storing 
iFolder data for all your users. You cannot create NSS volumes during the system install.

If you want to use an NSS volume to store iFolder data, you must reconfigure iFolder 3.x and 3.x 
Web Access after the OES install. To reconfigure, use Novell iManager to create an NSS volume, 
then go to YaST > Network Services and select iFolder 3.x and iFolder 3.x Web Access to enter new 
information. All previous configuration information is removed and replaced. 

Table 3-11   Novell iFolder 3.x Parameters and Values

Novell iFolder 3.x Web Access

If you plan to reconfigure iFolder 3.x after the OES configuration to use an NSS volume as the 
System Store Path, make sure you also reconfigure iFolder 3.x Web Access. 

Table 3-12   Novell iFolder 3.x Web Access Parameters and Values

iFolder 2.x Server DNS Name

iFolder 2.x User Data Path /var/opt/novell/ifolderdata

iFolder 2.x Admin Users

Parameter Default or Previously Entered Values

Directory Server Address Local select by default

Admin Name with Context cn=admin.o=example

LDAP Port 389

LDAP Secure Port 636 

A secure port is recommended when the eDirectory 
server and iFolder enterprise server are on different 
computers.

iFolder Admin DN

iFolder Admin Password

Proxy Context

System Name

System Store Path /var/opt/novell/ifolder3

System Description

Parameter Default or Previously Entered Values

Web Access Alias /ifolder

Parameter Default or Previously Entered Values
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Novell iManager

Table 3-13   Novell iManager Parameters and Values

NOTE: iManager is fully functional from a SUSE Linux server console using Mozilla* 1.7 or 
Mozilla* Firefox* 1.0 browsers only.

Novell iPrint

Table 3-14   Novell iPrint Parameters and Values

Novell Linux User Management

Table 3-15   Novell Linux User Management Parameters and Values

iFolder Server URL http://localhost

https://IP_address 

Specify an HTTPS and an IP address to configure 
secure SSL exchanges between the Web Access 
server and the iFolder enterprise server. 

Parameter Default or Previously Entered Values

eDirectory Tree Name exampletree

eDirectory Admin with Context cn=admin.o=example

Parameter Default or Previously Entered Values

iPrint eDirectory tree exampletree

LDAP IP address 127.0.0.1

LDAP Admin name with context cn=admin.o=example

LDAP secure port number 636

Parameter Default or Previously Entered Values

LDAP Admin Name with Context cn=admin.o=example

LDAP Server IP Address 127.0.0.1

LDAP Port Number 389

LDAP Secure Port 636

Linux/Unix Config Context o=example

LUM Workstation Context o=example

Parameter Default or Previously Entered Values
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Novell NCP Server

Table 3-16   Novell NCP Server Parameters and Values

Novell NetStorage

Table 3-17   Novell NetStorage Parameters and Values

Proxy User Name with Context

PAM-enabled Services to Allow Authentication via 
eDirectory:

login: yes
ftp: yes
sshd: yes
su: yes
rsh: yes
rlogin: yes
passwd: no
xdm: yes
openwbem: yes

IMPORTANT: Before you accept the default PAM-
enabled service settings, be sure you understand 
the security implications explained in “User 
Restriction Limitations” in the Novell OES SP2 
Planning and Implementation Guide.

Parameter Default or Previously Entered Values

Admin Name with Context cn=admin.o=example

Parameter Default or Previously Entered Values

Directory Server Address frankm.houston.example.com

Admin Name with Context cn=admin.o=example

LDAP Secure Port 636

iFolder 2 Server Address

Authentication Domain Host frankm.houston.example.com

Proxy User Name with Context cn=admin.o=example

User Context o=example

Parameter Default or Previously Entered Values
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Novell QuickFinder

Table 3-18   Novell QuickFinder Parameters and Values

Novell Samba

Table 3-19   Novell Samba Parameters and Values

Novell Storage Services (NSS)

Table 3-20   Novell Storage Services Parameters and Values

Parameter Default or Previously Entered Values

QuickFinder Admin Name cn=admin.o=example

LUM Enable QuickFinder Admin User yes

eDirectory Admin Name cn=admin.o=example

Add novlwww User to the Shadow Group yes

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password

LDAP Port 389

LDAP Secure Port 636

Base Context for Samba Users o=example

Proxy User Name with Context cn=admin.o=example

Proxy User Password

Parameter Default or Previously Entered Values

LDAP Address 127.0.0.1

LDAP Port 389

LDAP Secure Port 636

Server Admin Name cn=admin.o=example

NSS Admin Name cn=serveradmin.o=example
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3.3.5  Finishing the Installation
The installation concludes with the following steps:

1. Cleanup
2. Release Notes
3. Device Configuration

After you click Finish, the OES Linux server finishes loading the configured components and 
reboots.

3.4  What's Next
After you've completed the initial installation, complete any additional tasks you might need to 
perform. See “Completing Post-Installation Tasks” on page 49 and “Patching an OES Linux Server” 
on page 57.
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4Upgrading to OES Linux

This section describes how to upgrade a SUSE® Linux Enterprise Server (SLES) 9, SLES 9 SP1, 
SLES 9 SP2, or SLES 9 SP3 server to OES Linux. This is the only supported upgrade for this 
release.

• Section 4.1, “Meeting the Upgrade Requirements,” on page 45
• Section 4.2, “Upgrading the Server,” on page 47
• Section 4.3, “What's Next,” on page 48

4.1  Meeting the Upgrade Requirements 
Meet the following OES Linux requirements before you install any OES Linux components:

• Make sure the server has a static IP address.
• Make sure DNS returns the server's DNS name when presented with the server's IP 

address. You can the use host to validate this item.
• Make sure the server has a server certificate that has been generated and exported as a 

Common Server certificate.
To check for or add a certificate, do the following:

a. Launch YaST.
b. Click Security and Users > CA Management.
c. If no Certificate Authorities (CAs) are listed, create one by clicking Create Root CA.

 If a CA is listed, you can use it by selecting the CA and clicking Enter CA.
d. If you are using a listed CA, you must provide the CA password (generally the root 

password).
e. Click Certificates > Add.
f. Fill out the forms required for a server certificate. After the last form is complete, a 

server certificate is created and listed in the certificate list.
g. Select the certificate you just created.
h. Click the Export button, then select Export as common server certificate.

If you are upgrading from a server with either OpenLDAP or eDirectoryTM already installed and 
running, you have several options. Select one that matches your situation.

• Upgrade the server with OpenLDAP to OES without eDirectory. 
In this scenario, make sure that eDirectory is available somewhere on the network. 
However, when upgrading to OES on this server, do not select eDirectory. For other OES 
services that are installed during the upgrade, make sure that they are configured to use the 
existing eDirectory servers as an LDAP backend rather than the local OpenLDAP server.
Any existing users of OpenLDAP will not be affected. However, you might need to use a 
product such as Nsure Identity Manager 2 to synchronize between the various directories 
in your environment.

• Upgrade the server with OpenLDAP to OES with eDirectory.
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Make sure that no LDAP daemon is running on the server by doing the following:

IMPORTANT: The OpenLDAP that ships with SLES conflicts with the eDirectory 
LDAP and causes problems in the upgrade. 

a. At a command prompt, check to see if the LDAP daemon is running by entering
 ps -e | grep slapd

b. To stop the LDAP daemon, enter
 kill -9 process_ID
 The process ID is displayed in Step 1.

c. Prevent the LDAP daemon from loading in the future by entering
 chkconfig ldap off 

d. Check to make sure the LDAP daemon is turned off by entering
 chkconfig -l 

If you want to migrate the data from the existing OpenLDAP server to the new eDirectory 
server, perform the following steps:

a. Export your data from the OpenLDAP server before you begin the upgrade. If you do 
not, you will lose any data stored in the OpenLDAP directory database.

b. Prepare the new eDirectory tree with schema that is compatible for the data that has 
been exported from the OpenLDAP server.

c. Import the data into the new eDirectory tree.
Even if you do not migrate the data from the OpenLDAP server to eDirectory, if you plan 
to use eDirectory as an LDAP back end for the various SLES components (for example, 
User Management and DNS/DHCP server configuration data), you must prepare the new 
eDirectory tree with the schema definitions found in /opt/novell/ldif/
schemadiff.ldif. Then you must configure those components to use the new 
eDirectory LDAP front end.
In this scenario, the current Open Enterprise Server product does not provide any tools to 
do this upgrade and migration automatically. Novell is looking at the possibility of 
providing these tools in future releases.

• Upgrade a server that has eDirectory 8.7.3 IR3 to OES with eDirectory.
The version of eDirectory that ships with OES is 8.7.3 IR5. The only earlier version of 
eDirectory supported on SLES 9 is 8.7.3 IR3. If the IR3 version of eDirectory is already 
installed and you want to upgrade to OES eDirectory, you can simply select eDirectory 
during the OES upgrade process and eDirectory is automatically updated correctly, even if 
the eDirectory DIB has been relocated to a non-standard location. An administrator 
familiar with eDirectory administration and configuration can easily determine whether 
the automatic upgrade was successful and manually adjust any of the configuration 
settings that need to be changed or optimized.

Review and complete the instructions for “Preparing the OES Linux Files for Installation” on 
page 21. We recommend using the network installation option, especially if you are installing 
multiple servers.
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4.2  Upgrading the Server
1 Shut down the server you want to upgrade.
2 Insert Open Enterprise Server SP2 CD 1 into the CD-ROM drive of the server you want to 

upgrade to OES Linux and boot the machine.
3 Use the following instructions applicable to the method of installation you are using:

• Network Installation Using DHCP (page 26)
• Network Installation without DHCP (page 26)
• CD Installation (page 27)

When you are done with one of the above options, continue with Step 4.
4 On the License Agreement screen, click I Agree.
5 Select a language, then click Accept.
6 Select Update an Existing System, then click OK.
7 Click Update Options.
8 Select Update with Installation of New Software and Features Based on Selection.

The initial screen reads “Upgrade to SUSE CORE 9”. Ignore this. You are actually upgrading 
to Open Enterprise Server.

9 Select Novell Open Enterprise Server, then click Accept.

IMPORTANT: Make sure you select Open Enterprise Server. If you manually select another 
option, the upgrade process does not copy the OES components to the server.

10 Click Yes, then click Accept.
11 Click Yes, then click Update.
12 (Conditional) For a network install, remove Open Enterprise Server SP2 CD 1 from the CD 

drive. For a CD install, leave the CD in the CD drive until prompted to change it.
13 Follow the prompts to complete the file copy portion of the upgrade.

For a network installation, the upgrade should proceed without much interaction.
For a CD installation, change CDs when prompted.
The upgrade copies the OES Linux components and RPMs to the server and then reboots the 
server.

14 When the server comes back up, click No, Skip This Test, then click Next.
15 Click Next, then click Finish.

The server reboots again and you can log in.
At this point the OES components and RPMs have been copied to the server. You still need to 
configure the components that you want to run on the server.

16 Configure the OES components.
16a Log in to the server as Root.
16b Launch YaST.
16c Select a component from one of the following YaST categories and follow the prompts to 

complete the configuration. For specific information on configuring OES components, see 
“OES Configuration” on page 33.
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4.3  What's Next
After you've completed the Upgrade, see “Completing Post-Installation Tasks” on page 49.

YaST Category OES Components

Security and Users Linux User Management

Network Services eDirectory

eGuide

iManager

iFolder 2.x

iFolder 3.x

iFolder 3.x Web Access

iPrint

LDAP Servers

NCP Server

NetStorage

Novell Health Monitoring

Novell Remote Manager

Novell QuickFinder

Novell Samba

System Novell Cluster Services (NCS)

Novell Storage Services (NSS)

SMS
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5Completing Post-Installation 
Tasks

This section provides information for completing the following tasks:

• Section 5.1, “Verifying That the Installation Was Successful,” on page 49
• Section 5.2, “Determining Which Services Need Additional Configuration,” on page 50
• Section 5.3, “Installing or Configuring OES Components on an Existing Server,” on page 51
• Section 5.4, “Changing Keyboard Mapping,” on page 53
• Section 5.5, “Completing Additional Tasks for Networks or Servers Running NSS on OES 

Linux Servers,” on page 55
• Section 5.6, “Resolving the Certificate Store Error,” on page 55

5.1  Verifying That the Installation Was 
Successful
One way to verify that your OES Linux server installation was successful and that the components 
are loading properly is to watch the server reboot. As each component is loaded, the boot logger 
provides a status next to it indicating if the component is loading properly. 

You can also quickly verify a successful installation by accessing the server from your Web browser.

NOTE: iManager is fully functional from a SUSE® Linux server console using Mozilla 1.7 or 
Mozilla Firefox 1.0 browsers only.

1 In the Address field of your Web browser, enter the following URLs:

http://IP_or_DNS

or 

http://localhost

where IP_or_DNS is the IP address or DNS name of your OES Linux server and localhost is 
the local hostname of the OES Linux server.
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You should see a screen similar to the following:

IMPORTANT: Do not access the End User Software links at this point. Most of these services 
require further configuration, as explained in the Novell OES SP2 Planning and 
Implementation Guide.

2 (Optional) If you want to see the eDirectoryTM tree and begin to get a feel for how iManager 
works, click Network Management > iManager 2.5.x, click Open iManager 2.5 under 
iManager Links, and then log in as user Admin (the user you created during product 
installation).
You can also access iManager by typing the following URL in a browser window and logging 
in as user Admin:
http://IP_or_DNS_name/nps/iManager.html

5.2  Determining Which Services Need Additional 
Configuration
Depending on the products you have installed, there might be some tasks that you must complete 
before you can use individual service components.

Refer to the following sections in the Novell OES SP2 Planning and Implementation Guide:
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Table 5-1   Information in the OES Planning and Implementation Guide

5.3  Installing or Configuring OES Components 
on an Existing Server
IMPORTANT: If you have patched a server, make sure the installation source is pointing to the 
latest Support Pack media. For procedures on updating the installation source, see “Updating 
Installation Sources Using YaST” on page 75. 

If the server was installed and patched using physical media, make sure to download and insert the 
media from the latest Support Pack when prompted for the CD.

To post-install or configure OES components on an existing OES Linux server:

1 Open YaST.
2 Select the OES component that you want to install from the following YaST categories:

For Information About Review

Getting started with the 
services that you have 
installed

The following sections apply to the services that you have installed:

• “Management Interfaces and Services” for information about Using the 
OES Welcome Site and OES Utilities and Tools 

• “Identity and Directory Services” for information about eDirectory, 
Identity Management Services, and LDAP (eDirectory)

• “Infrastructure Services” for information about Auditing, Authentication, 
Backup, Clustering and Failover, Databases, DNS, DHCP, and 
OpenSLP, and TCP/IP, iSCSI, Licensing, Search, Security, Storage for 
File Services, Time Synchronization, and Web and Application Services 

• “End User Services” for information about Access Control, Novell 
ClientTM Utilities, File Services, Print Services, and White Pages 
(eGuide)

Caveats that you should 
know before starting to 
use your new server

“Implementation Caveats”

IMPORTANT: If you use Novell® Storage ServicesTM (NSS) on OES Linux, 
after installing the first OES Linux server in a tree, there are some 
procedures you need to follow for every subsequent OES Linux server you 
install in the tree. See “Always Check for an nssid.sh File” in the Novell OES 
SP2 Planning and Implementation Guide.

YaST Category OES Component

Security and Users Linux User Management
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Not all OES components require eDirectory to be installed on the local server. Components that 
have a dependency on eDirectory being installed locally will prompt you to install eDirectory if 
it is not already installed, but when eDirectory is installed this way, other components with an 
eDirectory dependency do not recognize that eDirectory has been installed. 

IMPORTANT: If you want the OES components to use a local eDirectory database, we 
recommend that you post-install eDirectory before installing any other OES component.

The following services have eDirectory dependencies:
• Novell eGuide
• Novell iPrint
• Novell NCP Server
• Novell Cluster Services
• Novell NetStorage
• Novell NSS
• Novell iManager (eDirectory must be somewhere in the network)

3 After selecting the component to install, follow the on-screen prompts for that component until 
it is completely installed.

4 Repeat Step 2 and Step 3 for each component that you want to post-install.

Network Services eDirectory

eGuide

iManager

iFolder 2.x

iFolder 3.x

iFolder 3.x Web Access

iPrint

LDAP Servers

NCP Server

NetStorage

Novell Health Monitoring

Novell Remote Manager

Novell QuickFinder

Novell Samba

System Novell Cluster Services (NCS)

Novell Storage Services (NSS)

SMS

YaST Category OES Component
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5.3.1  Installing eDirectory 8.8

IMPORTANT: Failure to deploy eDirectory 8.8 correctly can cause the server to fail. Make sure 
you read and follow all the specified procedures.

The OES Linux installation program installs eDirectory 8.7.3. If you want to upgrade a server to use 
eDirectory 8.8, you must update your server to OES SP2, then upgrade to eDirectory 8.8. For 
procedures, see the following information:

Table 5-2   Information for Updating to OES SP2 and eDirectory 8.8

5.4  Changing Keyboard Mapping
After the OES Linux installation is complete, if the keyboard mapping is set to German rather than 
to U.S. English (or whichever language you selected), the problem can be fixed by editing the 
XF86Config file.

For example, typing a slash (/) will show a dash (-) or typing y will display z. 

NOTE: This mapping problem might occur when the screen that prompts for the configuration of 
graphics, sound, and printers is skipped or when some error occurs while processing the input to this 
screen.

To fix the problem:

1 Press Ctrl+Alt+F2.
2 Log in as root.
3 At a command console prompt, enter: 
vi /etc/X11/XF86Config

Tasks Specified Procedures

Update the server to OES Linux SP2. Chapter 6, “Patching an OES Linux Server,” on 
page 57

Learn about known issues before updating to 
eDirectory 8.8.

TID 01100450 “Deploying eDirectory 8.8 on Open 
Enterprise Server SP2” (http://support.novell.com/
cgi-bin/search/searchtid.cgi?10100450.htm)

Upgrade the server to eDirectory 8.8. • “Installing or Upgrading Novell eDirectory on 
Linux” in the Novell eDirectory 8.8 Installation 
Guide 

• eDirectory 8.8 Readme (http://
www.novell.com/documentation/edir88/
readme/readme.txt)
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4 Under the Input Devices section, edit the line that contains Options “Xkblayout” “de” 
and replace “de” with “us” or other applicable language codes. For a list of applicable 
language codes, see Table 5-3.
4a Use the Down-arrow key to move to the line under the Input Devices section that contains: 

Option     “Xkblayout” “de”

4b Use the Right-arrow key to move the cursor over the d.
4c Use the Delete key to remove de.
4d Enter the Insert mode by typing 

i
4e Type us (or the two letters for your language) between the two double-quote marks (“”).

For example, if you are changing to U.S. English, the line should read:
Option     “Xkblayout” “us”

4f Exit the Insert mode by pressing Esc.
5 Save the change and exit the vi editor by entering 
:wq

6 Exit the console shell by entering 
exit

7 Return to the X Server screen by pressing Ctrl+Alt+F7.
8 Restart xserver by pressing Ctrl+Alt+Backspace.

The following table contains some of the language codes that you might need for keyboard 
mappings. For additional codes, see the /usr/X11R6/lib/X11/xkb/symbols directory.

Table 5-3   Language Codes for Keyboard Mapping

Language Code

Brazilian br

Canadian ca

Czech cs or cz

German de

French fr

Japanese jp

Norwegian no

Polish pl

Portuguese pt

Romanian ro

Russian ru

Swedish se

Turkish tr
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5.5  Completing Additional Tasks for Networks or 
Servers Running NSS on OES Linux Servers
If you use Novell Storage Services (NSS) on OES servers in your network or have just installed it on 
a server, complete the following procedures as applicable.

• Section 5.5.1, “Checking for an nssid.sh File,” on page 55
• Section 5.5.2, “Rebooting Server after Post-installing NSS,” on page 55

5.5.1  Checking for an nssid.sh File
If you use Novell Storage Services (NSS) on OES Linux, after installing the first OES Linux server 
in a tree, you should check every subsequent server to see whether the /opt/novell/
oes_install/nssid.sh file exists.

If this script file exists, you must run it on the server to synchronize the file ownership information 
for specific system users. For more information, see “Always Check for an nssid.sh File” in the 
Novell OES SP2 Planning and Implementation Guide.

5.5.2  Rebooting Server after Post-installing NSS
If you post-install NSS on an OES Linux server, enter rcnovell-smdrd restart at the 
command prompt or reboot the server before performing any backups, restores, or server 
consolidations on the NSS file system.

5.6  Resolving the Certificate Store Error
After installing OES, you might receive the following error:

Warning - Unable to change the group owner of the certificate store 
to www

To resolve this error, run the chgrp command on the /opt/novell/lib/java2/jre/lib/
security/cacerts certificate file using the following command in a command shell:

chgrp www /opt/novell/lib/java2/jre/lib/security/cacerts

Ukrainian ua

US/ASCII us

Vietnamese vn

Yugoslavian yu

Language Code
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6Patching an OES Linux Server

Patching a server consists of applying updates via patches to an existing server that is running Open 
Enterprise Server (OES) Linux. Using the procedures specified in this section, you can update a 
single server with the patches on OES Support Pack 2 CDs or ISO images, or you can download all 
the latest SUSE® Linux Enterprise Server (SLES) 9 and OES patches from the OES patch channel.

Patches fix problems that might exist in the server operating system, kernel, and in OES services 
that you have installed and configured on the server. 

A package consists of an individual rpm. A patch can consist of one or more rpm packages and can 
also reference script files. Patches use the metadata found in a directory on the server whereas 
packages use the metadata found in the individual rpm spec files. Therefore, if you install individual 
packages, the patch update process will not see these packages as having been installed because it 
uses a different set of metadata. Although Open Enterprise Server has the ability to update the server 
using either packages or patches, it uses patches for the reasons just mentioned as well as to 
maintain the same certification as SLES 9.

Applying individual patches to server running OES Linux is not recommended, see Doc ID: 204 
“Should I update my Open Enterprise Server with individual PSDB files?” (https://secure-
support.novell.com/KanisaPlatform/Publishing/590/204_f.SAL_Public.html)

For more information on what the OES Support Pack contains, see “Major Enhancements in the 
Support Packs” in the Novell OES SP2 Planning and Implementation Guide.

WARNING: If you have installed any of the OES server types or Novell® packages on the server, 
you must use the procedures in this document rather than any Update procedures specified in the 
SUSE LINUX Enterprise Server 9 Administration Guide.

If you have a SLES-only OES Linux server (no OES services installed on the server), you must 
patch the server using the procedures specified in TID 10098329 “Patch Open Enterprise Server 
With YaST Online Update” (http://support.novell.com/cgi-bin/search/searchtid.cgi?/10098329.htm).

If you are managing the server updates with the ZENworks® Linux Management 6.6.2 product, you 
must use the server procedures in the Novell ZENworks Linux Management Administration Guide 
(http://www.novell.com/documentation/zlm/index.html). The procedures specified in this document 
and the procedures in ZENwork Linux Management product 6.6.2 do not work in the same way.

If you are using Novell ZENworks 7 to install and manage your servers, you cannot use it to update 
OES Linux servers. You must use ZENworks Linux Management 6.6.2.

To patch the server, use these basic steps:

1 Prepare the server for the patching to OES SP2 Support Pack only or patching to OES SP2 plus 
the latest patches.

2 Patch the server using one of these methods: 
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Table 6-1   Methods for Patching a Server

3 Update the server’s Installation source.
4 Configure services on the server after installing the OES Support Pack patches.

The following sections include detailed procedures and additional information for completing these 
steps:

• Section 6.1, “Preparing the Server for Patching,” on page 59
• Section 6.2, “Patching Using a Patch CD or ISO Images,” on page 65
• Section 6.3, “Patching a Server From the ZLM Channel Using the Red Carpet Command Line 

(rug),” on page 69
• Section 6.4, “Patching a Server From the ZLM Channel Using the Red Carpet GUI,” on 

page 71
• Section 6.5, “Updating Installation Sources Using YaST,” on page 75
• Section 6.6, “Configuring Services After Applying an OES Support Pack,” on page 77
• Section 6.7, “Getting More Information about the Patch Process,” on page 79
• Section 6.8, “Patching Quick Paths for Experts,” on page 79

Method When to Use It

Using a Patch CD or ISO images

See “Patching Using a Patch CD or 
ISO Images” on page 65.

• You want to update the server to only OES Support 
Pack 2 with no additional patches.

• The connection to the Internet has low bandwidth

• You want to perform the update quickly

NOTE: Patching the server from a Patch CD or ISO 
images includes only the updates from a specific Support 
Pack. 

If you want to update the server to all the latest patches, 
you must use one of the methods that gets patches from 
the OES ZLM channel.

From the ZLM Channel using the 
command line (rug). 

See “Patching a Server From the ZLM 
Channel Using the Red Carpet 
Command Line (rug)” on page 69.

• You want to update the server with all the latest 
patches

• The server has a working Internet connection

• You want to use the command line interface

From the ZLM Channel using the Red 
Carpet® GUI (red-carpet) 

See “Patching a Server From the ZLM 
Channel Using the Red Carpet GUI” 
on page 71.

• You want to update the server with all the latest 
patches

• The server has a working Internet connection

• You want to use the graphical user interface (GUI)
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6.1  Preparing the Server for Patching
To prepare an OES Linux server for the patching:

1 Download the OES SP2 prepatch script and updated ISO images. 

See “Downloading the Prepatch Script and Updated ISO Images” on page 59.
2 Ensure that all services that you want to run on the server are installed. 

See “Ensuring that All Services Are Installed before Patching the Server” on page 60.
3 Ensure that the server has enough disk space for the Support Pack patches. 

See “Ensuring that the Server Has Enough Disk Space for the Support Pack Patches” on 
page 61

4 (Conditional) If you are patching an OES FCS server and iPrint Services are running, stop 
them. 
See “Stopping iPrint Services” on page 61

5 Run the OES SP2 prepatch script. 
See “Running the OES SP2 Prepatch Script” on page 62

6.1.1  Downloading the Prepatch Script and Updated ISO 
Images
To update an OES Linux server to OES SP2, you need an OES SP2 prepatch script and possibly the 
updated ISO images. You only need the ISO images if you are going to patch the server using CDs 
created from the ISO images or patch the server using the downloaded images. If you are updating 
from CDs or ISO images only, you do not need to download or run the OES SP2 prepatch script.

IMPORTANT: If you have already run the oessp2prepatch script on the server, you do not need to 
run it again.

Download the following software from the OES Consolidated Support Pack Web site (http://
support.novell.com/tools/csp/csp_oessp2.html):

• Prepatch script file oessp2prepatch.sh
• ISO images listed in Table 6-2. 

Table 6-2   ISO Images Required for Patching

If you are updating the server from CDs, you also need to burn the ISO images to CDs:

1 Insert a blank, writable CD into your CD burner.

ISO Image File CD Label Screen Prompt When 
Patching from CD

oessp2linux01.iso Open Enterprise Server SP2 CD 1 NA

oessp2linux02.iso Open Enterprise Server SP2 CD 2 YOU Patch CD CD 2

oessp2linux03.iso Open Enterprise Server SP2 CD 3 YOU Patch CD CD 3
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2 Select the option to create a CD from an image file.
3 Select ISO as the file type.
4 Select an image file (see Table 6-2) from the location you downloaded it to.
5 Complete the CD creation process.
6 Repeat this process for each of the ISO image files.

Your CDs are now ready to be used for patching.

Rather than burning a physical CD, you can mount the downloaded ISO image of the CD and run 
the update from the mounted image, or you can set up a network install and point to it. 

Before starting the YaST Online Update dialog, mount each of the ISO images.

To mount an image after downloading it to the local server, 

1 Create a directory for each of the images in the mnt directory.
2 Enter the following command at a shell prompt:
mount -o loop directory_name/iso_name /mnt/directory_name

For example:
If you have saved the files in the home/download/patchcd directory and created the 
iso-1, iso-2, and iso-3 directories in the mnt directory, you would enter the 
following command to mount the first ISO image:
mount -o loop /home/download/patchcd/oessp2linux01.iso /mnt/
iso-1

Continue with Section 6.1.2, “Ensuring that All Services Are Installed before Patching the Server,” 
on page 60.

6.1.2  Ensuring that All Services Are Installed before Patching 
the Server
When you patch the server, patches are applied only to services that are installed and configured on 
the server. Therefore, make sure to install and configure any services that you want on the server 
before you patch the server.

For procedures, see “Installing or Configuring OES Components on an Existing Server” on page 51.

If you want to install a service after the server has been patched, you should install it using updated 
media (the updated ISO images from the latest Support Pack).

Continue with Section 6.1.3, “Ensuring that the Server Has Enough Disk Space for the Support Pack 
Patches,” on page 61.
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6.1.3  Ensuring that the Server Has Enough Disk Space for the 
Support Pack Patches

IMPORTANT: Downloading and installing patches on an OES Linux server from the public patch 
channel at https://update.novell.com/data can be problematic if the server has 
insufficient disk space. 

Before downloading and patching the server, make sure that it has at least 4 GB of free disk space in 
the required locations to download and install the patches from the channel. For specific disk space 
requirements, see Table 6-3 on page 61.

Table 6-3   Disks Space Requirements for Downloading and Installing Patches from the Channel

If the server has insufficient disk space for downloading the patches from the OES channel, we 
recommend using the updated Support Pack CDs or ISO images to patch the server. See Section 6.2, 
“Patching Using a Patch CD or ISO Images,” on page 65.

Continue with Section 6.1.4, “Stopping iPrint Services,” on page 61.

6.1.4  Stopping iPrint Services
If the server is at OES SP1 or later, you can skip this step.

If the server was installed when OES initially shipped, has not been updated to OES SP1 or later, 
and has iPrint installed and configured, you must stop the iPrint Driver Store and iPrint Print 
Manager before applying patches. 

You can stop these services by using iManager or by entering the following commands at a console 
shell prompt.

Action Disk Space Requirement More Information

Download 2 GB of free disk space in the 
partition that contains the /var/
cache/rcd directory.

or

2 GB or more of free disk space 
anywhere on the server. 

The /var/cache/rcd directory is the default 
directory that rug downloads patches to.

To verify the amount of space available in a partition, 
enter the df -h command at a shell prompt.

If you want to use 2 GB anywhere on the server, use 
the following command to configure rug to download 
to a specific directory rather than the default:

rug set-prefs cache-directory /
directory_name

For example:

rug set-prefs cache-directory /patches

Install 2 GB in the / tmp directory. After the patches have been downloaded, they are 
installed to various locations on the server. 
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Table 6-4   Commands for Stopping iPrint

To verify that these services are stopped, enter the following command at a console shell prompt:

ps auxwww | grep iprint | grep -v grep

TIP: Issuing this command lists the processes that either are running as the iPrint user or contain 
iPrint in their names. If no processes are running, nothing is listed.

If for any reason the ipsmd services didn't stop, force these processes to stop by entering the 
following command at a console shell prompt:

killall ipsmd

If running the killall ipsmd command does not stop the processes, enter the following 
command at the console shell prompt:

killall -9 ipsmd

Continue with Section 6.1.5, “Running the OES SP2 Prepatch Script,” on page 62.

6.1.5  Running the OES SP2 Prepatch Script
If you are patching from CD or ISO images only, you can skip this step.

The patching software that shipped initially with OES and OES SP1 has been updated and now lets 
you use the Red Carpet GUI. The patches to update the Red Carpet software and a few other 
modules are included in the OES SP2 prepatch script. Completing the additional steps in this section 
ensures that the server is ready to receive the patches from the OES channel by installing packages 
that are needed before updating the currently installed software. You need to run this script on the 
server one time only.

Before applying the patches included in the OES channel to an OES Linux server:

1 If you are not already logged in as user root, log in to the server as user root or su to root.
2 Set up the server for downloading patches.

Completing the following steps ensures that the update service is correctly added, that the 
server is activated and subscribed to the correct channel, and that the correct patches are 
available in the channel.
2a Add the OES Update service.

If you haven't previously added or verified that the OES update service was added, 
complete this step; otherwise, skip to Step 2b.
During the server’s initial installation, the OES update service is automatically added to 
the server. Verify that the OES update service was added correctly by entering the 
following command at a shell command line prompt:
rug sl

Service Command Line Command

iPrint Print Manager /etc/init.d/novell-ipsmd stop

iPrint Driver Store /etc/init.d/novell-idsd stop
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TIP: In this command, the last letter is a lowercase L, not the number 1.

If the service was added correctly, you should see a message displayed similar to the 
following:

The number in the # column is variable, depending on the number of services that the 
server is subscribed to.
If the OES update service was not added correctly during the install, add it now by 
entering the following rug command with the service add option:
rug sa https://update.novell.com/data

2b Activate the OES update service.
If you haven't previously activated the OES update service, complete this step; otherwise, 
skip to Step 2c.
At a shell command line prompt, enter
rug act -s service_list_number activation_code email_address

The service list number is the number for the Novell_Update_Server service. See Step 2a.
For example:
rug act -s 1 123DE567890 jim@example.com

TIP: The activation code can be an evaluation activation code or a standard activation 
code, depending on which licensing option you selected when you downloaded the 
product. If you enter an evaluation activation code, you can receive updates for 30 days.
If you initially activate using an evaluation activation code and later purchase the product 
and receive a standard activation code, you can apply the standard activation code by 
repeating this step and entering the standard activation code. You do not need to deactivate 
the OES update service and reactivate it with the new activation code.

If you entered the correct information, the system responds with the following message:
System successfully activated
Refreshing channel data
Refresh complete

2c Subscribe to the OES update channel.
If the server hasn’t previously been subscribed to the OES update channel, complete this 
step; otherwise, skip to Step 2d.
At a shell command line prompt, enter
rug sub oes

If you enter this command and receive the message Warning: Invalid 
channel:'oes', see TID 10098375 “OES Patch Channel Not Visible after Activating 
Open Enterprise Server” (http://support.novell.com/cgi-bin/search/searchtid.cgi?/
10098375.htm).
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2d Verify that OES patches exists in the channel that the server is subscribed to.
If you haven’t previously verified that OES patches exist in the subscribed channel, 
complete this step; otherwise, skip to Step 3.
At a shell command line prompt, enter
rug pl oes

This command lists all patches available in the OES channel.

TIP: If no patches are shown after running rug pl oes, enter rug refresh to 
refresh the channel, and then enter rug pl oes again.

3 Copy the oessp2prepatch.sh file from the Consolidated Support Pack Web site for OES 
(http://support.novell.com/tools/csp/csp_oessp2.html) to a directory on the local server.

4 Make the oessp2prepatch.sh file executable by entering the following command:
chmod +x oessp2prepatch.sh

If you fail to make the oessp2prepatch.sh file executable, the following message is 
displayed when you try to apply the script:
permission denied

5 Apply the script by entering the following command at a shell prompt:
./oessp2prepatch

If you downloaded this file to a Windows workstation, then copied the file to the server before 
applying the script, the following error might be displayed when you apply the script:
bad interpreter: No such file or directory

If you see this error, run the dos2unix command with the filename as the parameter and run 
the script again.
For example,
dos2unix oessp2prepatch

IMPORTANT: The prepatch download and installation takes approximately 30 minutes when 
using a high-speed connection. 

The download and installation process is complete when you see the following message:
............................................................
The Open Enterprise Server SP2 Pre-patch setup is complete.
............................................................
************************************************************
Now you can finish patching the server.
For instructions, see Patching an OES Linux Server at
http://www.novell.com/documentation/oes/install_linux/data
/bxlu3xc.html#bxlu3xc
************************************************************
nstallation Guide

http://support.novell.com/tools/csp/csp_oessp2.html


novdocx (E
N

U
)  01 February 2006
When you have completed all the steps for preparing the server, you can proceed with patching the 
server using one of the following methods.

• Patching Using a Patch CD or ISO Images (page 65)
• Patching a Server From the ZLM Channel Using the Red Carpet Command Line (rug) 

(page 69)
• Patching a Server From the ZLM Channel Using the Red Carpet Command Line (rug) 

(page 69).

For more information about which method you might want to choose, see Table 6-1 on page 58.

6.2  Patching Using a Patch CD or ISO Images
For each release of a Support Pack for OES Linux, Novell updates the Open Enterprise Server SPx 
CD 1 boot CD ISO image and all other OES CD images. You can use these CDs or ISO images to 
patch the server with all the patches included in OES Support Pack 2. For information about 
downloading the images and burning the CDs, see “Downloading the Prepatch Script and Updated 
ISO Images” on page 59.

Use the following procedure for patching a server.

1 Make sure you have completed the following preparation procedures in “Preparing the Server 
for Patching” on page 59.

• “Downloading the Prepatch Script and Updated ISO Images” on page 59
When updating from CD or ISO images only, downloading and running the 
oessp2prepatch script is not necessary.

• “Ensuring that All Services Are Installed before Patching the Server” on page 60
• “Ensuring that the Server Has Enough Disk Space for the Support Pack Patches” on 

page 61
• “Stopping iPrint Services” on page 61

2 With the server running, insert Open Enterprise Server SP2 CD 1 into the CD drive of the 
server or mount all the physical CDs or ISO images that you downloaded to the local server.
Before starting the YaST Online Update dialog, mount each of the ISO images.
To mount an image after downloading it to the local server, create a directory for each of the 
images in the mnt directory, then enter the following command at a shell prompt:
mount -o loop directory_name/iso_name /mnt/directory_name

For example:
If you have saved the files in the home/download/patchcd directory and created the 
iso-1, iso-2, and iso-3 directories in the mnt directory, you would enter the 
following command to mount the first ISO image:
mount -o loop /home/download/patchcd/oessp2linux01.iso /mnt/
iso-1

3 (Conditional) Verify that the public keys are installed.
If you haven't previously verified that the public keys have been installed, do the following; 
otherwise, skip to Step 5.
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At a shell command line prompt, enter
rpm -qa | grep pubkey

or 
rpm -qa *pubkey*
You should see the following public keys displayed:

• gpg-pubkey-0dfb3188-41ed929b.asc

• gpg-pubkey-3d25d3d9-36e12d04.asc

• gpg-pubkey-9c800aca-39eef481.asc

• gpg-pubkey-15c17deb-3f9e80c9.asc

4 If all the public keys listed in Step 3 are displayed, continue with Step 5.
or
If nothing is returned or any of the keys is missing, import one or more of the four public keys 
as applicable from the Open Enterprise Server SP2 CD 1 or oessp2linux01.iso image 
by doing the following:
4a Change to the current drive where the CD is mounted or the ISO image is located by 

entering the following at a shell command line prompt:

4b Get a list of all the keyfile names by entering the following at a shell command line 
prompt:
ls gpg-pubkey*.asc

4c Import each file by entering the following command for each file:
rpm --import gpg-pubkey-unique_number.asc

5 Access the Welcome to YaST Online Update dialog box.
Do the following based on what occurred when you inserted the Open Enterprise Server SP2 
CD 1 in the CD drive.

Commands for CD Media Commands for ISO Image Media

cd /media/mount_point cd /mnt/directory_name

For example,

cd /media/cdrom

cd /media/cdrecorder

cd /media/dvd

For example,

cd /mnt/iso-1
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Do the following if you are installing the patches from the ISO images on the local server or 
using a network installation source:

If Then

The server automatically launched a screen that 
displayed a message that the SUSE patch CD 
was found.

1. Click the terminal window that opened 
when the CD was inserted. 

2. Click Yes. 

3. In the Welcome to YaST Online Update 
dialog box, accept the default settings, then 
click Next.

All patches to be installed for the Support 
Pack are selected by default.

4. Click Accept, then proceed to Step 6 on 
page 68.

Nothing happened 1. Open YaST. 

2. Click Software > Patch CD Update.

3. In the Welcome to YaST Online Update 
dialog box, accept the default settings, then 
click Next.

All patches to be installed for the Support 
Pack are selected by default.

4. Click Accept, then proceed to Step 6 on 
page 68.

Image Location Procedure

On the local server 1. Open YaST.

2. Click Software > Patch CD Update.

3. In the Welcome to YaST Online Update 
dialog box, click New Server.

4. In the Select Type of URL dialog box, select 
Directory, then click OK.

5. In the Local Directory dialog box, click 
Browse.

Browse to the mount point for the first ISO 
image or type the pathname to it, then click 
OK > Next.

The patch information is updated and the 
YaST Online Update Patch dialog box is 
displayed.

6. Select all the patches.

Right-click a patch in the list. Click All in 
This List > Install.

7. Click Accept, then proceed to Step 6 on 
page 68.
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6 When prompted to accept specific packages, click Install Patch.
The downloading of the patches should begin.

7 Follow the on-screen prompts to accept the downloading or installing of patches, and to insert 
CDs.
When prompted to insert YOU patch CDs, insert the CDs as shown or type the path to the 
applicable ISO image in the URL field of the prompt:

To display the URL field of the prompt, click Details.
When everything has been downloaded and installed, you should see the following message in 
the Process Log dialog box:
Installation finished.

8 When you see the Installation Finished message, click Finish.
The system starts a system configuration process. When that process is finished, the Welcome 
to YaST Online Update dialog box is returned or closed.

9 Repeat the download, installation, and configuration steps.
Reinsert Open Enterprise Server SP2 CD 1 or access the ISO images and perform Step 5, 
Step 6, Step 7 and Step 8, then continue with Step 10 or Step 11 when the second configuration 
step is complete.
The download and installation time is much shorter the second time because fewer patches are 
downloaded and installed the second time.

A network installation source 1. Open YaST.

2. Click Software > Patch CD Update.

3. In the Welcome to YaST Online Update 
dialog box, click New Server.

4. In the Select Type of URL dialog box, select 
the applicable protocol, then click OK.

5. Type the applicable information in the 
Server Name and Directory on Server 
fields, then click OK.

In the Directory on Server field, type the 
path_to_installation_source/sles9/CD1.

The patch information is updated and the 
YaST Online Update Patch dialog box is 
displayed.

6. Select all the patches in the list to be 
installed.

7. Click Accept, then proceed to Step 6 on 
page 68.

At Prompt ISO Image File CD label

YOU Patch CD CD 2 oessp2linux02.iso Open Enterprise Server SP2 CD 2

YOU Patch CD CD 3 oessp2linux03.iso Open Enterprise Server SP2 CD 3

Image Location Procedure
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IMPORTANT: Completing this step installs patches that could not be installed the first time.

10 (Conditional) If it has been some time since a Support Pack was made available and you want 
to update the server with the latest patches, use the procedures in “Patching a Server From the 
ZLM Channel Using the Red Carpet Command Line (rug)” on page 69 or “Patching a Server 
From the ZLM Channel Using the Red Carpet GUI” on page 71.
To access the Red Carpet GUI, open YaST, then click Software > Zenworks Linux Management 
Client.
10a If you update to the latest patches by using Red Carpet client, enter the following 

command at the shell command line prompt to avoid unwanted memory consumption:
rug set max-allowed-memory 40

11 Continue with “Updating Installation Sources Using YaST” on page 75.

6.3  Patching a Server From the ZLM Channel 
Using the Red Carpet Command Line (rug)
Novell has provided a channel using ZENworks Linux Management (ZLM) where you can get 
patches for updating an existing OES server. The following procedure specifies how to access the 
OES channel and update the server using rug commands in a Linux shell.

1 If you are not already logged in as user root, log in to the server as user root.
2 Make sure you have completed all the steps in “Preparing the Server for Patching” on page 59. 
3 Download and install all the patches in the OES channel by entering:
rug pin --entire-channel oes

Executing this command downloads all of the patches that need to be installed on the server.
4 When the Do you agree to the above license? prompt appears, review the 

information displayed about the patches, then enter y to start the download.
You can ignore the messages about Mozilla. The patch process resolves this issue.

IMPORTANT: The patch download takes approximately 30 to 60 minutes when using a high-
speed connection. 

The download and installation process is complete when you see the following message:
Download complete 
Transaction Finished

5 To avoid unwanted memory consumption after using the Red Carpet client, enter the following 
command at the shell command line prompt:
rug set max-allowed-memory 40

6 Continue with “Updating Installation Sources Using YaST” on page 75.

For additional help with the rug commands, see following table.

Table 6-5   Additional Rug Commands

Task Command

Activate a service rug act
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Add a service rug sa

Delete a service rug sd

Get more information about a specific patch rug pi patch_name

Install all the necessary patches that an OES Linux 
server needs for an update

rug pin --entire-channel oes

List all available patches for all channels rug pl

List all available patches for the OES channel rug pl oes

List all rug commands rug – – help

List all the channels that your activation lets you 
access

rug ch

List all the configuration options rug get -d

List all the services activated rug sl

List available updates rug lu

Refresh the channel to make sure that all available 
patches are available for download

rug refresh

Reinstall patches that are already marked 
“Installed” or that install individual patches

rug pin channel_name:patch_number

For example: rug pin oes:patch-10535

Restart the rcd daemon restart rcd

Restart rug rug restart

Set a proxy URL rug set proxy-url url_path

Set a proxy user rug set proxy-username name

Set the password for proxy user rug set proxy-password password

Show detailed information about a package rug info

Subscribe to a channel rug sub

Unsubscribe to a channel rug unsub

Task Command
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6.4  Patching a Server From the ZLM Channel 
Using the Red Carpet GUI
Novell has provided a channel using ZENworks Linux Management (ZLM) where you can get 
patches for updating an existing OES Linux server. The following procedure specifies how to access 
that channel and patch the server using the Red Carpet GUI.

NOTE: If you are unable to patch your server using the Red Carpet GUI, we recommend that you 
use the command line (rug) procedures to patch the server. See “Patching a Server From the ZLM 
Channel Using the Red Carpet Command Line (rug)” on page 69.

1 If you are not already logged in as user root, log in to the server as user root or su to root.
2 Make sure you have completed the steps in “Preparing the Server for Patching” on page 59.
3 Launch the Red Carpet GUI by doing one of the following from the Linux desktop on the 

server:
• Click N > System > Configuration > Red Carpet.

or
• Click N > System > Control Center YaST > Software > Online Update.

When patching after OES SP2:
Click N > System > Control Center YaST > Software > Zenworks Linux Management 
Client.

4 Verify that the OES Update Service was added. This service should have been added by default 
during the OES Linux installation.
4a Click Edit > Services.

The https://update.novell.com/data service URL should display in the Edit Services dialog 
box.
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4b If no service or an incorrect service is displayed, do the following:
4b1 In the Edit Services dialog box, click Add Service.
4b2 In the Service URL field, type https://update.novell.com/data.

4b3 Click OK.
4b4 Click Close.

5 Verify that the OES Service is activated.
The OES Service is activated if the OES channel displays in the Red Carpet Channel 
Subscription dialog box when you click the Channels icon.
If the service not activated, do the following:
5a Click File > Activate.
5b In the Group Activation dialog box, do the following:

5b1 Make sure the NovellUpdateServer service is selected.
5b2 In the Email field, type the e-mail address that you entered when you received your 

activation code.
5b3 In the Activation Code field, type the activation code you received when you 

purchased the product.

5b4 Click Activate.
5b5 (Conditional) If you see a message indicating: Warning: Invalid 

channel:'oes', see TID 10098375 “OES Patch Channel Not Visible after 
Activating Open Enterprise Server” (http://support.novell.com/cgi-bin/search/
searchtid.cgi?/10098375.htm).

6 Verify that the server is subscribed to the OES channel.
The server is subscribed to the OES channel if the OES channel displays and has a check mark 
in the check box next to the OES channel name in the Red Carpet Channel Subscription dialog 
box when you click the Channels icon.
If the server hasn’t previously subscribed to the OES channel, do the following:
6a Click Channels. 
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6b In the Red Carpet Channel Subscriptions dialog box, click the check box in the Subscribed 
column next to the OES channel listing.

6c Click Close.
7 Click the Patches tab.

WARNING: When you open the Red Carpet GUI, the Update tab is selected by default. Do 
not use the Update tab or Update All button. Install patches only from the interface you access 
from the Patches tab in the Red Carpet GUI. If you update from any other area than the Patches 
tab, you can leave the server in an undesirable state.
The Update tab is included in this utility for use by other products that are updating SLES only. 

This Patches page lists both OES and SLES patches available for your OES for Linux server.

Patches
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8 Select all the patches that have not been installed.
8a In the Patches menu, select the Not Installed Patches filter. 

Selecting this filter lists all the patches with a Not Installed status.

8b Select all the patches that have not yet been installed (Not Installed status) by selecting all 
the patches (pressing Ctrl+A).

9 Click Mark for Installation.

IMPORTANT: If you select any patches that are already installed, the Mark for Installation 
button is not active. Make sure you only select patches that have a “Not Installed” status. See 
Step 8.

Only not installed packages listedNot Installed Patches Filter selected
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After clicking Mark for Installation, all the patches to be installed should be listed in the 
Pending Actions field with an Install status in the Action field as shown in the following figure.

10 Click Run Now > Continue.
The installation process should start. When it completes, you should see the following message 
in the Transaction Finished dialog box: 
The transaction has completed successfully.

11 When the installation process is complete, click OK.
12 To avoid unwanted memory consumption after using the Red Carpet client, enter the following 

command at the shell command line prompt:
rug set max-allowed-memory 40

13 Continue with “Updating Installation Sources Using YaST” on page 75.

6.5  Updating Installation Sources Using YaST
For the YaST package manager to know about updated packages residing on the Patches CD, ISO 
images, or on the network, you must register this latest source as an additional installation source 
and remove or disable the outdated installation source.

Setting new installation sources after an update to a Support Pack makes it possible for you to post-
install any of the new services that come with the Support Pack and ensures that any dependencies 
on the core SLES services can use the latest versions. It also ensures that installing any Linux 
services from the core SLES doesn’t break any OES services.

If you want your installation source to be from CD:

1 Open YaST.
2 Click Software > Change Source of Installation.
3 Click Add > CD.

In the Software Source Media dialog box, a status for the Open Enterprise Server Version SPx 
CD is displayed.
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4 Select the status for the CD, then click Up until the status for the CD is listed first (highest 
priority).

5 After adding the latest Support Pack as the first priority installation source, select the old 
installation source, then click Disable or Delete to remove it as an installation source.
For example, if you just added Open Enterprise Server SP2 Version, you would remove or 
disable Open Enterprise Server SP1 Version.

6 Click Finish.

If you want your installation source to be from the downloaded local ISO images:

1 Before starting YaST, mount each of the the following ISO images.

oessp2linux01.iso
oessp2linux02.iso
oessp2linux03.iso

To mount an image after downloading it to the local server, create a directory for each of the 
images in the mnt directory, then enter the following command at a shell prompt:

mount -o loop directory_name/iso_name /mnt/directory_name

For example:

If you have saved the files in the home/download/patchcd directory and created the 
iso-1, iso-2, and iso-3 directories in the mnt directory, you would enter the 
following command to mount the first ISO image:

mount -o loop /home/download/patchcd/oessp2linux01.iso /mnt/
iso-1

2 Open YaST.
3 Click Software > Change Source of Installation.
4 Click Add > Local Directory.
5 Browse to the yast/core9 directory of the first ISO image, then click OK > OK.
6 Select the status for the image, then click Up until the status for the image is listed first (highest 

priority).
7 After adding the latest Support Pack as the first priority installation source, select the old 

installation source, then click Disable or Delete to remove it as an installation source.
For example, if you just added Open Enterprise Server SP2 Version, you would remove or 
disable Open Enterprise Server SP1 Version.

8 Click Finish.

If you want your installation source to be a network installation source:

1 Open YaST.
2 Click Software > Change Source of Installation.
3 Click Add > applicable_protocol.

Applicable protocols include http, ftp, samba, and nfs.
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4 In the Server and Directory dialog box, type the following information, then click OK.
• In the Server Name field, type the server name or IP address of the server that contains the 

contents of the Open Enterprise Server SPx CD 1.
• In the Directory on Server field, type the path to the contents of the Open Enterprise 

Server SPx CD 1. This path should extend past the contents of the network installation 
directory.
For example, if the DNS name for the installation server is 
linux_server1.example_co.com and the path to the network nfs installation is 
nfs://linux_server1.example_co/oes/sp2, then the Server Name field 
would contain linux_server1.example_co and the Directory on Server field would contain 
/oes/sp2//sles9/CD1.

In the Software Source Media dialog box, a status for the Open Enterprise Server Version SPx 
applicable_protocol is displayed.

5 Repeat Step 3 and Step 4 with the following exception:
• In the Server Name field, type the server name or IP address of the server that contains the 

contents of the SUSE CORE Version 9 CD 1.
• In the Directory on Server field, type the path to the contents of the SUSE CORE Version 9 

CD 1. This path should extend past the contents of the network installation directory.
For example, if the DNS name for the installation server is 
linux_server1.example_co.com and the path to the network nfs installation is 
nfs://linux_server1.example_co/oes/sp2, then the Server Name field 
would contain: linux_server1.example_co and the Directory on Server field 
would contain /oes/sp2//core9/CD1.

6 Select the status for the applicable protocol, then click Up until the status for the protocol is 
listed first (highest priority).

7 After adding the latest Support Pack as the first priority installation source, select the old 
installation source, then click Disable or Delete to remove it as an installation source.
For example, if you just added Open Enterprise Server SP2 Version Linux, you would remove 
or disable Open Enterprise Server SP1 Version Linux.

8 Click Finish.
9 Continue with “Configuring Services After Applying an OES Support Pack” on page 77.

6.6  Configuring Services After Applying an OES 
Support Pack

1 If Novell iManager is installed on the server, do the following to update all the plug-ins. If 
iManager is not installed on the server, proceed to Step 2 on page 78.
1a Access iManager by entering the following URL in the Address field of your Web 

browser:
http://IP_or_DNS_name/nps/iManager.html

Replace IP_or_DNS with the IP address or DNS name of your OES Linux server.
1b Log in to iManager as user Admin or as a user with rights equivalent to Admin.
1c In the header frame of iManager, click the Configure icon.
1d Click Module Installation > Available Novell Plug-in Modules.
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1e Select all the modules in the list by clicking the Select All check box (the check box at the 
top of the list to the left of module).

1f Click Install.
Installing the updates might take awhile.
Ignore the following message that might display at the end of the installation. The plug-ins 
have actually installed successfully.
Can’t find bundle for base name DevResources, locale en. 

1g Log out of iManager. 
1h Continue with Step 2.

2 If Novell QuickFinder is installed on the server and you are updating from SP1 to SP2, 
configure the service in YaST as follows:
2a At a command line prompt, enter

yast novell-quickfinder

2b When prompted that the service is already configured, select Yes to continue and press 
Enter to proceed.

2c Enter the required setting to configure the service on each screen presented.
2d When prompted to restart other services, select No and press Enter. 

The service is restarted when you reboot the server.
2e Quit YaST and continue with Step 3.

3 If NCPTM Server Management and Novell Remote Manager (NRM) are installed on the server 
and you are patching a server from the initial version of OES to the OES SP2 version, do the 
following to ensure that the management interface plug-in for NCP Server Management is 
functional in NRM and any changes made to the Novell Remote Manager configuration file are 
saved from previous version. 
If none of these services is installed on the server or you are patching from OES SP1 to OES 
SP2, proceed to Step 4.
3a Copy the following line from the old httpstkd.conf file at /etc/opt/novell/

httpstkd.conf.rpmsave and any other changes made to the httpstkd.conf 
file and save them in the current /etc/opt/novell/httpstkd.conf file.
load /opt/novell/lib/libnrm2ncp.so

This line is usually at the end of the file.
3b Continue with Step 4.

4 Reboot the server by entering
reboot

IMPORTANT: Rebooting the server is required because of updates to the kernel.
If the server has been up longer than the specified fsck check interval for that server, the server 
performs the fsck function after the reboot. Please allow for this to take some time, especially 
on servers with large file systems.

5 If Novell Virtual Office is installed on the server, restart Tomcat by entering the following 
command at a shell commandline prompt:
/etc/init.d/novell-tomcat4 restart
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Restarting Tomcat after the server boot, eliminates the chance of receiving error 500 when you 
load Novell Virtual Office.
To monitor Tomcat coming up, enter the following command at a shell commandline prompt:
tail /var/opt/novell/tomcat4/logs/catalina.out

If you have completed all the steps in “Downloading the Prepatch Script and Updated ISO Images” 
on page 59 through “Configuring Services After Applying an OES Support Pack” on page 77, you 
are finished patching the server.

6.7  Getting More Information about the Patch 
Process
Previous sections have specified the complete procedures for patching an OES Linux server. This 
section includes an additional list of Technical Information Documents (TID) written by Novell 
Technical ServicesSM personnel that might help you if you have some difficulties with the patching 
process.

NOTE: This list is not an exhaustive list of TIDs for patching.

Table 6-6   Tips from Technical Support about Patching an OES Linux Server

6.8  Patching Quick Paths for Experts
The following Quick Paths contain a brief summary of steps for each of the methods that you can 
use to patch the server with the pre and post steps included. These Quick Paths do not include 
detailed instructions and are meant to help the more experienced user move through the process 
quickly.

IMPORTANT: If you are unfamiliar with the OES Linux patching process, read the complete 
section, “Patching an OES Linux Server” on page 57, to ensure a more successful experience.

• Section 6.8.1, “Quick Path for Patching Using CDs or ISO Images,” on page 80
• Section 6.8.2, “Quick Path for Patching From ZLM Using the RCD Command Line (rug),” on 

page 82
• Section 6.8.3, “Quick Path for Patching Using the ZLM Red Carpet GUI,” on page 84

For More Information About Refer To

Answers to frequently asked questions for patching 
OES Linux using rug (command line) or Red Carpet 
GUI.

TID 10097537 “Patching Open Enterprise Server 
with rug/Red Carpet FAQ” (http://
support.novell.com/cgi-bin/search/searchtid.cgi?/
10097537.htm)

Commands for setting up a rug or Red Carpet GUI 
to use a proxy user

TID 10098376 “Set Up rug/Red Carpet to use a 
Proxy” (http://support.novell.com/cgi-bin/search/
searchtid.cgi?/10098376.htm)

Troubleshooting the OES patch process. TID 10100002 “Troubleshooting the OES SP2 
Patch Process” (http://support.novell.com/cgi-bin/
search/searchtid.cgi?10100002.htm)
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6.8.1  Quick Path for Patching Using CDs or ISO Images
1 Download OES ISO images from the OES Consolidated Support Pack Web site (http://

support.novell.com/tools/csp/csp_oessp2.html).
2 Burn CDs from the OES ISO images or create a mount directory for each CD in the mnt 

directory on the local server and mount all the downloaded images in the applicable directory.
mount -o loop directory_name/iso_name /mnt/directory_name

Example for first CD:
mount -o loop /home/download/patchcd/oessp2linux01.iso /mnt/
iso-1

3 Install all services that you want to run on the server.
4 Ensure that the server has enough disk space for downloading and installing patches.
5 (Conditional) If you are patching an OES FCS server and iPrint Services are running, stop 

them.
/etc/init.d/novell-ipsmd stop
/etc/init.d/novell-idsd stop

6 Insert the Open Enterprise Server SP2 CD1 in to the CD drive of the server or access the ISO 
images.

7 Verify that the all public keys are installed on the server. If they are not installed, import them.
7a To verify, enter 

rpm -qa *pubkey*

These keys should be listed:

gpg-pubkey-0dfb3188-41ed929b.asc
gpg-pubkey-3d25d3d9-36e12d04.asc
gpg-pubkey-9c800aca-39eef481.asc
gpg-pubkey-15c17deb-3f9e80c9.asc

7b To import the keys, change to the directory where the media is and run the import 
command:
cd /media/mount_point
rpm --import gpg-pubkey-unique_number.asc

8 Access the Welcome to YaST Online Update dialog box by Opening YaST, then clicking 
Software > Patch CD Update.

9 Access the patch files and start the patch download and installation by doing one of these:
• Source—CD: In the Welcome to YaST Online Update dialog box, click Next > Accept.
• Source—ISO Image Local: In the Welcome to YaST Online Update dialog box, click 

New Server > Directory > OK > Browse. Browse to or type the pathname for the mount 
point for the first ISO file, then click OK > Next. After the patch information is updated, 
select and install all the patches by right-clicking one patch in the list, then clicking All in 
This List > Install > Accept.

• Source—ISO Images on Network: In the Welcome to YaST Online Update dialog box, 
click New Server > the applicable protocol > OK. Type the applicable information in the 
Server Name and Directory on Server fields, then click OK. In the Directory on Server 
field, type the path_to_installation_source/sles9/CD1. After patch 
information is updated, select all the patches to be installed, then click Accept.
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10 Follow the on-screen prompts to install specific packages, insert additional CDs or access 
additional images, and acknowledge post-installation messages.

11 When you see the Installation Finished message in the Process Log dialog box, click 
Finish.

12 After the system configuration process is complete, reinsert Open Enterprise Server SP2 CD 1 
and perform Step 8 through Step 11, then continue with Step 13 or Step 14 after the second 
configuration process is complete.

13 (Conditional) If it has been some time since a Support Pack was made available and you want 
to update the server to the current patches, use the procedures in “Patching a Server From the 
ZLM Channel Using the Red Carpet Command Line (rug)” on page 69 or “Patching a Server 
From the ZLM Channel Using the Red Carpet GUI” on page 71.
13a To avoid unwanted memory consumption after using the Red Carpet client, enter the 

following command at the shell command line prompt:
rug set max-allowed-memory 40

14 Update the applicable Installation sources using YaST:
14a Update one of the applicable sources:

• CD Source: Open YaST. Click Software > Change Source of Installation > Add > 
CD. Select the status for the CD, then click Up until the status for the CD is listed 
first (highest priority). Select the old installation source, then click Disable or Delete 
to remove it as an installation source, then click Finish.

• ISO Image Local Source: Open YaST. Click Software > Change Source of 
Installation > Add > Local Directory > Browse. Browse to the yast/core9 
directory of the first mounted ISO image, then click OK > OK.

• Network ISO Source: Open YaST. Click Software > Change Source of Installation. 
Add > applicable_protocol. Type the applicable information in the Server Name and 
Directory on Server fields, then click OK. In the Directory on Server field, type the 
path_to_installation_source//sles9/CD1. Click Add > applicable 
protocol. Type the applicable information in the Server Name and Directory on 
Server fields, then click OK. In the Directory on Server field, type the 
path_to_installation_source//core9/CD1.

14b Select the old installation source, then click Disable or Delete to remove it as an 
installation source, then click Finish.

15 Configure services if they are running and reboot the server:
15a Configure iManager plug-ins.
15b If it is installed, configure Novell QuickFinder.
15c If NCP server and Novell Remote Manager are installed and you are patching from the 

OES initial release to OES SP2, copy changes made from the etc/opt/novell/
httpstkd.conf.rpmsave file to the current etc/opt/novell/
httpstkd.conf file and save them.

15d Reboot the server.
15e If Novell Virtual Office is installed, restart Tomcat before starting Virtual Office:

/etc/init.d/novell-tomcat4 restart
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6.8.2  Quick Path for Patching From ZLM Using the RCD 
Command Line (rug)

1 Download the oessp2prepatch.sh file and the OES ISO images from OES Consolidated 
Support Pack Web site (http://support.novell.com/tools/csp/csp_oessp2.html).

2 Install all services that you want to run on the server.
3 Ensure that the server has enough disk space for downloading and installing patches.
4 (Conditional) If you are patching an OES FCS server and iPrint Services are running, stop 

them.
/etc/init.d/novell-ipsmd stop
/etc/init.d/novell-idsd stop

5 Prepare for the server for the Support Pack using the ZLM command line and the 
oessp2prepatch.sh script:
5a Log in to the server as root or su to root.
5b Verify that the OES service has been added:

rug sl
If it is not, add the OES service:
rug sa https://update.novell.com/data

5c Activate the OES service.
rug act -s service_list_number activation_code email_address
Example:
rug act -s 1 123DE567890 jim@example.com

5d Subscribe to the OES Update Channel:
rug sub oes

5e Verify that patches exist in the channel:
rug pl oes
If not, refresh the channel and verify again:
rug refresh
rug pl oes

5f Copy http://support.novell.com/tools/csp/csp_oessp2.html oessp2prepatch.sh file 
to /root.

5g Make oessp2prepatch.sh executable:
chmod +x oessp2prepatch.sh

5h Apply the script:
./oessp2prepatch

6 Download and install all the patches in the OES channel:
rug pin --entire-channel oes

7 Review and accept the license agreement:
Enter Y at the Do you agree to the above license? prompt.

8 Wait for installation of patches to complete.
Download complete
Transaction Finished

9 To avoid unwanted memory consumption after using the Red Carpet client, enter the following 
command at the shell command line prompt:
rug set max-allowed-memory 40
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10 Update the applicable Installation sources using YaST.
10a Update one of the applicable sources:

• CD Source:  Open YaST. Click Software > Change Source of Installation > Add > 
CD. Select the status for the CD, then click Up until the status for the CD is listed 
first (highest priority). Select the old installation source, then click Disable or Delete 
to remove it as an installation source, then click Finish.

• Source ISO Image Local:  Open YaST. Click Software > Change Source of 
Installation > Add > Local Directory > Browse. Browse to the yast/core9 
directory of the first mounted ISO image, then click OK > OK.

• Network ISO Source:  Open YaST. Click Software > Change Source of Installation. 
Add > applicable_protocol. Type the applicable information in the Server Name and 
Directory on Server fields, then click OK. In the Directory on Server field, type the 
path_to_installation_source//sles9/CD1. Click Add > applicable 
protocol. Type the applicable information in the Server Name and Directory on 
Server fields, then click OK. In the Directory on Server field, type the 
path_to_installation_source//core9/CD1.

10b Select the old installation source, then click Disable or Delete to remove it as an 
installation source, then click Finish.

11 Configure services if they are running, and reboot the server.
11a Configure iManager plug-ins.
11b If it is installed, configure Novell QuickFinder.
11c If NCP server and Novell Remote Manager are installed and you are patching from the 

OES initial release to OES SP2, copy changes made from the etc/opt/novell/
httpstkd.conf.rpmsave file to the current etc/opt/novell/
httpstkd.conf file and save them.

11d Reboot the server.
11e If Novell Virtual Office is installed, restart Tomcat before starting Virtual Office:

/etc/init.d/novell-tomcat4 restart
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6.8.3  Quick Path for Patching Using the ZLM Red Carpet GUI
1 Download the oessp2prepatch.sh file and OES ISO images from the OES Consolidated 

Support Pack Web site (http://support.novell.com/tools/csp/csp_oessp2.html).
2 Install all services that you want to run on the server.
3 Ensure that the server has enough disk space for downloading and installing patches.
4 (Conditional) If you are patching an OES FCS server and iPrint Services are running, stop 

them.
/etc/init.d/novell-ipsmd stop
/etc/init.d/novell-idsd stop

5 Prepare for the server for the Support Pack using the ZLM command line and the 
oessp2prepatch.sh script:
5a Log in to the server as root or su to root.
5b Verify that the OES service has been added:

rug sl
If it is not, add the OES service:
rug sa https://update.novell.com/data

5c Activate the OES service.
rug act -s service_list_number activation_code email_address
Example:
rug act -s 1 123DE567890 jim@example.com

5d Subscribe to the OES Update Channel:
rug sub oes

5e Verify that patches exist in the channel:
rug pl oes
If not, refresh the channel and verify again:
rug refresh
rug pl oes

5f Copy http://support.novell.com/tools/csp/csp_oessp2.html oessp2prepatch.sh file 
to /root.

5g Make oessp2prepatch.sh executable:
chmod +x oessp2prepatch.sh

5h Apply the script:
./oessp2prepatch

6 Start the Red Carpet GUI:
On the Linux server desktop, click N > System > Configuration > Red Carpet

7 Select all the uninstalled patches and mark them for installation.
7a Click the Patches tab.
7b Click the Not Installed Packages filter.
7c Press Ctrl+A.
7d Click Mark for Installation.

8 Install the patches.
8a Click Run Now > Continue.
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8b After you see the following message, click OK:
The transaction has completed successfully.

9 To avoid unwanted memory consumption after using the Red Carpet client, enter the following 
command at the shell command line prompt:
rug set max-allowed-memory 40

10 Update the applicable Installation sources using YaST.
10a Update one of the applicable sources:

• CD Source:  Open YaST. Click Software > Change Source of Installation > Add > 
CD. Select the status for the CD, then click Up until the status for the CD is listed 
first (highest priority). Select the old installation source, then click Disable or Delete 
to remove it as an installation source, then click Finish.

• Source ISO Image Local:  Open YaST. Click Software > Change Source of 
Installation > Add > Local Directory > Browse. Browse to the yast/core9 
directory of the first mounted ISO image, then click OK > OK.

• Network ISO Source:  Open YaST. Click Software > Change Source of Installation. 
Add > applicable_protocol. Type the applicable information in the Server Name and 
Directory on Server fields, then click OK. In the Directory on Server field, type the 
path_to_installation_source//sles9/CD1. Click Add > applicable 
protocol. Type the applicable information in the Server Name and Directory on 
Server fields, then click OK. In the Directory on Server field, type the 
path_to_installation_source//core9/CD1.

10b Select the old installation source, click Disable or Delete to remove it as an installation 
source, then click Finish.

11 Configure services if they are running and reboot the server.
11a Configure iManager plug-ins.
11b If it is installed, configure Novell QuickFinder.
11c If NCP server and Novell Remote Manager are installed and you are patching from the 

OES initial release to OES SP2, copy changes made from the etc/opt/novell/
httpstkd.conf.rpmsave file to the current etc/opt/novell/
httpstkd.conf file and save them.

11d Reboot the server.
11e If Novell Virtual Office is installed, restart Tomcat before starting Virtual Office:

/etc/init.d/novell-tomcat4 restart
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7Installing and Configuring Multiple 
Servers Using AutoYaST

This section contains the following information:

• Section 7.1, “Overview,” on page 87
• Section 7.2, “Security Considerations,” on page 87
• Section 7.3, “Prerequisites,” on page 88
• Section 7.4, “Setting Up a Control File with OES Components,” on page 88
• Section 7.5, “Setting Up an Installation Source,” on page 105
• Section 7.6, “Additional Issues for OES Components,” on page 106
• Section 7.7, “Sample Control File,” on page 106

7.1  Overview
If you need to install OES Linux to multiple systems that perform similar tasks and that share the 
same environment and similar but not necessarily identical hardware, you might want to use 
AutoYaST to perform the installation. 

Using the Configuration Management tool (YaST > Misc > Autoinstallation), you generate an XML 
profile file (referred to as a control file) and use it to perform OES Linux installations to multiple 
servers that share the same hardware and environments. You can also tailor this control file for any 
specific environment. You then provide this control file to the YaST2 installation program.

This section does not provide complete AutoYaST instructions. It provides only the instructions to 
help you select which OES software to add to the AutoYaST control file, and specifies the 
dependencies that OES components have on each other. 

For complete instructions on using AutoYaST2, see Automatic Linux Installation and Configuration 
with Yast2 (http://forgeftp.novell.com//yast/doc/SLES9/autoinstall/9.1/autoyast.pdf). You can also 
access the HTML files locally on an OES server in /usr/share/doc/packages/
autoyast2/html/index.html.

For additional information, how-tos, mailings lists, and updates for the AutoYaST Auto Installer, see 
the YaST Auto Installer Web site (http://forgeftp.novell.com//yast/doc/SLES9/autoinstall/
index.html).

7.2  Security Considerations
When you create a control.xml file using AutoYast, the eDirectoryTM password for user Admin 
is written in clear text. This password can be read by anyone who has access to the file. Linux 
passwords are stored in the file in a hashed form.

We recommend controlling access to this file.
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7.3  Prerequisites
You need at least the following components to install a system using AutoYaST:

A server with OES Linux SP1 or later already installed 
One or more target computers to install the server software to and the following information 
about each:

• Number of hard disks
• MAC address
• Monitor types and graphics hardware

A control file
For information on setting up a control file with OES components, see “Setting Up a Control 
File with OES Components” on page 88.
A boot scenario set up
The boot scenario can be boot from media or boot from an installation source. For more 
information, see “Setting Up an Installation Source” on page 105.
A source or server that contains the AutoYaST profile (control file) 
For more information, see “Setting Up an Installation Source” on page 105.

7.4  Setting Up a Control File with OES 
Components
The control file is a file in XML format that contains an installation profile for the target computer. 
This installation profile contains all the information to complete software installation and 
configuration on a target computer.

You can create the control file manually in a text editor (not recommended) or you can create or 
modify this file using the AutoInstallation module in YaST.

To create the control file for one or more computers, you can use the configuration interface in the 
YaST. This system depends on existing modules that are usually used to configure a computer after 
OES Linux is installed on a server.

The following procedure contains a quick list of steps to create the control file using the 
AutoInstallation module in YaST on a server running OES Linux SP1 or later.

1 On a server that has OES SP1 or later installed, open the YaST2 Control Center.
2 Click Misc > Autoinstallation.
3 Click Tools > Create Reference Profile.
4 In the Create a Reference Control File dialog box, select the Network card check box in the 

Select Additional Resources field, then click Create.
AutoYaST probes the system for software, partitioning, boot loader, network card information, 
language settings, mouse, and other system wide settings.

5 Verify the package selections.
5a Click Software > Package Selection.
nstallation Guide



novdocx (E
N

U
)  01 February 2006
5b On the Package Selection page, make sure the items are the same as you previously 
selected or need. For more information on the addons (software selections) that are 
selected in the base selections (predefined server types or pattern), see “Decide What Type 
of Server You Are Installing” on page 12. If the configuration contains the packages and 
selections you need, skip to Step 7. If not, continue with Step 6.

6 If you need to change the package selections for the target servers, do the following:
6a From the Package Selection dialog box, click Configure.
6b On the Software Selection page, click a base selection (predefined server type or pattern).
6c If you need to make more specific changes, click Detailed Selections.
6d In the Filter Selections field, select Selections.
6e Select or deselect the specific software items that you want to be added or removed from 

the base pattern (predefined server type), then click Accept.
6f Accept the Automatic Changes by clicking Continue in the Changed Packages dialog box.

6g Click Configure, then click Next.
7 Specify the Partitioning parameters for the target server:

7a From the Main YaST AutoInstallation menu, click Hardware > Partitioning > Configure.
7b Set up partitioning on the first drive as desired. 

See the online help for details about limitations.
For more information on partitioning options, see “Partitioning” in Automatic Linux 
Installation and Configuration with YaST2 (http://forgeftp.novell.com//yast/doc/SLES9/
autoinstall/9.1/html/CreateProfile.Partitioning.html).

8 Specify the settings for the graphics card and monitor:
8a From the Main YaST AutoInstallation menu, click Hardware > Graphics Card and 

Monitor > Configure.
8b Select the Configure the X Window System check box, then click Next.
8c On the Configure Monitor screen, select the applicable monitor vendor and model, then 

click Next.
8d Verify the X11 settings. If they are not correct, repeat Step 8b and Step 8c.

If you skip this step, the server keyboard mappings might be German.
9 (Optional) Insert a script to perform a task that you might want, such as a script for removing 

partitions:
For more information on partitioning options, see “Custom User Scripts” in Automatic Linux 
Installation and Configuration with YaST2 (http://forgeftp.novell.com//yast/doc/SLES9/
autoinstall/9.1/html/createprofile.scripts.html).
9a From the Main YaST AutoInstallation menu, click Misc > Custom Scripts > Configure.
9b In the User Script Management screen, click New.
9c In the File Name field, specify a descriptive name for the script, such as 

hello_world_script.
9d In the Script Source field, enter commands such as the following example script:

#!/bin/sh
‘echo "hello world" > /tmp/post-script-output'
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9e Click the Type drop-down box, then select Post.
This script runs after the installation is complete. For additional options, see the online 
help for this dialog box.

9f Click Save.
9g Make sure your script appears in the Post Scripts section of the Custom Scripts screen, 

then click Finish.
10 Set the password for the Root user:

10a From the Main YaST AutoInstallation menu, click Security and Users > Edit and Create 
Users > Configure.

10b Click Set Filter, then select Select System Users from the drop-down menu.
10c Select user root, then click edit.
10d Type a password for the root user in the Password and Verify Password fields, click Next, 

then click Finish.
10e Verify that the root user appears in the Users section of the Edit and Create Users dialog 

box.
11 Set a password for Certificate Authority management:

11a From the Main YaST AutoInstallation menu, click Security and Users > CA Management 
> Configure.

11b Type a password for the certificate in the Password and Confirm Password fields, then 
click Finish.

11c Verify that the Password status appears as Set on the CA Management screen.
12 Configure OES Network Services:

12a From the Main YaST AutoInstallation menu, click AutoYaST_configuration_category > 
module_name > Configure.
Most OES services are in the Network Services category. 
We recommend configuring eDirectory first. Although there are dependencies for some of 
the components, in this release AutoYaST does not verify whether one module is 
configured or not.
See the following table for category names and dependencies. You should configure all 
the modules that were selected for the software selections in Step 5 on page 88. For more 
information about which modules are in each base pattern (predefined server type), see 
“Decide What Type of Server You Are Installing” on page 12.

Module Name Other Module Dependencies AutoYaST Configuration 
Category

eDirectory None Network Services

eGuide eDirectory and LDAP Servers Network Services

iFolder 2.x eDirectory and LDAP Servers Network Services

iFolder 3.x eDirectory Network Services

iFolder 3.x Web Services None Network Services

iManager Requires eDirectory in the 
network

Network Services
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12b Type or select the information for each field requested on each screen, then click Next 
until a summary of setting is displayed for that service.
See “Navigating OES Configuration Screens” on page 92 for default settings and an 
example of the XML that is generated in the control file.

12c Verify that the settings for each module are set as desired.
If not, click Reset Configuration and provide the corrected settings.

12d Repeat Step 12a through Step 12c until all the required modules have been configured, 
then continue with Step 13.

13 Save the file.
13a Click File > Save.
13b Browse to a location that you want to save the file to.
13c Type filename.xml, then click Save.

Replace filename with an appropriate name to identify the control file for the installation 
you are performing.
For additional filename requirements and recommendations, see “The Auto-Installation 
Process” in Automatic Linux Installation and Configuration with YaST2 (http://
forgeftp.novell.com//yast/doc/SLES9/autoinstall/9.1/html/Invoking.html).

iPrint eDirectory, LDAP Servers, 
and Linux User Management

Network Services

LDAP Servers None Network Services

NCP Server eDirectory and LDAP Servers Network Services

NetStorage eDirectory, iManager, and 
LDAP Servers

Network Services

Novell Health Monitor eDirectory and LDAP Servers Network Services

Novell QuickFinder eDirectory and Linux User 
Management if you want the 
QuickFinderTM administrative 
user to be a LUM-enabled 
eDirectory user.

Network Services

Novell Remote Manager None Network Services

Novell Samba eDirectory and LDAP Servers Network Services

Linux User Management eDirectory and LDAP Servers Security and Users

Novell Storage Services 
(NSS)

eDirectory, LDAP Servers, 
Linux User Management, and 
SMS

System

Novell Cluster Services (NCS) eDirectory, LDAP Servers, 
and Novell Storage Services

System

SMS LDAP Servers in the network System

Module Name Other Module Dependencies AutoYaST Configuration 
Category
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14 Exit the configuration management tool by clicking File > Exit.
15 Proceed with “Setting Up an Installation Source” on page 105.

7.4.1  Navigating OES Configuration Screens
Each OES component and the configurable fields associated with it are listed in the following 
sections. These components also include the default or previously entered values, where applicable. 
Some components might require some additional configuration as part of the OES installation; this 
information is also included in the sections. If the component requires configuration that is not part 
the OES installation, see the component's administration guide for more information. You can find 
Administration guides for all OES products at the OES Documentation Web site  (http://
www.novell.com/documentation/oes/oes_home/data/allguides.html#allguides).

• “eDirectory” on page 92
• “eGuide” on page 94
• “iFolder 2.x” on page 94
• “iFolder 3.x” on page 95
• “iFolder 3.x Web Access” on page 96
• “iManager” on page 96
• “iPrint” on page 97
• “LDAP Servers” on page 97
• “Linux User Management” on page 98
• “NCP Server” on page 99
• “NetStorage” on page 100
• “Novell Cluster Services” on page 100
• “Novell Health Monitoring” on page 102
• “Novell QuickFinder” on page 103
• “Novell Remote Manager” on page 104
• “Novell Samba” on page 104
• “Novell Storage Services (NSS)” on page 104
• “SMS (Storage Management Services, Backup)” on page 105

eDirectory

We recommend configuring this service first because the information provided here populates the 
required fields in components that are dependent on this module.

Table 7-1   eDirectory Menu Options and Information

Field or Selection Default or Previously Entered Values and Comments

New Tree or Existing Tree Name example_tree

IP address of an existing eDirectory server with a 
replica

IP_address_of_existing_server
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IMPORTANT: If you install the OES Linux server into an existing tree with servers with versions 
previous to NetWare® 5.1 SP7 or later with eDirectory 8.6.x or later, you first need to run 
Deployment Manager to prepare the network. See “eDirectory Rights Required to Install OES 
Linux” on page 15. If all the servers in the tree are NetWare 5.1 SP7 or later with eDirectory 8.6.x or 
later, you do not need to run Deployment Manager.

XML in the control file is generated similar to the following:

  <edirectory>
   <admin_context>cn=admin.o=example</admin_context>
   <admin_password>novell</admin_password>
   <dib_location>/var/nds/dib</dib_location>
   <existing_ip>192.65.71.14</existing_ip>
   <existing_ldap_secure_port config:type="integer">636</
existing_ldap_secure_port>
   <http_port config:type="integer">8028</http_port> 
   <https_port config:type="integer">8030</https_port> 
   <ldap_port config:type="integer">389</ldap_port> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
   <ntp_server>192.65.71.82</ntp_server> 
   <server_context>o=novell</server_context> 
   <slp_da /> 
   <slp_mode>none</slp_mode> 
   <slp_scopes>DEFAULT</slp_scopes> 
   <tree_name>OES_EXAMPLE</tree_name> 
   <tree_type>existing</tree_type> 
  </edirectory

Synchronizing Server Time

eDirectory requires that all OES servers, both NetWare and Linux, are time synchronized. 

For information on this important topic, see “Implementing Time Synchronization” in the Novell 
OES SP2 Planning and Implementation Guide.

Enter NCP Port on the existing server 524

FDN Admin Name with Context or FDN Existing 
Admin Name with Context

cn=admin.o=example

Admin Password

Enter Server Context o=example

Directory Information Base (DIB) Location /var/nds/dib

Network Time Protocol (NTP) Server local host

Enter LDAP Port 389

Enter Secure LDAP Port 636

Enter iMonitor Port 8028

Enter Secure iMonitor Port 8030

Field or Selection Default or Previously Entered Values and Comments
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SLP Configuration

You have the following options for configuring SLP:

• No SLP: This option is good for eDirectory trees with three eDirectory servers or less.
• Multicast: This option allows the server to request SLP information using multicast packets. 

Use this in environments that have not established SLP DAs (Directory Agents).
• Use an existing SLP DA: Use this in environments that have established SLP DAs.

For more information about configuring SLP, see “Configuring OpenSLP for eDirectory”Novell 
eDirectory 8.7.3 Administration Guide.

eGuide

Table 7-2   eGuide Menu Options and Information

XML in the control file is generated similar to the following:

  <eguide>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <ldap_port config:type="integer">389</ldap_port> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
  </eguide>

iFolder 2.x

Table 7-3   iFolder 2.x Menu Options and Information

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address required for remote selection only

Admin Name with Context cn=admin.o=example

Admin Password admin_password

eDirectory LDAP Port 389

eDirectory LDAP Secure Port 636

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password
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XML in the control file is generated similar to the following:

 <ifolder2>
  <admin_context>cn=admin.o=example</admin_context> 
  <admin_password>novell</admin_password> 
  <admin_users config:type="list">
    <listentry>admin</listentry> 
  </admin_users>
   <ifolder2_ip_address>192.65.71.238</ifolder2_ip_address> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <ldap_port config:type="integer">389</ldap_port> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
   <server_dns>OESserver-ls1.provo.novell.com</server_dns> 
   <server_netmask>255.255.255.252</server_netmask> 
   <user_data_path>/var/opt/novell/ifolderdata</user_data_path> 
 </ifolder2>

iFolder 3.x

Table 7-4   iFolder 3.x Menu Options and Information

LDAP Port 389

LDAP Secure Port 636

iFolder 2.x will be the only Web application on this 
server or iFolder 2.x and other Web applications 
will run on this server

iFolder 2.x and other Web applications will run on 
this server (default)

iFolder 2.x Server IP Address

iFolder 2.x Server Netmask

iFolder 2.x Server DNS Hostname

iFolder 2.x User Data Path /var/opt/novell/ifolderdata

iFolder 2.x Admin Users admin

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389

LDAP Secure Port 636

System Name

Field or Selection Default or Previously Entered Values and Comments
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XML in the control file is generated similar to the following:

 <ifolder>
  <admin_context>cn=admin.o=example</admin_context> 
  <admin_password>novell</admin_password> 
  <ifolderadmin_dn>cn=ifolderadmin.o=example</ifolderadmin_dn> 
  <ifolderadmin_password>novell</ifolderadmin_password> 
  <ifolderadmin_password2>novell</ifolderadmin_password2> 
  <ldap_ip_address>192.65.71.18</ldap_ip_address> 
  <ldap_port config:type="integer">389</ldap_port> 
  <ldap_secure_port config:type="integer">636</ldap_secure_port> 
  <proxy_context>o=example</proxy_context> 
  <store_path>/var/opt/novell/ifolder3</store_path> 
  <system_description>ifolder 3 example server </system_description> 
  <system_name>if3_example_server</system_name> 
 </ifolder>

iFolder 3.x Web Access

Table 7-5   iFolder 3.x Web Access Menu Options and Information

XML in the control file is generated similar to the following:

  <ifolderwebaccess-main>
   <webaccess_alias>/ifolder</webaccess_alias> 
   <webaccess_server_url>http://localhost</webaccess_server_url> 
 </ifolderwebaccess-main>

iManager

Table 7-6   iManager Menu Options and Information

System Store Path /var/opt/novell/ifolder3

System Description (optional)

iFolder Admin DN

iFolder Admin Password

Proxy Context

Field or Selection Default or Previously Entered Values and Comments

Web Access Alias /ifolder

iFolder Server URL http://localhost

Field or Selection Default or Previously Entered Values and Comments

eDirectory Tree

Field or Selection Default or Previously Entered Values and Comments
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NOTE: iManager is fully functional only from a SUSE Linux server console using Mozilla 1.7 or 
Mozilla Firefox 1.0 browsers.

XML in the control file is generated similar to the following:

 <imanager>
  <admin_context>cn=admin.o=example</admin_context> 
  <tree_name>192.65.71.18</tree_name> 
 </imanager>

iPrint

Table 7-7   iPrint Menu Options and Information

XML in the control file is generated similar to the following:

 <iprint>
  <admin_context>cn=admin.o=example</admin_context> 
  <admin_password>novell</admin_password> 
  <ldap_ip_address>192.65.71.18</ldap_ip_address> 
  <ldap_secure_port config:type="integer">636</ldap_secure_port> 
  <tree_name>oes_example</tree_name> 
 </iprint>

LDAP Servers

Table 7-8   LDAP Menu Options and Information

FDN admin name with context cn=admin.o=example

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389

LDAP Secure Port 636

iPrint eDirectory tree

Field or Selection Default or Previously Entered Values and Comments

eDirectory Tree Name Defaults to the correct selection based on 
eDirectory entry

Field or Selection Default or Previously Entered Values and Comments
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XML in the control file is generated similar to the following:

 <oes-ldap>
  <admin_context>cn=admin.o=novell</admin_context>
  <ldap_servers>192.65.71.18,389,636</ldap_servers>
  <tree_name>oes_example</tree_name>
 </oes-ldap>

Linux User Management

Table 7-9   Linux User Management Menu Options and Information

Configured LDAP server Add or remove from the list

Admin Name and Context cn=admin.o=example

Admin Password admin_password

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389

LDAP Secure Port 636

Linux/Unix Config Context o=example

LUM Workstation Context o=example

Proxy User Name with Context optional entry

Proxy User Password optional entry

PAM-enabled Services to Allow Authentication via 
eDirectory:

login: no
ftp: no
sshd: yes
su: no
rsh: no
rlogin: no
passwd: no
xdm: no
openwbem: yes

Field or Selection Default or Previously Entered Values and Comments
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IMPORTANT: Before you accept the default PAM-enabled service settings, be sure you 
understand the security implications explained in “User Restriction Limitations” in the Novell OES 
SP2 Planning and Implementation Guide.

XML in the control file is generated similar to the following:

  <linux-user-mgmt>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <ldap_port config:type="integer">389</ldap_port> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
   <partition_root>o=example</partition_root> 
   <proxy_user /> 
   <proxy_user_password /> 
  <services config:type="list">
   <ftp>no</ftp> 
   <login>no</login> 
   <openwbem>yes</openwbem> 
   <passwd>no</passwd> 
   <rlogin>no</rlogin> 
   <rsh>no</rsh> 
   <sshd>yes</sshd> 
   <su>no</su> 
   <xdm>no</xdm> 
   </services>
   <ws_context>o=example</ws_context> 
 </linux-user-mgmt>

NCP Server

Table 7-10   NCP Server Menu Options and Information

XML in the control file is generated similar to the following:

  <ncpserver>
   <admin_dn>cn=admin.o=example</admin_dn> 
   <admin_password>novell</admin_password> 
  </ncpserver>

Field or Selection Default or Previously Entered Values and Comments

Admin Name with Context cn=admin.o=example

Admin Password admin_password
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NetStorage

Table 7-11   NetStorage Menu Options and Information

XML in the control file is generated similar to the following:

  <netstorage>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <ifolder2_ip_address /> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <xtier_address /> 
   <xtier_proxy_context>cn=admin.o=example</xtier_proxy_context> 
   <xtier_proxy_password>novell</xtier_proxy_password> 
   <xtier_users_context>o=example</xtier_users_context> 
  </netstorage>

Novell Cluster Services

Table 7-12   Novell Cluster Services Menu Options and Information

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389

LDAP Secure Port 636

Enter the iFolder 2 Server Address (optional)

Authentication Domain Host Local Host

Proxy User Name with Context cn=admin.o=example

Proxy User Password

User Context o=example

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry.

Directory Server Address Required only with remote system selection.

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389
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Additional Cluster Services Configuration Information

On the Configuration screens presented:

1 Select whether you are installing locally or remotely, accept or change the admin name and 
password, then click Next.

Locally indicates that you are also installing eDirectory on this server. We recommend that you 
install eDirectory on cluster nodes. If you are not installing eDirectory on this server, select 
Remote.

When installing OES Linux clustering into a NetWare 5.1 or NetWare 6 tree, the Local LDAP 
server option should be used or clustering might fail to install. NetWare 5.1 or NetWare 6 
LDAP servers are incompatible with the OES Linux Cluster Services installation.

2 Choose to either create a new cluster or install Novell Cluster ServicesTM on a server that you 
will add to an existing cluster, or configure later.
Create a New Cluster is the default when installing Novell Cluster Services during the OES 
installation.

3 Specify the fully distinguished name (FDN) of the cluster.
Use the dot format illustrated in the example. Do not use commas.
If you are creating a new cluster, this is the name you will give the new cluster and the 
eDirectory context where the new Cluster object will reside.
If you are adding a server to an existing cluster, this is the name and eDirectory context of the 
cluster that you are adding this server to.

4 (Conditional) If you are creating a new cluster, specify a unique IP address for the cluster.
The cluster IP address is separate from the server IP address, is required to be on the same IP 
subnet as the other cluster servers, and is required for certain external network management 
programs to get cluster status alerts. The cluster IP address provides a single point for cluster 
access, configuration, and management. A Master IP address resource is automatically created 
during the Cluster Services installation that makes this possible.

LDAP Secure Port 636

New or Existing Cluster Existing Cluster

Cluster FDN

Cluster IP Address

Optional Device for SBD

Optional Device for SBD mirror

Name of This Node Local Host

Node's IP Address Probed at install. Specifying an address in this field 
is useful if the server has more than one IP 
address.

Start Clustering Services Now Checked by default. 

Field or Selection Default or Previously Entered Values and Comments
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The cluster IP address is bound to the master node and remains with the master node regardless 
of which server is the master node.

5 (Conditional) If you chose to install remotely in Step 1 on page 101, accept the default server 
name and IP address (recommended), or specify the IP address and server name of a server that 
has eDirectory installed.

6 (Conditional) If you are creating a new cluster, do the following:
6a Specify the device where you want the SBD partition to be created, then click Next.

For example, the device might be something similar to /dev/sdc.
If you have a shared disk system or SAN attached to your cluster servers, Novell Cluster 
Services creates a small cluster partition on that shared disk system. This small cluster 
partition is referred to as the Split Brain Detector (SBD) partition. Provide the drive or 
device where you want the small cluster partition created.
If you do not have a shared disk system connected to your cluster servers, accept the 
default (none). 

IMPORTANT: You must have at least 20 MB of free space on one of the shared disk 
drives to create the cluster partition. If no free space is available, the shared disk drives 
can't be used by Novell Cluster Services.

6b Specify the IP address that clustering should use. If you have multiple network boards 
installed, you need to specify the IP address bound to the desired network board.

6c Select or deselect the Start Clustering Now option.
Start Clustering Now indicates whether clustering should start now or after the machine is 
rebooted.

XML in the control file is generated similar to the following:

  <ncs>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <cluster_dn>cn=cluster.o=example</cluster_dn> 
   <cluster_ip /> 
   <config_type>Existing Cluster</config_type> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address>
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
   <sbd_dev /> 
   <sbd_dev2 /> 
   <server_name /> 
   <start>Now</start> 
  </ncs>

Novell Health Monitoring

The values specify LDAP configuration for this service. The configuration management tool 
generates entries for lifeconsole in the XML source.
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Table 7-13   Novell Health Monitoring Menu Options and Information

XML in the control file is generated similar to the following:

  <lifeconsole>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
  </lifeconsole>

Novell QuickFinder

Table 7-14   Novell QuickFinder Menu Options and Information

XML in the control file is generated similar to the following:

  <novell-quickfinder>
   <admin_name>cn=admin.o=example</admin_name>
   <admin_password>novell</admin_password> 
   <lum_enable>yes</lum_enable> 
   <shadow_access>no</shadow_access> 
   <user_name>cn=admin.o=example</user_name> 
   <user_password>novell</user_password> 
  </novell-quickfinder>

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389

LDAP Secure Port 636

Field or Selection Default or Previously Entered Values and Comments

QuickFinder Admin User Type Local (default) or Directory LUM enabled

QuickFinder Admin Name root if local, cn=admin.o=example if Directory LUM 
enabled

QuickFinder Admin Password

Directory Admin Name with Context cn=admin.o=example

Directory Admin Password admin_password

Add novlwww User to the Shadow Group no
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Novell Remote Manager

No configuration required.

Novell Samba

Table 7-15   Novell Samba Menu Options and Information

XML in the control file is generated similar to the following:

  <novell-samba>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
   <proxy_user_context>cn=proxy.o=example</proxy_user_context> 
   <proxy_user_password>novell</proxy_user_password> 
   <user_context>o=example</user_context>
  </novell-samba>

Novell Storage Services (NSS)

Table 7-16   Novell Storage Services Menu Options and Information

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389

LDAP Secure Port 636

Base Context for Samba Users o=example

Proxy User Name with Context cn=admin.o=example

Proxy User Password

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389
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XML in the control file is generated similar to the following:

  <nss>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <ldap_port config:type="integer">389</ldap_port> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
   <nssadmin_dn>cn=192657114admin.o=example</nssadmin_dn> 
  </nss>

SMS (Storage Management Services, Backup)

Table 7-17   SMS Menu Options and Information

XML in the control file is generated similar to the following:

  <sms>
   <admin_context>cn=admin.o=example</admin_context> 
   <admin_password>novell</admin_password> 
   <ldap_ip_address>192.65.71.18</ldap_ip_address> 
   <ldap_port config:type="integer">389</ldap_port> 
   <ldap_secure_port config:type="integer">636</ldap_secure_port> 
  </sms>

7.5  Setting Up an Installation Source
AutoYaST requires an installation source. You have several options. For an explanation of each, see 
“Network Based Installations” (http://forgeftp.novell.com//yast/doc/SLES9/autoinstall/9.1/html/
Bootmanagement.html) and “The Auto-Installation Process” in  Automatic Linux Installation and 
Configuration with YaST2 (http://forgeftp.novell.com//yast/doc/SLES9/autoinstall/9.1/html/
Invoking.html).

LDAP Secure Port 636

Unique object name for NSS Admin of this server cn=hostnameadmin.o=example

Field or Selection Default or Previously Entered Values and Comments

Local or Remote Directory Server Defaults to the correct selection based on 
eDirectory entry

Directory Server Address Required only with remote system selection

Admin Name with Context cn=admin.o=example

Admin Password admin_password

LDAP Port 389

LDAP Secure Port 636

Field or Selection Default or Previously Entered Values and Comments
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7.6  Additional Issues for OES Components
When SMS is selected for installation, the RPM that contains kernel modules for NSS that allows 
the backing up of trustees is not installed. To fix this problem for installations that use AutoYaST:

1 Manually edit the control file to add the following line to the software section, packages 
subsection:

<package>novell-sms-zapiship-kernel type.rpm</package>

Replace kernel type with the selection applicable to the kernel that you are installing.

The options are:
• default
• smp
• big-smp

For example

  <packages config:type="list">
        <package>heartbeat</package>
        <package>heartbeat-pils</package>
        <package>heartbeat-stonith</package>
        <package>java2</package>
        <package>java2-jre</package>
        <package>km_nss</package>
        <package>libapr0</package>
        <package>libgcj</package>
        <package>libxml</package>
        <package>samba</package>
        <package>novell-sms-zapishim-smp</package>

2 Save the changes.

Adding the novell-sms-zapiship-kernel type.rpm line explicitly installs the required RPMs necessary 
for SMS.

7.7  Sample Control File
The following is a sample control file with most of the OES components configured.

<?xml version="1.0"?>
<!DOCTYPE profile SYSTEM "/usr/share/autoinstall/dtd/profile.dtd">
<profile xmlns="http://www.suse.com/1.0/yast2ns" xmlns:config="http://
www.suse.com/1.0/configns">
  <configure>
    <ca_mgm>
      <password>novell</password>
    </ca_mgm>
    <edirectory>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <dib_location>/var/nds/dib</dib_location>
nstallation Guide



novdocx (E
N

U
)  01 February 2006
      <existing_ip>192.65.71.55</existing_ip>
      <existing_ldap_secure_port config:type="integer">636</
existing_ldap_secure_port>
      <http_port config:type="integer">8028</http_port>
      <https_port config:type="integer">8030</https_port>
      <ldap_port config:type="integer">389</ldap_port>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
      <ntp_server>time.novell.com</ntp_server>
      <server_context>o=novell</server_context>
      <slp_da></slp_da>
     <slp_mode>none</slp_mode>
      <slp_scopes>DEFAULT</slp_scopes>
      <tree_name>OES_EXAMPLE</tree_name>
      <tree_type>existing</tree_type>
    </edirectory>
    <eguide>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <ldap_port config:type="integer">389</ldap_port>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
    </eguide>
    <imanager>
      <admin_context>cn=admin.o=novell</admin_context>
      <tree_name>OES_EXAMPLE</tree_name>
    </imanager>
    <iprint>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
      <tree_name>OES_EXAMPLE</tree_name>
    </iprint>
    <lifeconsole>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
    </lifeconsole>
    <linux-user-mgmt>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <ldap_port config:type="integer">389</ldap_port>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
      <partition_root>o=novell</partition_root>
      <proxy_user>cn=proxy.o=novell</proxy_user>
      <proxy_user_password>novell</proxy_user_password>
      <services>
        <ftp>no</ftp>
        <login>no</login>
        <openwbem>yes</openwbem>
        <passwd>no</passwd>
        <rlogin>no</rlogin>
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        <rsh>no</rsh>
        <sshd>yes</sshd>
        <su>no</su>
        <xdm>no</xdm>
      </services>
      <ws_context>o=novell</ws_context>
    </linux-user-mgmt>
    <ncpserver>
      <admin_dn>cn=admin.o=novell</admin_dn>
      <admin_password>novell</admin_password>
    </ncpserver>
    <netstorage>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <ifolder2_ip_address></ifolder2_ip_address>
      <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <xtier_address></xtier_address>
      <xtier_proxy_context>cn=admin.o=novell</xtier_proxy_context>
      <xtier_proxy_password>novell</xtier_proxy_password>
      <xtier_users_context>o=novell</xtier_users_context>
    </netstorage>
    <novell-quickfinder>
      <admin_name></admin_name>
      <admin_password>novell</admin_password>
      <lum_enable>no</lum_enable>
      <shadow_access>no</shadow_access>
      <user_name>root</user_name>
      <user_password>novell</user_password>
    </novell-quickfinder>
    <novell-samba>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
      <proxy_user_context>cn=proxy.o=novell</proxy_user_context>
      <proxy_user_password>novell</proxy_user_password>
      <user_context>o=novell</user_context>
    </novell-samba>
    <novell-vo>
      <address>192.65.71.55</address>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
      <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
      <users_context>o=novell</users_context>
    </novell-vo>
    <scripts>
      <post-scripts config:type="list">
        <script>
          <filename>test_hello_world</filename>
          <interpreter>shell</interpreter>
          <location></location>
          <source><![CDATA[#!/bin/sh
‘echo "hello world" > /tmp/post-script-output']]></source>
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        </script>
      </post-scripts>
    </scripts>
    <sms>
      <admin_context>cn=admin.o=novell</admin_context>
      <admin_password>novell</admin_password>
     <ldap_ip_address>192.65.71.55</ldap_ip_address>
      <ldap_port config:type="integer">389</ldap_port>
      <ldap_secure_port config:type="integer">636</ldap_secure_port>
    </sms>
    <users config:type="list">
      <user>
        <encrypted config:type="boolean">true</encrypted>
        <user_password>WKtayGW8zA9fw</user_password>
        <username>root</username>
      </user>
    </users>
    <x11>
      <color_depth config:type="integer">16</color_depth>
      <configure_x11 config:type="boolean">true</configure_x11>
      <display_manager>kdm</display_manager>
      <enable_3d config:type="boolean">false</enable_3d>
      <monitor>
        <display>
          <max_hsync config:type="integer">85</max_hsync>
          <max_vsync config:type="integer">106</max_vsync>
          <min_hsync config:type="integer">30</min_hsync>
          <min_vsync config:type="integer">50</min_vsync>
        </display>
        <monitor_device>MULTISCAN 200GS</monitor_device>
        <monitor_vendor>SONY</monitor_vendor>
      </monitor>
      <resolution>1024x768</resolution>
      <window_manager>kde</window_manager>
    </x11>
  </configure>
  <install>
    <bootloader>
      <activate config:type="boolean">false</activate>
      <device_map config:type="list">
        <device_map_entry>
          <firmware>(hd0)</firmware>
          <linux>/dev/hda</linux>
        </device_map_entry>
        <device_map_entry>
          <firmware>(fd0)</firmware>
          <linux>/dev/fd0</linux>
        </device_map_entry>
      </device_map>
      <global config:type="list">
        <global_entry>
          <key>color</key>
          <value>white/blue black/light-gray</value>
        </global_entry>
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        <global_entry>
          <key>default</key>
          <value config:type="integer">0</value>
        </global_entry>
        <global_entry>
          <key>timeout</key>
          <value config:type="integer">8</value>
        </global_entry>
        <global_entry>
          <key>gfxmenu</key>
          <value>(hd0,4)/boot/message</value>
        </global_entry>
      </global>
      <initrd_modules config:type="list">
        <initrd_module>
          <module>reiserfs</module>
        </initrd_module>
      </initrd_modules>
      <loader_device>/dev/hda</loader_device>
      <loader_type>grub</loader_type>
      <location>mbr</location>
      <repl_mbr config:type="boolean">false</repl_mbr>
      <sections config:type="list">
       <section config:type="list">
          <section_entry>
            <key>title</key>
            <value>Linux</value>
          </section_entry>
          <section_entry>
            <key>kernel</key>
            <value>(hd0,4)/boot/vmlinuz root=/dev/hda5 vga=0x31a 
selinux=0 splash=silent resume=/dev/hda1 elevator=cfq showopts</value>
          </section_entry>
          <section_entry>
            <key>initrd</key>
            <value>(hd0,4)/boot/initrd</value>
          </section_entry>
        </section>
        <section config:type="list">
          <section_entry>
            <key>title</key>
            <value>Floppy</value>
          </section_entry>
          <section_entry>
            <key>root</key>
            <value>(fd0)</value>
          </section_entry>
          <section_entry>
            <key>chainloader</key>
            <value>+1</value>
          </section_entry>
        </section>
        <section config:type="list">
          <section_entry>
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            <key>title</key>
            <value>Failsafe</value>
          </section_entry>
          <section_entry>
            <key>kernel</key>
            <value>(hd0,4)/boot/vmlinuz root=/dev/hda5 showopts 
ide=nodma apm=off acpi=off vga=normal noresume selinux=0 barrier=off 
nosmp noapic maxcpus=0  3</value>
          </section_entry>
          <section_entry>
            <key>initrd</key>
            <value>(hd0,4)/boot/initrd</value>
          </section_entry>
        </section>
      </sections>
    </bootloader>
    <general>
      <clock>
        <hwclock>UTC</hwclock>
        <timezone>US/Pacific</timezone>
      </clock>
      <keyboard>
        <keymap>english-us</keymap>
      </keyboard>
      <language>en_US</language>
      <mode>
        <confirm config:type="boolean">false</confirm>
      </mode>
      <mouse>
        <id>22_exps2</id>
      </mouse>
    </general>
    <partitioning config:type="list">
      <drive>
        <device>/dev/hda</device>
        <partitions config:type="list">
          <partition>
            <filesystem config:type="symbol">swap</filesystem>
            <format config:type="boolean">true</format>
            <mount>swap</mount>
            <partition_id config:type="integer">130</partition_id>
            <partition_nr config:type="integer">1</partition_nr>
            <region config:type="list">
              <region_entry config:type="integer">0</region_entry>
              <region_entry config:type="integer">988</region_entry>
            </region>
            <size>509386753</size>
          </partition>
          <partition>
            <partition_id config:type="integer">5</partition_id>
            <partition_nr config:type="integer">4</partition_nr>
            <region config:type="list">
              <region_entry config:type="integer">2948</region_entry>
              <region_entry config:type="integer">23428</region_entry>
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           </region>
            <size>12090580993</size>
          </partition>
        </partitions>
        <use>all</use>
      </drive>
    </partitioning>
    <report>
      <errors>
        <log config:type="boolean">true</log>
        <show config:type="boolean">true</show>
        <timeout config:type="integer">0</timeout>
      </errors>
      <messages>
        <log config:type="boolean">true</log>
        <show config:type="boolean">true</show>
        <timeout config:type="integer">0</timeout>
      </messages>
      <warnings>
        <log config:type="boolean">true</log>
        <show config:type="boolean">true</show>
        <timeout config:type="integer">0</timeout>
      </warnings>
      <yesno_messages>
        <log config:type="boolean">true</log>
        <show config:type="boolean">true</show>
        <timeout config:type="integer">0</timeout>
      </yesno_messages>
    </report>
    <software>
      <addons config:type="list">
        <addon>novell-health-monitoring</addon>
        <addon>auth</addon>
        <addon>novell-sms</addon>
        <addon>novell-iManager</addon>
        <addon>novell-samba</addon>
        <addon>novell-welcome</addon>
        <addon>Basis-Sound</addon>
        <addon>novell-eDirectory</addon>
        <addon>novell-lum</addon>
        <addon>novell-netStorage</addon>
        <addon>novell-ncp</addon>
        <addon>novell-web-services</addon>
        <addon>novell-quickFinder</addon>
        <addon>Base-System</addon>
        <addon>X11</addon>
        <addon>novell-yast2</addon>
        <addon>novell-nrm</addon>
        <addon>SuSE-Documentation</addon>
        <addon>Kde-Desktop</addon>
        <addon>Linux-Tools</addon>
        <addon>novell-eguide</addon>
        <addon>novell-life</addon>
        <addon>novell-base</addon>
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        <addon>YaST2</addon>
        <addon>novell-ipmanagement</addon>
        <addon>novell-iPrint</addon>
      </addons>
      <base>novell-oes-all</base>
      <packages config:type="list">
        <package>perl-ldap-ssl</package>
        <package>perl-ldap</package>
        <package>perl-libwww-perl</package>
        <package>apache2</package>
        <package>autofs4</package>
        <package>convmv</package>
        <package>gdk-pixbuf</package>
        <package>ifolder3-enterprise</package>
        <package>ifolder3-tsa</package>
        <package>ifolder3-web</package>
        <package>java2</package>
        <package>java2-jre</package>
        <package>km_novfs</package>
        <package>libapr0</package>
        <package>libgcj</package>
        <package>libxml</package>
        <package>mod_mono</package>
        <package>mono-core</package>
        <package>mono-data</package>
        <package>mono-web</package>
        <package>ncompress</package>
        <package>novell-cluster-services</package>
        <package>novell-cluster-services-km</package>
        <package>novell-iManNDSbase</package>
        <package>novell-iManNLDAPbase</package>
        <package>novell-iManNLDAPsdk</package>
        <package>novell-iManNOVLice</package>
        <package>novell-iManNOVLlmgnt</package>
        <package>novell-iManNOVLxis</package>
        <package>novell-iManager-npkiapi</package>
        <package>novell-iManager-npkit</package>
        <package>novell-ncp</package>
        <package>novell-nmasclient</package>
        <package>novell-sms-zapishim-default</package>
        <package>novell-tomcat4</package>
        <package>ocfs2-tools</package>
        <package>ocfs2console</package>
        <package>pam_mount</package>
        <package>python</package>
        <package>python-gtk</package>
        <package>python-ldap</package>
        <package>python-xml</package>
        <package>samba</package>
        <package>sharutils</package>
        <package>simias</package>
        <package>simias-enterprise</package>
        <package>xsp</package>
        <package>yast2-printer</package>
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        <package>apache2-jakarta-tomcat-connectors</package>
        <package>db1</package>
        <package>gnome-libs</package>
        <package>jakarta-tomcat</package>
        <package>libglade</package>
        <package>nmap</package>
        <package>orbit</package>
        <package>perl-Convert-ASN1</package>
        <package>perl-HTML-Parser</package>
        <package>perl-HTML-Tagset</package>
        <package>perl-IO-Socket-SSL</package>
        <package>perl-Net_SSLeay</package>
        <package>python-numeric</package>
      </packages>
    </software>
  </install>
</profile>
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8Removing OES Linux Components

You can remove OES component RPMs using YaST.

NOTE: YaST does not support deconfiguring products that create objects or attributes in 
eDirectoryTM. You need to use iManager to remove these objects and attributes. For procedures, see 
“Delete Object” in the Novell iManager 2.5 Administration Guide.

1 Launch YaST.
2 Click Software > Install and Remove Software.
3 Search for the component you want to remove.

You can use the Filter menu to select other views for locating the components you want to 
remove.
To search for an item:
3a In Filter drop-down list, select Search.
3b In the Search field, type the name of the rpm, technology, or word that you want to search 

for.
3c Click Search.

A list of packages with the criteria you specified is displayed in the packages summary 
list.

4 Right-click the component you want to remove, then click Delete.
This marks the component for removal.

5 Click Accept to remove the component.
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9Security Considerations

This section includes issues that you should consider when installing and configuring an OES Linux 
server.

• Section 9.1, “Installing Using AutoYaST,” on page 117
• Section 9.2, “Access to the Server during Installation or Upgrade,” on page 117
• Section 9.3, “Remote Installations Using VNC,” on page 117

9.1  Installing Using AutoYaST
When you create a control.xml file using AutoYast, the eDirectoryTM password for user Admin 
is written in clear text. This password can be read by anyone who has access to the file. Linux 
passwords are stored in the file in a hashed form.

We recommend controlling access to this file.

9.2  Access to the Server during Installation or 
Upgrade
Because eDirectory passwords are not obfuscated in system memory during the installation or 
upgrade, we recommend not leaving a server unattended during the installation, upgrade, or 
configuration.

Using ssh (secure shell) to access the system does not work during installation, but ssh can be used 
from the system being installed after the first reboot. YaST installation is always a down server 
installation, so unauthorized users cannot connect to the computer from other computers on the 
network during an installation or update.

9.3  Remote Installations Using VNC
While installing the server, we recommend that you do not use Virtual Network Computing (VNC) 
for remote installation in an untrusted environment.
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AInstalling Linux with EVMS as the 
Volume Manager of the System 
Device

If you plan to use the Novell® Storage ServicesTM (NSS) file system for data volumes on your OES 
Linux server, you might need to modify the Partitioning settings in the install procedure to use 
EVMS (Enterprise Volume Management System) as the volume manager of the system device. This 
section provides background to help you make the decision and instructions for how to do it. 

• Section A.1, “FAQs About Using EVMS with NSS,” on page 119
• Section A.2, “Storage Deployment Scenarios for NSS,” on page 121
• Section A.3, “Configuring the System Device to Use EVMS,” on page 125

A.1  FAQs About Using EVMS with NSS
• Section A.1.1, “Why Should I Use EVMS with NSS?,” on page 119
• Section A.1.2, “Does NSS Work with Non-EVMS Volume Managers?,” on page 119
• Section A.1.3, “Why Address EVMS Issues at Install Time?,” on page 120
• Section A.1.4, “Can I Reconfigure Devices to Use EVMS During an Upgrade?,” on page 121
• Section A.1.5, “Can I Use NSS After the Install If Existing Devices Do Not Use EVMS?,” on 

page 121

A.1.1  Why Should I Use EVMS with NSS?
Using EVMS with NSS allows you to take advantage of the full range of capabilities of NSS and the 
NSS management tools, including the Storage plug-in to Novell iManager 2.5, NSS Management 
Utility (NSSMU), and NSS utilities and commands. NSS tools require EVMS for management 
functions related to devices, software RAIDS, partitions, and pools. 

For information about limitations for NSS on devices managed by non-EVMS volume managers, 
see “Does NSS Work with Non-EVMS Volume Managers?” on page 119.

A.1.2  Does NSS Work with Non-EVMS Volume Managers?
NSS file systems work on devices that are managed by any volume manager. However, the 
following NSS capabilities are unavailable or have limited availability for devices managed by a 
non-EVMS volume manager:

• NSS Management Tools: The following NSS management tools are affected:
• The Storage plug-in for Novell iManager 2.5 requires that EVMS be used as the volume 

manager of any devices where you want to create and manage NSS file systems. The tool 
does not work with devices managed by non-EVMS volume managers.
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• The NSS tools, utilities, or commands that are used to manage devices, create and manage 
software RAID devices, create and manage partitions, and create pools require EVMS. 
However, with a non-EVMS volume manager, you can perform these tasks with Linux 
tools and utilities or with third-party tools. 

• NSSMU requires EVMS to manage partitions, to manage devices, to create and manage 
software RAIDs, and to create pools. Without EVMS, you can use some management 
functions for NSS pools, but you cannot create them. 
You can use NSSMU to create and manage both non-encrypted and encrypted volumes for 
the existing pools you create from the Linux command line.

• NSS Software RAIDS: NSS requires EVMS to create and manage software RAID devices. If 
you want to create software RAIDs, use the capability in whatever non-EVMS volume 
manager you use.

• Cross-Platform Compatibility: Pools created on devices managed by non-EVMS volume 
managers cannot be moved to a NetWare® server.

• Clusters: Novell Cluster ServicesTM (NCS) for Linux requires EVMS for clustering. Pools 
created on devices managed by non-EVMS volume managers cannot be used in NCS clusters. 
Third-party clustering systems that integrate with third-party cluster volume managers should 
be able to work with NSS volumes.

To use NSS with a non-EVMS volume manager, create partitions and pools with the Linux mkfs 
command, then use NSSMU and NSS volume management commands to manage the volumes. For 
information, see “Using NSS on Devices Managed by Non-EVMS Volume Managers” in the Novell 
Storage Services File System Administration Guide for OES.

A.1.3  Why Address EVMS Issues at Install Time?
The Linux 2.6 and later kernel prevents multiple volume managers from managing the same device, 
so you should decide which volume manager to use for devices based on how you plan to use the 
space on those devices and the tools you want to use to manage them. 

Linux requires traditional Linux file systems for system partitions such as the boot (/boot), swap, 
and root (/) partitions. NSS volumes on Linux are configured as data volumes after the install; they 
cannot be configured at install time. 

At install time, OES Linux uses LVM (Linux Volume Management) as the default volume manager 
for the system device and any other devices that you configure for traditional Linux volumes. When 
you later create NSS volumes, the NSS tools recognize only those devices that are managed by 
EVMS or that are unconfigured; it does not find devices managed by LVM. If you have a single 
device or if you have multiple devices and choose to mix traditional Linux file systems and NSS file 
systems on the same device, volume manager issues affect how you can use or manage storage after 
the install.

Before you install OES Linux, you should consider deployment solutions that reserve a device for 
NSS or configure devices to use EVMS at install time. This allows you to take advantage of the full 
capabilities of NSS management tools for NSS file systems. For information, see “Storage 
Deployment Scenarios for NSS” on page 121.

If you decide to use the LVM defaults at install time, you can still use unallocated free space on the 
devices for NSS file systems after the install. For information, see “Can I Use NSS After the Install 
If Existing Devices Do Not Use EVMS?” on page 121.
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A.1.4  Can I Reconfigure Devices to Use EVMS During an 
Upgrade?
During an upgrade, you can modify the suggested Partitioning settings to use EVMS instead of 
LVM for the system device. This action deletes the existing LVM partitions and partition tables and 
creates new partitions and partition tables. 

WARNING: Re-partitioning a device during the install destroys all data on the device. To prevent 
data loss, it is best to use the modified install option only on a new device.

If the system device also contains data volumes, take one or more of the following precautionary 
measures before you upgrade: 

• Move all data volumes off the system device to another device.
• If you cannot move the volumes, make a backup copy of the data volumes, so you can restore 

the data volumes later from a backup copy.

A.1.5  Can I Use NSS After the Install If Existing Devices Do Not 
Use EVMS?
If you do not configure devices at install time to use EVMS, it is still possible to use NSS file 
systems on the server. Use any of the following approaches:

• Add a new device. Add an unconfigured device to use for NSS volumes. Use the Storage plug-
in to iManager or NSSMU to create at least one NSS volume on the device before you create 
any traditional Linux file systems on it. This ensures that EVMS automatically controls the 
device.

• Reconfigure the device to use EVMS as the volume manager: Set up the device to use 
EVMS without re-installing OES Linux. You can then use the Storage plug-in to iManager or 
NSSMU to create NSS pools and volumes in the unallocated free space on the device.
For information, see “Making Devices Available to EVMS” in the Novell Storage Services File 
System Administration Guide for OES.

• Use NSS with the non-EVMS volume manager. Use the Linux mkfs command to create 
NSS partitions and pools with the unallocated free space. You have limited capability to 
manage NSS volumes, as described in “Does NSS Work with Non-EVMS Volume Managers?” 
on page 119.

A.2  Storage Deployment Scenarios for NSS
This section provides the following scenarios to help you determine whether you need to modify the 
install to use EVMS for the system device. 

Table A-1   Scenarios for Storage Deployment

Scenario System Device Data Device Install for System Device

“System Device with LVM and 
Data Devices with EVMS 
(Recommended)” on page 122

LVM or other 
non-EVMS 

EVMS Normal. Do not configure data 
devices during the install.
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A.2.1  System Device with LVM and Data Devices with EVMS 
(Recommended)
We recommend that you use two or more logical or physical storage devices for your server. Use one 
for the system device and the others for data devices. 

A device can be a single hard disk, multiple hard disks configured as a hardware RAID 1 or RAID 5 
device, or a logical device. If you have only a single device, carve it into at least two logical devices 
before beginning the install. Use a third-party tool for disk carving, such as fdisk or a tool 
provided by the device vendor.

In this recommended solution, use an LVM or another volume manager for the system device, then 
use EVMS to manage other devices on the system. Use the normal install procedure to implement 
this storage deployment plan.

• “System Device with LVM” on page 122
• “Devices with NSS File Systems and EVMS” on page 123
• “Devices with Traditional Linux File Systems” on page 123
• “NSS Management Tools for Devices with NSS and EVMS” on page 123

System Device with LVM

Reserve one of the available devices for use as a system device that contains only the Linux boot (/
boot), swap, and root (/) partitions for your Linux server. Use space from this device for the boot, 
swap, and root partitions. Use any volume manager as the default volume manager of the system 
device, such as LVM (default), EVMS, or third-party volume managers.

The system device should be about 20 GB, depending on the following:

• The size of the boot partition (about 300 MB recommended)
• The size of the swap partition (at least equal to the amount of RAM on the server, up to about 

two times the RAM available, according to your anticipated performance needs)
• The size of the system volume (allow at least 2 GB (minimum) or up to 10 GB (recommended), 

depending on the OES services that you intend to install)
• The size needed for any planned kernel extensions or services to be added post-install

“System and Data Devices with 
EVMS” on page 123

EVMS EVMS Modified. For information, see 
“Configuring the System Device 
to Use EVMS” on page 125

“A Single Device with EVMS” on 
page 123

EVMS No device Modified. For information, see 
“Configuring the System Device 
to Use EVMS” on page 125

“One or Multiple Devices without 
EVMS” on page 124

LVM or other 
non-EVMS

No device or 
non-EVMS

Normal. Do not configure data 
devices during the install.

Scenario System Device Data Device Install for System Device
nstallation Guide



novdocx (E
N

U
)  01 February 2006
Devices with NSS File Systems and EVMS

Reserve at least one device for use only with NSS file systems and manage the device with EVMS. 
During the install, leave the devices where you plan to use NSS volumes as unallocated free space. 

IMPORTANT: Do not configure the data devices during the install. 

Devices with Traditional Linux File Systems

If you reserve a device for use only with traditional Linux file systems, you can use any volume 
manager for it. If you use EVMS, the NSS tools can see unallocated free space on the device and 
you could easily use the space for NSS volumes at any time after the install.

NSS Management Tools for Devices with NSS and EVMS

NSS file systems and traditional Linux file systems can coexist on the same devices, but you must 
manage the Linux file systems with EVMS in this deployment scenario. After the install, for any 
data devices where you plan to create NSS volumes, make sure to create at least one NSS volume on 
the device before you create any traditional Linux volumes. Use the Storage management plug-in to 
iManager or NSSMU to create the pools and volumes. The order of creation and the toolset you use 
helps ensure that EVMS automatically controls the device. 

If you create traditional Linux file systems first on the devices, YaST sets up the device to use LVM 
by default, and you must take additional steps to move the device to EVMS control. For 
information, see “Making Devices Available to EVMS” in the Novell Storage Services File System 
Administration Guide for OES.

Use EVMS GUI or other Linux tools to optionally create traditional Linux file systems with 
unallocated free space on devices managed by EVMS.

A.2.2  System and Data Devices with EVMS
If you want to use EVMS for the system and data devices, modify the install to use EVMS to 
manage the system device, and make sure to leave unallocated free space available for NSS file 
systems on it. For information, see “Configuring the System Device to Use EVMS” on page 125.

Follow the guidelines for data devices and tools in “System Device with LVM and Data Devices 
with EVMS (Recommended)” on page 122.

A.2.3  A Single Device with EVMS
Use a single device if you have only a single device that cannot be carved into at least two logical 
devices before beginning the install. A device can be a single hard disk or multiple hard disks 
configured as a hardware RAID 1 or RAID 5 device. 

If your storage deployment plan meets the following device configuration plan, modify the install to 
use EVMS to manage the device, and make sure to leave unallocated free space available for NSS 
file systems. For information, see “Configuring the System Device to Use EVMS” on page 125.

• “System Partitions” on page 124
• “Unallocated Free Space” on page 124
• “NSS Management Tools” on page 124
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System Partitions

Modify the install to configure the Linux boot (/boot), swap, and root (/) partitions to work 
under EVMS. 

The total combined space of the system partitions should be about 20 GB, depending on the 
following:

• The size of the boot partition (about 300 MB recommended)
• The size of the swap partition (at least equal to the amount of RAM on the server, up to about 

two times the RAM available, according to your anticipated performance needs)
• The size of the system volume (allow at least 2 GB (minimum) or up to 10 GB (recommended), 

depending on the OES services that you intend to install)
• The size needed for any planned kernel extensions or services to be added post-install

Unallocated Free Space

During the install, leave the remainder of space on the device to use for NSS file systems or 
traditional Linux file systems. 

NSS Management Tools

After the install, use the Storage management plug-in to iManager or NSSMU to create NSS pools 
and volumes in the unallocated free space. Use EVMS GUI or other Linux tools to optionally create 
traditional Linux file systems with unallocated free space.

A.2.4  One or Multiple Devices without EVMS
In this scenario, you choose to use LVM or another non-EVMS volume manager for your devices. 
You understand the limitations for using a non-EVMS volume manager with NSS that are discussed 
in “Does NSS Work with Non-EVMS Volume Managers?” on page 119.

If your storage deployment plan meets the following device configuration plan, use the normal 
install procedure to implement this storage deployment plan.

• “System Partitions” on page 124
• “Unallocated Free Space” on page 125
• “Limited NSS Management Tools” on page 125

System Partitions

During the install, configure the Linux boot (/boot), swap, and root (/) partitions to work under 
LVM (or other non-EVMS volume manager). 

The total combined space of the system partitions should be about 20 GB, depending on the 
following:

• The size of the boot partition (about 300 MB recommended)
• The size of the swap partition (at least equal to the amount of RAM on the server, up to about 

two times the RAM available, according to your anticipated performance needs)
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• The size of the system volume (allow at least 2 GB (minimum) or up to 10 GB (recommended), 
depending on the OES services that you intend to install)

• The size needed for any planned kernel extensions or services to be added post-install

Unallocated Free Space

During the install, leave the remainder of space on the device to use for NSS file systems or 
traditional Linux file systems. 

Limited NSS Management Tools

Create partitions and pools with the Linux mkfs command, then use NSSMU and NSS volume 
management commands to manage the volumes. For information, see “Using NSS on Devices 
Managed by Non-EVMS Volume Managers” in the Novell Storage Services File System 
Administration Guide for OES.

A.3  Configuring the System Device to Use EVMS
This section discusses how to configure the system device during the Linux install to use EVMS as 
the volume manager. For the purposes of this install, a system device is any device that contains the 
Linux /boot, swap, or root (/) partitions for your Linux computer. 

• Section A.3.1, “Before the Install,” on page 125
• Section A.3.2, “During the Install,” on page 127
• Section A.3.3, “After the Install,” on page 130

A.3.1  Before the Install
This section discusses the following:

• “Storage Deployment Considerations for the System Device” on page 125
• “Storage Deployment Considerations for Data Devices” on page 126
• “Data Loss Considerations for the System Device” on page 126
• “Hardware RAID Controller Considerations” on page 126
• “Known Issue (OES Linux)” on page 127

Storage Deployment Considerations for the System Device

Before you begin, please review the following:

• “FAQs About Using EVMS with NSS” on page 119
• “Storage Deployment Scenarios for NSS” on page 121
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The modified install procedures in this section describe how to install OES Linux with EVMS as the 
volume manager of the system device. The instructions assume the following:

• You want to use EVMS on the system device.
• You are configuring only the system device during the install.
• Any other devices on the system are left as unallocated free space to be configured after the 

system is operating and performing as expected.

All other deployment scenarios can use the normal install with regard to the system device.

Storage Deployment Considerations for Data Devices

During the install, if you set up traditional Linux file systems on data devices where you also plan to 
use NSS volumes with EVMS, make sure to do the following:

• Leave unallocated free space on the device to use for NSS volumes.
• Configure the devices to use EVMS as the volume manager.

Data Loss Considerations for the System Device

During the install, when you modify the Partitioning settings to use EVMS instead of LVM, you 
must delete the recommended LVM partitions and partition tables and create new partitions and 
partition tables. This destroys all data on the disk.

IMPORTANT: To avoid data loss, it is best to use the modified install option only on a new device. 

If you upgrade to OES Linux from an existing Linux server or from a NetWare server, remnants of 
the prior system and data volumes on the system device might prevent a smooth installation and can 
result in data loss, depending on what is stored on your system device.   

• When you repartition the system device during the install to use EVMS, the installation deletes 
all data on the device.

• You might get unexpected warnings that EVMS-controlled system or boot partitions cannot be 
created because of remnants of the old system. It might be necessary to wipe (zero-out) the 
drive, then begin the installation again.

In either case, if you have data volumes stored on the existing system device, the data is destroyed.

If you have data volumes on the system device, take one or more of the following precautionary 
measures before you upgrade: 

• Before upgrading using the modified install, move the data volumes from the system device to 
another device.

• If you cannot move the volumes, make a backup copy of the data volumes, so you can restore 
the data volumes later from a backup copy.

Hardware RAID Controller Considerations

If the server uses a hardware RAID controller with SCSI devices, and you plan to use space on it for 
NSS pools and volumes, make sure the RAID controller and SCSI devices use Write-Through cache 
management, not Write-Back cache management. Use the controller’s BIOS setup routine or 
configuration utility to enable Write-Through cache management when you set up the RAID.
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IMPORTANT: Using Write-Back cache management on SCSI drives with a journaled file system 
such as NSS can actually degrade file system performance instead of improving it. For information, 
see “Troubleshooting the NSS File System” in the Novell Storage Services File System 
Administration Guide for OES.

Known Issue (OES Linux)

In the initial version of OES Linux, certain hardware configurations utilizing an HP Smart Array 
Controller, such as the 5i RAID Controller, rely on a naming scheme that is incompatible with the 
EVMS module found on the shipping OES Linux CD1 ISO image. This issue prevents using EVMS 
on the primary hard drive of these machines. 

IMPORTANT: This issue is resolved in OES Linux SP1 and later.

For details on this issue and an updated OES CD1 ISO image that resolves this problem, see TID 
2971770, OES install fails with EVMS Volume Manager (http://support.novell.com/cgi-bin/search/
searchtid.cgi?/2971770.htm).

After booting from the CD, you must continue installing the server from CD rather than using a 
network installation procedure, or the patched files are overwritten.

If you use the same size partitions as the previous partitions on the disk, the installation fails.

A.3.2  During the Install

WARNING: The following procedure to install Linux with EVMS as the volume manager for the 
system device destroys all data on the system device.

To install Linux with EVMS as the volume manager for your boot and system partitions, you must 
modify the Partitioning configuration in the Installation Settings.

1 Begin the SLES 9 install for OES. 

For information, see “Installing Open Enterprise Server (OES) Linux” on page 21.
2 When the installation reaches the Installations Settings screen, delete the recommended 

partitions and the partition table on the system disk so that the device can be marked to use 
EVMS as the volume manager instead of LVM.
2a In the list of Installation Settings, select Partitioning. 
2b In the Partitioning menu, select Create Custom Partition Setup, then click Next.
2c Select Custom Partition - for Experts, then click Next to open the Expert Partitioner 

options.
2d Select Expert > Delete Partition Table and Disk Label, then click Yes twice to continue 

through the Warning advisories.
This deletes the recommended partitions and the partition table on the system disk.

3 Create a primary partition on the system disk to use as the boot partition.
3a Click Create.
3b From the list of devices, select the device you want to use for the boot partition, such as /

dev/hda, then click OK.
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If you have a single system disk, only one device is available and you are not prompted for 
the device.

3c Select Primary Partition, then click OK.
3d Select Format, then select the native Linux file system you want to use, such as Reiser.
3e In Size (End Value) field, specify 200 MB or larger. 

For example, to set the size at 300 MB, type 300M.
3f Set the mount point to /boot.

3g Click OK.
The partition appears as a logical device in the devices list, such as /dev/hda1.

4 Create a second primary partition on the system disk to use for your swap and system volumes 
as follows:
4a Click Create.
4b From the list of devices, select the device you want to use for the second primary partition, 

such as /dev/hda, then click OK.
If you have a single system disk, only one device is available and you are not prompted for 
the device.

4c Select Primary Partition, then click OK.
4d Select Do Not Format, then select Linux LVM (0x8E) from the list of file system IDs.
4e In Size (End Value field), set the cylinder End value to 5 GB or larger, depending on the 

combined partition size you need to contain your system and swap volumes based on the 
following recommendations:

IMPORTANT: Do not make the system partition larger than necessary. The remaining 
space on the system disk can be used to create NSS volumes or native Linux volumes that 
are managed by EVMS.

• In determining how much space to allow for your system volume, allow at least 2 GB 
(minimum) or up to 10 GB (recommended), depending on the OES services that you 
intend to install.

• If you intend to create additional NSS volumes on the same physical disk, you must 
leave unpartitioned space available.

• The amount of space you set aside for the swap volume should be at least equal to the 
amount of RAM on the server. Setting the swap volume size to two times the RAM is 
recommended for better performance.

• The total size should be the size you need for your system volume plus the size you 
need for your swap volume.

For example,
If you have a 20 GB hard drive with 2 GB of RAM and plan to install all of the OES 
services on the system volume, your system partition should be at least 12 GB. For better 
performance, make the system partition 14 GB with 4 GB allotted for the swap drive. The 
remaining 5+ GB can be left unpartitioned for NSS volumes or other Linux partitions that 
you might want to create later.

4f Click OK.
The partition appears as a logical device in the devices list, such as /dev/hda2.
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5 Modify the volume management type from LVM to EVMS for the second primary partition 
you created in Step 4 as follows:
5a At the bottom of the page, click EVMS.

Available partitions for EVMS appear as devices under /dev/evms, such as /dev/
evms/hda2.

5b In the EVMS Configurator, select the LVM partition created in Step 4, then click Create 
Container.

5c In the Create EVMS Container dialog box, select the partition, specify the container name 
(such as system), then click Add Volume to create the lvm/system container, where 
system is the container name.

5d Click OK.
The EVMS Configurator displays the lvm/system container you just created, its size, 
and free space.

6 Create the swap volume in the lvm/system container as follows:
6a Select lvm/system, then click Add.
6b In the Create Logical Volume dialog box, select Format, then select Swap from the File 

System drop-down menu.
6c Specify swap as the volume name.
6d Specify the size of the swap volume as 1 GB, or larger if you have more RAM. 

The swap volume should be at least as large as your RAM.
6e Specify the mount point as swap.
6f Click OK.

7 Create the system volume in the lvm/system container as follows:
7a Select lvm/system, then click Add.
7b In the Create Logical Volume dialog box, select Format, then select the file system to use 

from the File System drop-down menu, such as Reiser.
7c In the Volume Name field, specify a volume name, such as sys_lx.
7d Specify the Size of the system volume as the remaining space available in the lvm/

system partition by clicking Max. 
7e Specify the mount point as / (root volume).
7f Click OK.

8 Click Next to return to the list of devices.
Below is an example of the physical and logical devices that should be configured on your 
system. Your setup depends on the number of devices in the server and the sizes you choose for 
your partitions.

Device Size F Type Mount Start End Used By

/dev/hda 149.0 GB 6Y160p0 0 19456

/dev/hda1 305.9 MB F Linux Native 
(Reiser)

/boot 0 38
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9 Click Next to return to the Installation Settings page.
You can dismiss the message warning that you should not mix EVMS and non-EVMS 
partitions on the same device.

10 From the Installations Settings screen, click Software > Details, then select NSS from the 
available software options.

11 Continue with the OES installation.

IMPORTANT: After the install is complete, make sure to perform the mandatory post-install 
configuration of the related system settings to ensure that the system device functions properly 
under EVMS. Otherwise, the system fails to boot properly. 
For information, see “After the Install” on page 130. 

A.3.3  After the Install
After the OES installation is complete, you must perform the following tasks to ensure that the 
system device functions properly under EVMS:

• “Edit the /etc/fstab File” on page 130
• “Disable boot.lvm and boot.md” on page 131
• “Enable the boot.evms Service” on page 131
• “Edit the /etc/init.d/boot.evms Script” on page 132
• “Enable Write-Through Cache Management for SCSI Devices” on page 132
• “Reboot the Server” on page 133
• “Verify the System Services” on page 133
• “Create NSS Pools and Volumes” on page 133

Edit the /etc/fstab File

When you boot the system, the kernel reads the /etc/fstab file to identify which file systems 
should be mounted and then mounts them. This file contains a table of file system information about 
the root (/), /boot, and swap partitions plus other partitions and file systems you want to mount.

/dev/hda2 20.0 GB Linux LVM 39 2649 EVMS 
lvm/
system

/dev/hdb 111.8 GB SP1203N 0 14595

/dev/evms/lvm/system/
sys_lx

14.9 GB F EVMS / - -

/dev/evms/lvm/system/
swap

5.0 GB F EVMS swap - -

Device Size F Type Mount Start End Used By
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The /boot partition is separate from the EVMS container where you placed the root (/) and swap 
partitions and is not managed by EVMS at this time. However, in the following steps, you disable 
boot.lvm and boot.md, then enable boot.evms. In effect, this forces EVMS to scan all the 
partitions at boot time, including the /boot partition, and it activates /boot under the /dev/
evms directory. Therefore, this makes /boot a partition that is discovered by EVMS at startup, 
and requires that the device be listed under /dev/evms in the fstab file so it can be found when 
booting with boot.evms. 

After the install, you must edit the /etc/fstab file to modify the location of the /boot partition 
so it is under the /dev/evms directory. For example, change /dev/hda1 to /dev/evms/
hda1. Replace hda1 with the device name you used for your /boot partition.

IMPORTANT: When working in the /etc/fstab file, do not leave any stray characters or 
spaces in the file. This is a configuration file, and it is highly sensitive to such mistakes.

1 Open the /etc/fstab file in a text editor. 
2 Locate the line that contains the /boot partition.

For example, if your /boot partition uses device hda1 and the Reiser file system, look for a 
line similar to this: 
/dev/hda1 /boot reiser defaults 1 1

3 In the Device Name column, modify the location of the /boot partition from /dev to /dev/
evms so it can be managed by EVMS. Modify only the device name by adding /evms to the 
path: 
/dev/evms/hda1 /boot reiser defaults 1 1

4 Save the file.
The changes do not take affect until the server is restarted. Do not reboot at this time.

5 Continue with “Disable boot.lvm and boot.md” on page 131.

Disable boot.lvm and boot.md

Disable boot.lvm and boot.md so they do not run at boot time. EVMS now handles the boot.

1 In YaST, click System > Runlevel Editor > Expert Mode.
2 Select boot.lvm.
3 Click Set/Reset > Disable the Service. 
4 Select boot.md.
5 Click Set/Reset > Disable the Service. 
6 Click Finish, then click Yes.

The changes do not take affect until the server is restarted. Do not reboot at this time.
7 Continue with “Enable the boot.evms Service” on page 131.

Enable the boot.evms Service

The boot.evms service should be enabled automatically after the install, but you should verify 
that it is enabled. 

1 In YaST, click System > Runlevel Editor > Expert Mode.
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2 Select boot.evms.
3 Click Set/Reset > Enable the Service.

The B runlevel option is automatically selected.
4 Click Finish, then click Yes.

The changes do not take affect until the server is restarted. Do not reboot at this time.
5 Continue with “Edit the /etc/init.d/boot.evms Script” on page 132.

Edit the /etc/init.d/boot.evms Script

1 Open the /etc/init.d/boot.evms script in a text editor.
2 Add the following lines to the Stop section:
mount -n -o remount,rw /

echo -en "\nDeleting devices nodes"

rm -rf /dev/evms

mount -n -o remount,ro /

For example, the Stop section looks like this after the edit:
stop)

  echo -n "Stopping EVMS"

  mount -n -o remount,rw /

  echo -en "\nDeleting devices nodes"

  rm -rf /dev/evms

  mount -n -o remount,ro /

  rc_status -v

;;

3 Save the file.
4 Continue with “Enable Write-Through Cache Management for SCSI Devices” on page 132.

Enable Write-Through Cache Management for SCSI Devices

If you are using space from SCSI devices for your NSS pools and volumes on Linux, make sure the 
devices use Write-Through cache management, not Write-Back cache management. 

IMPORTANT: Using Write-Back cache management on SCSI drives with a journaled file system 
such as NSS can actually degrade file system performance instead of improving it. For information, 
see “Troubleshooting the NSS File System” in the Novell Storage Services File System 
Administration Guide for OES.

SCSI Devices in a Hardware RAID

If you have not already done so, use the RAID controller’s BIOS setup routine or configuration 
utility to enable Write-Through cache management for the controller and the RAID’s SCSI devices.
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Local SCSI Devices

To enable Write-Through cache management for local devices: 

1 Log in to the server as root.
2 In YaST, open Software > Install and Remove Software > Various Linux Tools. 
3 Install the xscsi RPM package, then close YaST. 

The xscsi package installs the scsi-config utility in /user/bin/scsi-config. 
4 In a terminal console, enter scsi-config, then enable Write-Through (disable Write-Back) 

for each SCSI device.

Reboot the Server

1 Reboot the server to apply the post-install configuration settings.

Verify the System Services

After the post-install configuration is complete and you have rebooted the server, make sure the 
server is operating as expected. 

Create NSS Pools and Volumes

For any data devices where you plan to create NSS volumes, make sure to create at least one NSS 
volume on the device before you create any traditional Linux volumes. Use the Storage management 
plug-in to iManager or NSSMU to create the pools and volumes. The order of creation and the 
toolset you use helps ensure that EVMS automatically controls the device.

For information, see the Novell Storage Services File System Administration Guide for OES.
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BOES Linux File and Data Locations

This section contains information about the general rules and conventions Novell® follows when 
determining where various data types and program components are stored on the Linux file system. 

Where possible, we have tried to ensure that OES Linux components follow Linux Standard Base 
(LSB) requirements regarding file location. Efforts to do this are detailed here.

• Section B.1, “General Rules,” on page 135
• Section B.2, “Exceptions,” on page 136

B.1  General Rules
Where possible, product design has followed these rules:

• /opt/novell:  Contains all static data in the following standard subdirectories. 

Table B-1   Data in Standard Linux Subdirectories

• /opt/novell/oes_install: Contains the OES installation and uninstallation code.
• /etc/opt/novell:  Generally contains host-specific configuration data.

NOTE: The eDirectory .conf file is /etc/nds.conf.

If a product has a single configuration file, it is named product.conf.
If a product uses multiple configuration files, they are placed in a subdirectory named for the 
product.

• /var/opt/novell:  Contains all variable data.
Variable data (data that changes during normal run time operations) is stored in a product 
subdirectory.

• /var/opt/novell/log:  Generally contains log files.

NOTE: The eDirectory log file is /var/nds/ndsd.log.

If a product has a single log file, it is stored in a file with the product name.
If a product has multiple log files, they are stored in a subdirectory named for the product.

/opt/novell/bin Executable files that are used by multiple products or are intended to 
be executed by an end user.

/opt/novell/product/bin Executable files that are used only by a product and are not executed 
by an end user.

/opt/novell/lib Shared libraries that are used by multiple products and shared or static 
libraries that are part of an SDK.

/opt/novell/include Header files for SDKs, typically in a product subdirectory.
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• All files and directories that could not follow the above rules have the prefix novell- where 
possible.

B.2  Exceptions
Some files must reside in nonstandard locations for their products to function correctly. Two 
examples are init scripts, which must be in /etc/init.d, and cron scripts, which must be in /
etc/cron.d. When possible, these files have a novell- prefix. 

When standard conventions preclude the use of prefixes (for example in the case of PAM modules, 
which use suffixes instead of prefixes), the standard conventions are followed.
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CDocumentation Updates

To help you keep current on updates to the documentation, this section contains information on 
content changes that have been made in this OES Linux Installation Guide since the initial release of 
Open Enterprise Server. 

This document is provided on the Web in HTML and PDF, and is kept up to date with the 
documentation changes listed in this section. If you need to know whether a copy of the PDF 
documentation you are using is the most recent, check its publication date on the title page.

This documentation update information is grouped according to the date the changes were 
published. Within a dated section, the changes are alphabetically listed by the names of the main 
table of contents sections in the OES Linux Installation Guide.

The documentation was updated on the following dates:

• Section C.1, “May 8, 2006,” on page 137
• Section C.2, “March 3, 2006,” on page 138
• Section C.3, “December 23, 2005 (Open Enterprise Server SP2),” on page 139
• Section C.4, “October 5, 2005,” on page 143
• Section C.5, “September 29, 2005,” on page 144
• Section C.6, “August 19, 2005 (Open Enterprise Server SP1),” on page 146
• Section C.7, “July 12, 2005,” on page 151

C.1  May 8, 2006
Updates were made to the following sections:

• Section C.1.1, “Installing Open Enterprise Server Linux,” on page 137
• Section C.1.2, “Patching an OES Linux Server,” on page 138
• Section C.1.3, “Installing Linux with EVMS as the Volume Manager of the System Device,” on 

page 138

C.1.1  Installing Open Enterprise Server Linux
The following updates were made to this section:

Location Change

“SLP Configuration” on 
page 37

Added information to help users using the Novell ClientTM understand how to 
access an OES Linux server in the network when SLP is not configured.
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C.1.2  Patching an OES Linux Server
The following updates were made to this section:

C.1.3  Installing Linux with EVMS as the Volume Manager of the 
System Device
The following update was made to this section:

C.2  March 3, 2006
Updates were made to the following sections:

• Section C.2.1, “Completing Post-Installation Tasks,” on page 138
• Section C.2.2, “Patching an OES Linux Server,” on page 139

C.2.1  Completing Post-Installation Tasks
The following update was made to this section:

Location Change

“Patching an OES Linux 
Server” on page 57

• Added procedures for patching using ISO images as well as CDs.

• Emphasized that patching from CD/ISO patches to a Support Pack only 
while patching from the channel keeps the server current.

• Added a recommendation to avoid applying specific patches to the 
server.

• Moved "Patching Using a Patch CD or ISO Images" sections to precede 
the patching from ZLM sections.

• Added information about using the ZLM icon after patching to OES SP2.

• Clarified when stopping iPrint services is necessary.

• Removed CD 4 from the download requirements.

• Reformatted disk space requirements to a table and lowered the amounts 
required.

• Minor corrections and clarifications throughout.

• Added clarification that OES SP2 Prepatch only needs to be run once.

Location Change

“Edit the /etc/fstab File” 
on page 130

This section was revised for clarity.

Location Change

“Installing eDirectory 
8.8” on page 53

Added information for installing eDirectoryTM 8.8. 
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C.2.2  Patching an OES Linux Server
The following updates were made to this section:

C.3  December 23, 2005 (Open Enterprise Server 
SP2)
Updates were made to the following sections:

• Section C.3.1, “Completing Post-Installation Tasks,” on page 140
• Section C.3.2, “Entire Guide,” on page 140
• Section C.3.3, “Installing and Configuring Multiple Servers Using AutoYast,” on page 140
• Section C.3.4, “Installing Linux with EVMS as the Volume Manager of the System Device,” on 

page 141
• Section C.3.5, “Installing Open Enterprise Server Linux,” on page 141
• Section C.3.6, “Patching an OES Linux Server,” on page 141
• Section C.3.7, “Removing OES Linux Components,” on page 142
• Section C.3.8, “Upgrading to OES Linux,” on page 142
• Section C.3.9, “What's New,” on page 143

Location Change

“Patching an OES Linux 
Server” on page 57

Corrected an error regarding instructions for users patching their servers using 
ZENworks® Linux Management 7. 

“Patching a Server From 
the ZLM Channel Using 
the Red Carpet 
Command Line (rug)” on 
page 69

Changed instructions for managing a memory leak in the red-carpet daemon in 
Step 5. 

“Patching a Server From 
the ZLM Channel Using 
the Red Carpet GUI” on 
page 71

Changed instructions for managing a memory leak in the red-carpet daemon in 
Step 12. 

“Quick Path for Patching 
From ZLM Using the 
RCD Command Line 
(rug)” on page 82

Changed instructions for managing a memory leak in the red-carpet daemon in 
Step 9.

“Quick Path for Patching 
Using the ZLM Red 
Carpet GUI” on page 84

Changed instructions for managing a memory leak in the red-carpet daemon in 
Step 9.
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C.3.1  Completing Post-Installation Tasks
The following updates were made to this section:

C.3.2  Entire Guide
The following updates were made to the entire guide:

C.3.3  Installing and Configuring Multiple Servers Using 
AutoYast
The following update was made to this section:

Location Change

“Verifying That the 
Installation Was 
Successful” on page 49

Updated the graphic showing a sucessful installation in Step 1 on page 49.

Table 5-1 on page 51 Removed Novell® Virtual Office from the end user services list.

“Installing or Configuring 
OES Components on an 
Existing Server” on 
page 51

Added information for what to do when installing components after you have 
updated the server with Support Pack patches. Changed the presentation of 
the section to a procedure.

Removed Novell Virtual Office as one of the OES components in the table with 
YaST categories and OES components.

“Changing Keyboard 
Mapping” on page 53

Clarified procedures for using the vi editor, added Table 5-3, “Language Codes 
for Keyboard Mapping,” on page 54, and changed the location of the note that 
describes why the problem might occur.

Location Change

Entire guide Updated applicable references from SP1 to SP2. Changed disk names from 
SP1 to SP2.

Page design reformatted to comply with revised Novell® documentation 
standards.

Location Change

Step 14 on page 92 Removed Virtual Office as a module.

Virtual Office Menu 
Options and Information

Removed Virtual Office information.
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C.3.4  Installing Linux with EVMS as the Volume Manager of the 
System Device
The following updates were made to this section:

C.3.5  Installing Open Enterprise Server Linux
The following updates were made to this section:

C.3.6  Patching an OES Linux Server
The following updates were made to this section:

Location Change

“FAQs About Using 
EVMS with NSS” on 
page 119

Added information about using EVMS and non-EVMS volume managers for 
devices where you plan to create NSS volumes on devices post install.

“Storage Deployment 
Scenarios for NSS” on 
page 121

This section was reorganized for clarity.

“Configuring the System 
Device to Use EVMS” 
on page 125

This section was reorganized for clarity. It now organizes the steps to take 
before, during, and after the install.

Location Change

“Installing Open 
Enterprise Server (OES) 
Linux” on page 21

Changed SLES 9 SP2 to SP3 as the version of SLES being installed.

“Preparing for a Network 
Installation” on page 22 
and in the procedure 
Step 3 on page 22

Changed the TID reference for the netInstall.sh file from 29772361 to 
2972902 because the files were updated.

Added information about the error Bad Interpreter No such file or 
folder.

“SLP Configuration” on 
page 37

Updated SLP information to match new options.

“OES Configuration” on 
page 33

Removed Novell Virtual Office OES component information.

Step 2 on page 29 Clarified procedures for customizing the software selections and added 
graphics.

Location Change

“Patching an OES Linux 
Server” on page 57

Added instructions about not using these procedures to patch servers that use 
a  ZENworks ® Linux Management server to do patch management for all 
servers on the network. The processes are different. 

Added overall steps to this section to define the flow for the entire process.
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C.3.7  Removing OES Linux Components
The following update was made to this section:

C.3.8  Upgrading to OES Linux
The following update was made to this section.

“Preparing the Server 
for Patching” on 
page 59

Renamed the section and added Running the OES SP2 Prepatch Script 
procedures. 

“Patching a Server From 
the ZLM Channel Using 
the Red Carpet 
Command Line (rug)” on 
page 69

Removed steps for adding the service, activation, and refreshing the channel 
because the procedures are redundant to procedures performed in the 
Running the OES SP2 Prepatch Script procedures.

Table 6-5, “Additional 
Rug Commands,” on 
page 70

Added several commands that might be helpful for patching the server.

“Patching a Server From 
the ZLM Channel Using 
the Red Carpet GUI” on 
page 71

Added this section.

“Updating Installation 
Sources Using YaST” 
on page 75

Updated the steps for adding a second path for the SUSE® Core CDs when 
patching from the network. Moved this section to before the Section 6.6, 
“Configuring Services After Applying an OES Support Pack,” on page 77

Step 5 in “Configuring 
Services After Applying 
an OES Support Pack” 
on page 77

Removed NetStorage and iPrint and added QuickFinderTM to this step.

Step 4 in “Configuring 
Services After Applying 
an OES Support Pack” 
on page 77

Added information about the server performing the fsck function after the 
reboot if the fsck interval has been exceeded. The fsck function can take some 
time on servers that have a large filesystem.

“Patching Quick Paths 
for Experts” on page 79

Added this section.

Location Change

Step 3 on page 115 Added substeps for using the seach feature.

Location Change

“Upgrading to OES 
Linux” on page 45

Added SLES 9 SP3 as a platform to upgrade from.

“Upgrading the Server” 
on page 47

Removed Novell Virtual Office as a OES component in the table showing the 
YaST categories for OES components.

Location Change
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C.3.9  What's New
The following update was made to this section.

C.4  October 5, 2005
An update was made to the following sections:

• Section C.4.1, “Installing Open Enterprise Server Linux,” on page 143
• Section C.4.2, “Installing and Configuring Multiple Servers Using AutoYast,” on page 143
• Section C.4.3, “Preparing to Install OES Linux,” on page 143

C.4.1  Installing Open Enterprise Server Linux
The following updates were made to this section:

C.4.2  Installing and Configuring Multiple Servers Using 
AutoYast
The following update was made to this section:

C.4.3  Preparing to Install OES Linux
The following update was made to this section.

Location Change

“OES Support Pack 2 
Release” on page 9

Added information about new and updated features for the OES Linux 
installation in OES SP2.

Location Change

“Setting Up Disk 
Partitions” on page 28

Corrected information in Table 3-2 on page 28.

Download the 
netInstall.sh script file. 
(page 22)

Changed the location of the download file from the documentation Web site 
URL http://www.novell.com/documentation/oes/script/netInstall.sh to a TID at 
http://support.novell.com/cgi-bin/search/searchtid.cgi?/2972361.htm.

Location Change

“Installing and 
Configuring Multiple 
Servers Using 
AutoYaST” on page 87

Change the URLs for references to additional documentation for AutoYaST.

Location Change

“Server Hardware” on 
page 11

Change the minimum disk space requirements from 2 GB to 6 GB.
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C.5  September 29, 2005
An update was made to the following sections:

• Section C.5.1, “Installing Open Enterprise Server Linux,” on page 144
• Section C.5.2, “Installing and Configuring Multiple Servers Using AutoYast,” on page 145
• Section C.5.3, “Installing Linux with EVMS as the Volume Manager,” on page 145
• Section C.5.4, “Patching an OES Linux Server,” on page 145
• Section C.5.5, “Preparing to Install OES Linux,” on page 145

C.5.1  Installing Open Enterprise Server Linux
The following updates were made to this section:

Location Change

“Setting Up Disk 
Partitions” on page 28

Added important information about how to set up partitions if you plan to create 
NSS volumes on the same devices that contain system partitions, such as 
boot, swap, or root.

“Customizing the 
Software Selections” on 
page 28

Added advisory information to the description of Novell iFolder 3.x, Novell 
iFolder 3.x Web Access, and Novell Storage Services packages.

“Novell iFolder 3.x” on 
page 40

When you configure iFolder as part of the OES install and configuration, you 
can specify only an EXT3 or ReiserFS volume location for the System Store 
Path, which is where you are storing iFolder data for all your users. You cannot 
create NSS volumes during the system install.

If you want to use an NSS volume to store iFolder data, you must reconfigure 
iFolder 3.x and 3.x Web Access after the OES install. To reconfigure, use 
Novell iManager to create an NSS volume, then go to YaST > Network 
Services and select iFolder 3.x and iFolder 3.x Web Access to enter new 
information. All previous configuration information is removed and replaced. 

“Novell iFolder 3.x Web 
Access” on page 40

If you plan to reconfigure iFolder 3.x after the OES configuration to use an 
NSS volume as the System Store Path, make sure you also reconfigure 
iFolder 3.x Web Access. 

Added the following for iFolder Server URL:

https://IP_address 

Specify an HTTPS and an IP address to configure secure SSL exchanges 
between the Web Access server and the iFolder enterprise server. 
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C.5.2  Installing and Configuring Multiple Servers Using 
AutoYast
The following update was made to this section:

C.5.3  Installing Linux with EVMS as the Volume Manager
The following updates were made to this section:

C.5.4  Patching an OES Linux Server
The following updates were made to this section.

C.5.5  Preparing to Install OES Linux
The following updates were made to this section.

Location Change

“Installing and 
Configuring Multiple 
Servers Using 
AutoYaST” on page 87

Revised the entire section.

Location Change

“Installing Linux with 
EVMS as the Volume 
Manager of the System 
Device” on page 119

Revised the entire section.

Location Change

“Patching a Server From 
the ZLM Channel Using 
the Red Carpet 
Command Line (rug)” on 
page 69

Added steps for ensuring that the public keys are installed. 

“Patching Using a Patch 
CD or ISO Images” on 
page 65

Corrected steps for ensuring that the public keys are installed. 

“Updating Installation 
Sources Using YaST” 
on page 75

Added this section.

Location Change

“Server Software” on 
page 11

Added a note to the computer requirements that OES runs in 32-bit mode only.
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C.6  August 19, 2005 (Open Enterprise Server 
SP1)
An update was made to the following sections:

• Section C.6.1, “About This Guide,” on page 146
• Section C.6.2, “Completing Post-Installation Tasks for OES Linux,” on page 147
• Section C.6.3, “Documentation Updates,” on page 147
• Section C.6.4, “Installing Open Enterprise Server (OES) for Linux,” on page 147
• Section C.6.5, “Installing Linux with EVMS as the Volume Manager,” on page 148
• Section C.6.6, “Installing and Configuring Multiple Servers Using AutoYast,” on page 149
• Section C.6.7, “OES Linux File and Data Locations,” on page 149
• Section C.6.8, “Patching an OES Linux Server,” on page 149
• Section C.6.9, “Preparing to Install OES Linux,” on page 149
• Section C.6.10, “Removing OES Linux Components,” on page 150
• Section C.6.11, “Security Considerations,” on page 150
• Section C.6.12, “Upgrading to OES Linux,” on page 150
• Section C.6.13, “What's New,” on page 150

C.6.1  About This Guide
The following update was made to this section:

“eDirectory Rights 
Required to Install the 
First Three OES Linux 
Servers in an eDirectory 
Tree” on page 15

Revised the entire section.

“Installing into an 
Existing NetWare Tree” 
on page 17

Revised the entire section.

Location Change

“Additional 
Documentation” on 
page 7

Rewrote the introduction and added a contents listing. Added the Additional 
Documentation section.

Location Change
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C.6.2  Completing Post-Installation Tasks for OES Linux
The following updates were made to this section:

C.6.3  Documentation Updates
The following update was made to this section:

C.6.4  Installing Open Enterprise Server (OES) for Linux
The following updates were made to this section:

Location Change

“Completing Post-
Installation Tasks” on 
page 49

Renamed and reorganized the entire section as follows:

• Moved the Update procedures to their own section. See “Patching an 
OES Linux Server” on page 57.

• Renamed “Guidelines for NSS on OES for Linux Servers” to Section 5.5, 
“Completing Additional Tasks for Networks or Servers Running NSS on 
OES Linux Servers,” on page 55 and added the procedures for Section 
5.5.2, “Rebooting Server after Post-installing NSS,” on page 55.

• Added these topics: Section 5.4, “Changing Keyboard Mapping,” on 
page 53 and Section 5.6, “Resolving the Certificate Store Error,” on 
page 55.

“Verifying That the 
Installation Was 
Successful” on page 49

Added specific information for logging in to iManager. 

“Determining Which 
Services Need 
Additional 
Configuration” on 
page 50

Renamed and revised the entire section. 

“Installing or Configuring 
OES Components on an 
Existing Server” on 
page 51

• Renamed this topic. 

• Added iFolder 3.x, iFolder 3.x Web Access, and IP Address Management 
to the Network Services portion of the table. 

• Added emphasis to the recommendation to configure eDirectory before 
installing components that might required it. 

• Added a list of services that require eDirectory.

Location Change

“Documentation 
Updates” on page 137

Added this appendix to this guide.

Location Change

“Installing Open 
Enterprise Server (OES) 
Linux” on page 21

• Changed SLES SP1 references to SLES SP2. 

• Changed server pattern references to predefined server types.
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C.6.5  Installing Linux with EVMS as the Volume Manager
The following updates were made to this section:

Step 2 on page 24 in the 
FTP Protocol procedure

Changed the format of the mount command.

Step 2 on page 24 in the 
HTTP Protocol 
procedure

Changed the format of the ln -s command.

Table 3-1 on page 25 Updated the iso image names and associated CD labels.

“Specifying the Type of 
Installation” on page 27

Moved this section.

“Specifying the 
Installation Settings for 
the Base OES Linux 
Installation” on page 27

Reorganized this section and moved the following information to this section:

• “Setting Up Disk Partitions” on page 28

• “Customizing the Software Selections” on page 28

• “Setting Up the Time Zone” on page 30

• “Accepting the Installation Settings” on page 30

“Setting Up Disk 
Partitions” on page 28

Clarified the partitioning guidelines.

“Customizing the 
Software Selections” on 
page 28

• Added Novell iFolder 3.x, Novell iFolder 3.x Web Access, and Novell IP 
Address Management to the list of OES services that are not installed 
with any of the predefined server types. 

• Clarified instructions for adding to or removing preselected software 
items from predefined server types.

“Specifying 
Configuration 
Information” on page 31

Reorganized the content and location of this section.

Table 3-3 on page 31 • Created a table to present information for this section rather than a 
procedure format. 

• Clarified recommendations and procedures.

Location Change

Just before Step 1of the 
procedure for Modifying 
the Install to Use EVMS 
for System Devices

Added a note that the issue regarding hardware configurations utilizing an HP 
Smart Array Controller is resolved in OES SP1 for Linux.

Step 4 of the procedure 
for Modifying the Install 
to Use EVMS for 
System Devices

Clarified steps for creating a container for the system and swap partition and 
added an example.

Step 13 and 14 Clarified steps for disabling boot.lvm, then boot.md and added instructions 
to make sure the boot.evms service is enabled.

Location Change
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C.6.6  Installing and Configuring Multiple Servers Using 
AutoYast
The following update was made to this section:

C.6.7  OES Linux File and Data Locations
The following update was made to this section.

C.6.8  Patching an OES Linux Server
The following update was made to this section.

C.6.9  Preparing to Install OES Linux
The following updates were made to this section.

Location Change

“Installing and 
Configuring Multiple 
Servers Using 
AutoYaST” on page 87

Added this section to this guide.

Location Change

“OES Linux File and 
Data Locations” on 
page 135

Made minor editing changes.

Location Change

“Patching an OES Linux 
Server” on page 57

Added this section to this guide.

Location Change

“Preparing to Install 
OES Linux” on page 11

• Changed SLES SP1 references to SLES SP2. 

• Changed server patterns references to predefined server types.

“Server Hardware” on 
page 11

Added a note to the computer requirements that states that OES runs in 32-bit 
mode only.

“Decide What Type of 
Server You Are 
Installing” on page 12

Clarified information about predefined server types and descriptions of 
software selections included in each.

“eDirectory Rights 
Required to Install OES 
Linux” on page 15

• Renamed and reorganized this entire section. 

• Clarified that the rights mentioned in this section were eDirectory rights 
and specified when the types of users mentioned would need these 
rights.
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C.6.10  Removing OES Linux Components
The following update was made to this section.

C.6.11  Security Considerations
The following update was made to this section.

C.6.12  Upgrading to OES Linux
The following updates were made to this section.

C.6.13  What's New
The following update was made to this section.

“Installing into Existing 
Networks” on page 17

Added this section.

“What's Next” on 
page 19

Added references to the Patching an OES Linux Server and Installing and 
Configuring Multiple Servers Using AutoYaST sections.

Location Change

“Removing OES Linux 
Components” on 
page 115

Added cross-reference information for deleting objects using iManager to the 
Note about deconfiguring eDirectory objects or attributes.

Location Change

“Security 
Considerations” on 
page 117

Added this section to this guide.

Location Change

“Upgrading to OES 
Linux” on page 45

• Renamed this section. 

• Added SLES 9 SP2 as a platform to upgrade from.

Step 16c on page 47 Added Novell iFolder 3.x, Novell iFolder 3.x Web Access, and Novell IP 
Address Management to the Network Services portion of the table.

Location Change

“What's New” on page 9 Added information about new and updated features for the OES Linux 
installation in OES SP1.

Location Change
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C.7  July 12, 2005
An update was made to the following section:

• Section C.7.1, “Installing Linux with EVMS as the Volume Manager,” on page 151

C.7.1  Installing Linux with EVMS as the Volume Manager
The following update was made to this section:

Location Change

Just before Step 1of the 
procedure for Modifying 
the Install to Use EVMS 
for System Devices

Added information about hardware configurations utilizing an HP Smart Array 
Controller.
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